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Preface

IBM® SPSS® Statistics is a comprehensive system for analyzing data. The Complex Samples
optional add-on module provides the additional analytic techniques described in this manual. The
Complex Samples add-on module must be used with the SPSS Statistics Core system and is
completely integrated into that system.

About SPSS Inc., an IBM Company

SPSS Inc., an IBM Company, is a leading global provider of predictive analytic software

and solutions. The company’s complete portfolio of products — data collection, statistics,
modeling and deployment — captures people’s attitudes and opinions, predicts outcomes of
future customer interactions, and then acts on these insights by embedding analytics into business
processes. SPSS Inc. solutions address interconnected business objectives across an entire
organization by focusing on the convergence of analytics, IT architecture, and business processes.
Commercial, government, and academic customers worldwide rely on SPSS Inc. technology as
a competitive advantage in attracting, retaining, and growing customers, while reducing fraud
and mitigating risk. SPSS Inc. was acquired by IBM in October 2009. For more information,
visit http://www.spss.com.

Technical support

Technical support is available to maintenance customers. Customers may contact

Technical Support for assistance in using SPSS Inc. products or for installation help

for one of the supported hardware environments. To reach Technical Support, see the

SPSS Inc. web site at http://support.spss.com or find your local office via the web site at
http://support.spss.com/default.asp?refpage=contactus.asp. Be prepared to identify yourself, your
organization, and your support agreement when requesting assistance.

Customer Service

If you have any questions concerning your shipment or account, contact your local office, listed
on the Web site at http://www.spss.com/worldwide. Please have your serial number ready for
identification.

Training Seminars

SPSS Inc. provides both public and onsite training seminars. All seminars feature hands-on
workshops. Seminars will be offered in major cities on a regular basis. For more information on
these seminars, contact your local office, listed on the Web site at Attp://www.spss.com/worldwide.
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Additional Publications

The SPSS Statistics: Guide to Data Analysis, SPSS Statistics: Statistical Procedures Companion,
and SPSS Statistics: Advanced Statistical Procedures Companion, written by Marija Norusis and
published by Prentice Hall, are available as suggested supplemental material. These publications
cover statistical procedures in the SPSS Statistics Base module, Advanced Statistics module
and Regression module. Whether you are just getting starting in data analysis or are ready for
advanced applications, these books will help you make best use of the capabilities found within
the IBM® SPSS® Statistics offering. For additional information including publication contents
and sample chapters, please see the author’s website: http://www.norusis.com
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Chapter

Introduction to Complex Samples
Procedures

An inherent assumption of analytical procedures in traditional software packages is that the
observations in a data file represent a simple random sample from the population of interest. This
assumption is untenable for an increasing number of companies and researchers who find it both
cost-effective and convenient to obtain samples in a more structured way.

The Complex Samples option allows you to select a sample according to a complex design and
incorporate the design specifications into the data analysis, thus ensuring that your results are valid.

Properties of Complex Samples

A complex sample can differ from a simple random sample in many ways. In a simple random
sample, individual sampling units are selected at random with equal probability and without
replacement (WOR) directly from the entire population. By contrast, a given complex sample
can have some or all of the following features:

Stratification. Stratified sampling involves selecting samples independently within
non-overlapping subgroups of the population, or strata. For example, strata may be socioeconomic
groups, job categories, age groups, or ethnic groups. With stratification, you can ensure adequate
sample sizes for subgroups of interest, improve the precision of overall estimates, and use different
sampling methods from stratum to stratum.

Clustering. Cluster sampling involves the selection of groups of sampling units, or clusters. For
example, clusters may be schools, hospitals, or geographical areas, and sampling units may be
students, patients, or citizens. Clustering is common in multistage designs and area (geographic)
samples.

Multiple stages. In multistage sampling, you select a first-stage sample based on clusters. Then
you create a second-stage sample by drawing subsamples from the selected clusters. If the
second-stage sample is based on subclusters, you can then add a third stage to the sample. For
example, in the first stage of a survey, a sample of cities could be drawn. Then, from the selected
cities, households could be sampled. Finally, from the selected households, individuals could be
polled. The Sampling and Analysis Preparation wizards allow you to specify three stages in

a design.

Nonrandom sampling. When selection at random is difficult to obtain, units can be sampled
systematically (at a fixed interval) or sequentially.

© Copyright SPSS Inc. 1989, 2010 1
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Unequal selection probabilities. When sampling clusters that contain unequal numbers of units,
you can use probability-proportional-to-size (PPS) sampling to make a cluster’s selection
probability equal to the proportion of units it contains. PPS sampling can also use more general
weighting schemes to select units.

Unrestricted sampling. Unrestricted sampling selects units with replacement (WR). Thus, an
individual unit can be selected for the sample more than once.

Sampling weights. Sampling weights are automatically computed while drawing a complex
sample and ideally correspond to the “frequency” that each sampling unit represents in the target
population. Therefore, the sum of the weights over the sample should estimate the population
size. Complex Samples analysis procedures require sampling weights in order to properly analyze
a complex sample. Note that these weights should be used entirely within the Complex Samples
option and should not be used with other analytical procedures via the Weight Cases procedure,
which treats weights as case replications.

Usage of Complex Samples Procedures

Your usage of Complex Samples procedures depends on your particular needs. The primary
types of users are those who:

B Plan and carry out surveys according to complex designs, possibly analyzing the sample later.
The primary tool for surveyors is the Sampling Wizard.

B Analyze sample data files previously obtained according to complex designs. Before using the
Complex Samples analysis procedures, you may need to use the Analysis Preparation Wizard.

Regardless of which type of user you are, you need to supply design information to Complex
Samples procedures. This information is stored in a plan file for easy reuse.

Plan Files

A plan file contains complex sample specifications. There are two types of plan files:

Sampling plan. The specifications given in the Sampling Wizard define a sample design that

is used to draw a complex sample. The sampling plan file contains those specifications. The
sampling plan file also contains a default analysis plan that uses estimation methods suitable for
the specified sample design.

Analysis plan. This plan file contains information needed by Complex Samples analysis procedures
to properly compute variance estimates for a complex sample. The plan includes the sample
structure, estimation methods for each stage, and references to required variables, such as sample
weights. The Analysis Preparation Wizard allows you to create and edit analysis plans.

There are several advantages to saving your specifications in a plan file, including:

B A surveyor can specify the first stage of a multistage sampling plan and draw first-stage
units now, collect information on sampling units for the second stage, and then modify the
sampling plan to include the second stage.
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B An analyst who doesn’t have access to the sampling plan file can specify an analysis plan and
refer to that plan from each Complex Samples analysis procedure.

B A designer of large-scale public use samples can publish the sampling plan file, which
simplifies the instructions for analysts and avoids the need for each analyst to specify his
or her own analysis plans.

Further Readings

For more information on sampling techniques, see the following texts:

Cochran, W. G. 1977. Sampling Techniques, 3rd ed. New York: John Wiley and Sons.
Kish, L. 1965. Survey Sampling. New York: John Wiley and Sons.

Kish, L. 1987. Statistical Design for Research. New York: John Wiley and Sons.

Murthy, M. N. 1967. Sampling Theory and Methods. Calcutta, India: Statistical Publishing
Society.

Sarndal, C., B. Swensson, and J. Wretman. 1992. Model Assisted Survey Sampling. New York:
Springer-Verlag.
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Sampling from a Complex Design

Figure 2-1
Sampling Wizard, Welcome step

5| Sampling Wizard

Welcome to the Sampling YWizard
The Sampling Wizard helps you design and select a complex sample. Your selections will be saved to a plan file that you can uze at analysis

lime to indicate how the data were sampled.
You can also use the wizard to modify a sampling plan or dravy & sample according to an existing plan.

Wyhat would vou like to do?

@ Design & sample

Choose this option if you have not crested = plan

File: . ﬁﬂﬂﬁi
filee. ou will have the option to draw the sample. N fproperty_assess

(2 Edit & sample design

Choose this option if you want to add, remove,
or modify stages of an existing plan. *ou wil File: Brovae.
hawve the option to dravy the sample, —

©) Draw the zample

Choose this option if you already have a plan file

File:
and want to draw & sample. - Brovese. .

The Sampling Wizard guides you through the steps for creating, modifying, or executing a
sampling plan file. Before using the Wizard, you should have a well-defined target population, a
list of sampling units, and an appropriate sample design in mind.

Creating a New Sample Plan

» From the menus choose:
Analyze > Complex Samples > Select a Sample...

» Select Design a sample and choose a plan filename to save the sample plan.

© Copyright SPSS Inc. 1989, 2010 4
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Click Next to continue through the Wizard.

Optionally, in the Design Variables step, you can define strata, clusters, and input sample weights.
After you define these, click Next.

Optionally, in the Sampling Method step, you can choose a method for selecting items.

If you select PPS Brewer or PPS Murthy, you can click Finish to draw the sample. Otherwise,
click Next and then:

In the Sample Size step, specify the number or proportion of units to sample.

You can now click Finish to draw the sample.

Optionally, in further steps you can:

Choose output variables to save.
Add a second or third stage to the design.

Set various selection options, including which stages to draw samples from, the random
number seed, and whether to treat user-missing values as valid values of design variables.

Choose where to save output data.

Paste your selections as command syntax.
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Sampling Wizard: Design Variables

Figure 2-2
Sampling Wizard, Design Variables step

i Sampling Wizard

Stage 1: Design Wariables

In thiz panel you can stratify your sample or define clusters, ou can alzo provide a label for the stage that wil be used in the output.

If sampling weights exist from a prior stage of the sample design wou can use them as input to the current stage.

: W¥elcome “ariahles: Stratify By:
S @seoet & Property ID [propic] & County [county]
i b Design Variables & Meighborhond [rbrhood]
Method ) 5& Years since last appraizal [time]
sample Size ‘gﬁ Walue @t last appraisal [lastval]
Clusters:
B . &) Towvniship [town]
|

Input Sample Weight:
|

Stage Label |

@ = incomplete section

This step allows you to select stratification and clustering variables and to define input sample
weights. You can also specify a label for the stage.

Stratify By. The cross-classification of stratification variables defines distinct subpopulations, or
strata. Separate samples are obtained for each stratum. To improve the precision of your estimates,
units within strata should be as homogeneous as possible for the characteristics of interest.

Clusters. Cluster variables define groups of observational units, or clusters. Clusters are useful
when directly sampling observational units from the population is expensive or impossible;
instead, you can sample clusters from the population and then sample observational units from
the selected clusters. However, the use of clusters can introduce correlations among sampling
units, resulting in a loss of precision. To minimize this effect, units within clusters should be as
heterogeneous as possible for the characteristics of interest. You must define at least one cluster
variable in order to plan a multistage design. Clusters are also necessary in the use of several
different sampling methods. For more information, see the topic Sampling Wizard: Sampling
Method on p. 8.
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Input Sample Weight. If the current sample design is part of a larger sample design, you may have
sample weights from a previous stage of the larger design. You can specify a numeric variable
containing these weights in the first stage of the current design. Sample weights are computed
automatically for subsequent stages of the current design.

Stage Label. You can specify an optional string label for each stage. This is used in the output to
help identify stagewise information.

Note: The source variable list has the same content across steps of the Wizard. In other words,
variables removed from the source list in a particular step are removed from the list in all steps.
Variables returned to the source list appear in the list in all steps.

Tree Controls for Navigating the Sampling Wizard

On the left side of each step in the Sampling Wizard is an outline of all the steps. You can navigate
the Wizard by clicking on the name of an enabled step in the outline. Steps are enabled as

long as all previous steps are valid—that is, if each previous step has been given the minimum
required specifications for that step. See the Help for individual steps for more information on
why a given step may be invalid.
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Sampling Wizard: Sampling Method

Figure 2-3
Sampling Wizard, Sampling Method step

3] Sampling Wizard

Stage 1; Sampling Method

In thiz panel you can choose how 1o select tems from the working data file. If you choose a PPS (probability proportional to size) sampling
method you must also specify a measure of size (MOS),

: Wiglcome tethiod
EI@ Stage 1 d e B -
H N -
: Design Varisbles y Tt |S|mple Fandom Sampling
I P ethod 65? @ Without replacement (AOR)
Sample Size éy
With replacement (AR
L. Use Wk estimation for analysis
El..
» |

@ = incomplete section

This step allows you to specify how to select cases from the active dataset.

Method. Controls in this group are used to choose a selection method. Some sampling types allow
you to choose whether to sample with replacement (WR) or without replacement (WOR). See the
type descriptions for more information. Note that some probability-proportional-to-size (PPS)

types are available only when clusters have been defined and that all PPS types are available only
in the first stage of a design. Moreover, WR methods are available only in the last stage of a design.

m  Simple Random Sampling. Units are selected with equal probability. They can be selected
with or without replacement.

m  Simple Systematic. Units are selected at a fixed interval throughout the sampling frame (or
strata, if they have been specified) and extracted without replacement. A randomly selected
unit within the first interval is chosen as the starting point.

m  Simple Sequential. Units are selected sequentially with equal probability and without
replacement.

m  PPS. This is a first-stage method that selects units at random with probability proportional
to size. Any units can be selected with replacement; only clusters can be sampled without
replacement.
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m  PPS Systematic. This is a first-stage method that systematically selects units with probability
proportional to size. They are selected without replacement.

m  PPS Sequential. This is a first-stage method that sequentially selects units with probability
proportional to cluster size and without replacement.

m  PPS Brewer. This is a first-stage method that selects two clusters from each stratum with
probability proportional to cluster size and without replacement. A cluster variable must be
specified to use this method.

m  PPS Murthy. This is a first-stage method that selects two clusters from each stratum with
probability proportional to cluster size and without replacement. A cluster variable must be
specified to use this method.

m  PPS Sampford. This is a first-stage method that selects more than two clusters from each
stratum with probability proportional to cluster size and without replacement. It is an
extension of Brewer’s method. A cluster variable must be specified to use this method.

m  Use WR estimation for analysis. By default, an estimation method is specified in the plan file
that is consistent with the selected sampling method. This allows you to use with-replacement
estimation even if the sampling method implies WOR estimation. This option is available
only in stage 1.

Measure of Size (M0OS). If a PPS method is selected, you must specify a measure of size that defines
the size of each unit. These sizes can be explicitly defined in a variable or they can be computed

from the data. Optionally, you can set lower and upper bounds on the MOS, overriding any values
found in the MOS variable or computed from the data. These options are available only in stage 1.
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Sampling Wizard: Sample Size

Figure 2-4
Sampling Wizard, Sample Size step

] Sampling Wizard

Stage 1: Sample Size

In thiz panel you can specify the number or proportion of units to be sampled inthe current stage. The sample size can be fixed across strata
ot it can vary for different strata.

If you specify sample sizes as proportions you can alzo set the minimum or maximum number of units to draw.

\Wiglcome

Design Variables &)3
Hethod & @ value:
Sample Size ‘8& The size value applies
Cutput Variables I:I to each stratum.
Sumimary

Add Stage 2 © Unegual valugs for strata:

=3 - Drawr Sample
i Selection Options

Cutput Files @ Read values from variakls:

Completion ) |

(< Back |[{jext =] | Finish | | cancel || Hep |

This step allows you to specify the number or proportion of units to sample within the current
stage. The sample size can be fixed or it can vary across strata. For the purpose of specifying
sample size, clusters chosen in previous stages can be used to define strata.

Units. You can specify an exact sample size or a proportion of units to sample.

m  Value. A single value is applied to all strata. If Counts is selected as the unit metric, you should
enter a positive integer. If Proportions is selected, you should enter a non-negative value.
Unless sampling with replacement, proportion values should also be no greater than 1.

m  Unequal values for strata. Allows you to enter size values on a per-stratum basis via the Define
Unequal Sizes dialog box.

]

Read values from variable. Allows you to select a numeric variable that contains size values
for strata.

If Proportions is selected, you have the option to set lower and upper bounds on the number of
units sampled.
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Define Unequal Sizes

Figure 2-5
Define Unequal Sizes dialog box

ﬁ Define Unequal Sizes

Size Specifications: = E Exclude:

county count

astern “

Central

1

2

3 |western
4 |Morthern hd

=l

5

7

Southern

—

Refresh Strata

The Define Unequal Sizes dialog box allows you to enter sizes on a per-stratum basis.

Size Specifications grid. The grid displays the cross-classifications of up to five strata or

cluster variables—one stratum/cluster combination per row. Eligible grid variables include all
stratification variables from the current and previous stages and all cluster variables from previous
stages. Variables can be reordered within the grid or moved to the Exclude list. Enter sizes in the
rightmost column. Click Labels or Values to toggle the display of value labels and data values for
stratification and cluster variables in the grid cells. Cells that contain unlabeled values always
show values. Click Refresh Strata to repopulate the grid with each combination of labeled data
values for variables in the grid.

Exclude. To specify sizes for a subset of stratum/cluster combinations, move one or more variables
to the Exclude list. These variables are not used to define sample sizes.
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Sampling Wizard: Output Variables

Figure 2-6
Sampling Wizard, Output Variables step

Sampling Wizard

Stage 1: Output Variables

In thiz panel you can choose varishles to be saved when the sample iz draven. The variables contain information akout the sample or
populstion for the current stage. If the sample is stratified the variables contain data for each stratum.

\Wiglcome
Stage 1

Which variables do you want to save?
Design Variables v

Mhethiod
Sample Size
b Cutput variables |
Summary [] gample size 1L Sample weight
Add Stage 2
=3 - Drawr Sample
H Selection Options o2 Inclusion probakilities, cumulative sample weights, and final sample weights are always
Qutput Files =T saved.
Completion

Duplication indexes are crested automatically when the plan requests sampling with
replacement.

(< Back |[{Hext =]  Finish | cancel | Her |

This step allows you to choose variables to save when the sample is drawn.

Population size. The estimated number of units in the population for a given stage. The rootname

for the saved variable is PopulationSize .

Sample proportion. The sampling rate at a given stage. The rootname for the saved variable is

SamplingRate .

Sample size. The number of units drawn at a given stage. The rootname for the saved variable

is SampleSize .

Sample weight. The inverse of the inclusion probabilities. The rootname for the saved variable is

SampleWeight .

Some stagewise variables are generated automatically. These include:

Inclusion probabilities. The proportion of units drawn at a given stage. The rootname for the saved

variable is InclusionProbability .

Cumulative weight. The cumulative sample weight over stages previous to and including the

current one. The rootname for the saved variable is SampleWeightCumulative .
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Index. Identifies units selected multiple times within a given stage. The rootname for the saved

variable is Index_.

Note: Saved variable rootnames include an integer suffix that reflects the stage number—for
example, PopulationSize 1 _for the saved population size for stage 1.

Sampling Wizard: Plan Summary

Figure 2-7

Sampling Wizard, Plan Summary step

H Sampling Wizard

Stage 1: Plan Summary

WWiglcome
Stage 1
; Design Variables
Methiod
Sample Size
Output Yariables
P Summary
Al Stage 2
g Dz Sample
; Selection Options
i Output Files
Completion

Thiz panel summarizes the sampling plan so far. You can add another stage to the design.

If you chooze not to add & next stage the next step is to set options for drawing wour sample.

SUmmary:
Stage | Label | strata Clusters | Size | Method
1 (Mone) cournty towen 4 per stratum  Simple Random Sampling

(AOR]

File: C:tempiproperty_assess.csplan

Do you weant to add stage 27
@ ves, add stage 2 nowy

Choose thiz option if the working data
file contains data for stage 2.

(@] Mo, do not add another stace nowe

Choose thiz option if stage 2 data are not
available yet or yvour design has only one stage.

This is the last step within each stage, providing a summary of the sample design specifications
through the current stage. From here, you can either proceed to the next stage (creating it, if
necessary) or set options for drawing the sample.
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Sampling Wizard: Draw Sample Selection Options

Figure 2-8
Sampling Wizard, Draw Sample Selection Options step

3] Sampling Wizard

Drarwy Sample: Selection Options

In thiz panel you can choose whether to drave a sample. Y¥ou can pick which stages to extract and set other sampling options such asz the
zeed used for random number generation.

: \Wiglcome
B- Stage 1 Do you wwant to draw & sample?
Design Variables

Methad @ ves Staes: |4 (1,2)

Sample Size
) ©io
Output Variables =
Sumimary
=8 Stage 2 What type of seed value do you want to use?

Design Yariables
@ a rancomly-chosen number

Method Erter a custom seed walue if you wart to reproduce
Sample Size © G R the sample later,
Cutput Varisbles
Summaty
Aold Stage 3 ] Include in the sample frame cazes with user-miszing values of stratification or

clustering variables
=3 - Drawr Sample

Selection Options
Cutput Files
Completion

|| wyorking data are sarted by stratification variables (presorted data may speed
processing)

(< Back |[{Hext =]  Finish | cancel | Her |

This step allows you to choose whether to draw a sample. You can also control other sampling
options, such as the random seed and missing-value handling.

Draw sample. In addition to choosing whether to draw a sample, you can also choose to execute
part of the sampling design. Stages must be drawn in order—that is, stage 2 cannot be drawn
unless stage 1 is also drawn. When editing or executing a plan, you cannot resample locked stages.

Seed. This allows you to choose a seed value for random number generation.

Include user-missing values. This determines whether user-missing values are valid. If so,
user-missing values are treated as a separate category.

Data already sorted. If your sample frame is presorted by the values of the stratification variables,
this option allows you to speed the selection process.
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Sampling Wizard: Draw Sample Output Files

Figure 2-9
Sampling Wizard, Draw Sample Output Files step

Sampling Wizard

Drarwy Sample: Output Files:

In thiz panel you can choose where to save sample output deta. “ou must save sampled cases to an external file if sampling is done with
replacement. The selected cases are saved along with the variables if the destination is & new dataset or file.
Jaint probabilties are saved if vou request PPS sampling without replacement. They are needed for WOR estimation of PPS designs.

: Wglcome
[_j Stage 1 Where do you want to save sample data?

Design Variables
Wethod @ Active datasst

Sample Size © New detaset:
Output Variables
Sumimary
B Stage 2
Design Yariables
Methiod
Sample Size
Cutput Varisbles
SUmmary [7] Save case selection rules
Add Stage 3
=3 Drave Sample
Selection Options
i B Cutput Files
Completion

©) Exterral file:

(< Back |[{Hext =]  Finish | cancel | Her |

This step allows you to choose where to direct sampled cases, weight variables, joint probabilities,
and case selection rules.

Sample data. These options let you determine where sample output is written. It can be added to
the active dataset, written to a new dataset, or saved to an external IBM® SPSS® Statistics data
file. Datasets are available during the current session but are not available in subsequent sessions
unless you explicitly save them as data files. Dataset names must adhere to variable naming rules.
If an external file or new dataset is specified, the sampling output variables and variables in the
active dataset for the selected cases are written.

Joint probabilities. These options let you determine where joint probabilities are written. They are
saved to an external SPSS Statistics data file. Joint probabilities are produced if the PPS WOR,
PPS Brewer, PPS Sampford, or PPS Murthy method is selected and WR estimation is not specified.

Case selection rules. If you are constructing your sample one stage at a time, you may want to
save the case selection rules to a text file. They are useful for constructing the subframe for
subsequent stages.
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Sampling Wizard: Finish

Figure 2-10
Sampling Wizard, Finish step

i Sampling Wizard

Completing the Sampling Wizard

You have provided all of the information needed to creste a sample design and draw a sample.
You can return to the Sampling Wizard later if you need to add or modify stages. After all the stages have been sampled you can use the
plan file in any Complex Samples analysis procedure to indicate how the sample was drawn.

: Welcome

=8 Stage 1

Design Yariables

Method

Sample Size

Outpt Variables @ Paste the ayntax generated by the Wizard into & syntas wwindaw

Summary

=3 Stage 2
Design Yatiables
Method
Sample Size
Outpt Varisbles
Summary

Add Stage 3

=3 ~ Draw Sample

i Selection Options

Output Files

- P Completion

What do you weant to do’?

@ Save the design to & plan file and draw the sample

To cloze this wizard, click Finish.

= Back

[c:ance|][ Help ]

This is the final step. You can save the plan file and draw the sample now or paste your selections
into a syntax window.

When making changes to stages in the existing plan file, you can save the edited plan to a
new file or overwrite the existing file. When adding stages without making changes to existing
stages, the Wizard automatically overwrites the existing plan file. If you want to save the plan
to a new file, select Paste the syntax generated by the Wizard into a syntax window and change the
filename in the syntax commands.

Modifying an Existing Sample Plan

» From the menus choose:

>

Analyze > Complex Samples > Select a Sample...

Select Edit a sample design and choose a plan file to edit.

» Click Next to continue through the Wizard.
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» Review the sampling plan in the Plan Summary step, and then click Next.

Subsequent steps are largely the same as for a new design. See the Help for individual steps

for more information.

» Navigate to the Finish step, and specify a new name for the edited plan file or choose to overwrite

the existing plan file.

Optionally, you can:

m  Specify stages that have already been sampled.

m  Remove stages from the plan.

Sampling Wizard: Plan Summary

Figure 2-11
Sampling Wizard, Plan Summary step

3] Sampling Wizard

Plan Summary

[_:l..

\Wiglcome

- P Plan Summary
[_]..

Stage 1
Design Yariables
= (gtale]
Sample Size
Cutput Varisbles
SUrihEry

Stage 2
Design Yatiables
Method
Sample Size
Outpt Variables
Summary

Add Stage 3

Diravy Satnple

Selection Options:
Cutput Files
Completion

Thiz panel summarizes the sampling plan. Indicate any stages that have already been sampled. These stages will be locked in the \Wizard to
prevent accidertal changes. They cannot be resampled unless you unlock them.
You can alzo delete existing stages from the plan.

SLmmary:

Stage | Label Strata Clusters Size | hig

1 [Mone) courty towen 4 per stratum Sim
i’

2 [Mone) nbrhiood 0.2 per stratum Sim
il

[ —————————— " |

File: C:property _sssess.csplan

Which stages have already been sampled?

[ remove stages from the plan:

-

(< Back |[{Hext =]  Finish | cancel | Her |

This step allows you to review the sampling plan and indicate stages that have already been
sampled. If editing a plan, you can also remove stages from the plan.

Previously sampled stages. If an extended sampling frame is not available, you will have to execute
a multistage sampling design one stage at a time. Select which stages have already been sampled
from the drop-down list. Any stages that have been executed are locked; they are not available in
the Draw Sample Selection Options step, and they cannot be altered when editing a plan.
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Remove stages. You can remove stages 2 and 3 from a multistage design.

Running an Existing Sample Plan

» From the menus choose:
Analyze > Complex Samples > Select a Sample...

Select Draw a sample and choose a plan file to run.
Click Next to continue through the Wizard.

Review the sampling plan in the Plan Summary step, and then click Next.

vV v v v

The individual steps containing stage information are skipped when executing a sample plan. You
can now go on to the Finish step at any time.

Optionally, you can specify stages that have already been sampled.

CSPLAN and CSSELECT Commands Additional Features

The command syntax language also allows you to:
m  Specify custom names for output variables.

m  Control the output in the Viewer. For example, you can suppress the stagewise summary of
the plan that is displayed if a sample is designed or modified, suppress the summary of the
distribution of sampled cases by strata that is shown if the sample design is executed, and
request a case processing summary.

m  Choose a subset of variables in the active dataset to write to an external sample file or to
a different dataset.

See the Command Syntax Reference for complete syntax information.
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Preparing a Complex Sample for
Analysis

Figure 3-1
Analysis Preparation Wizard, Welcome step

3] Analysis Preparation Wizard

Welcome to the Analysis Preparation Yizard

The Analysis Preparation Wizard helps you describe your cothplex sample and choose an estimation method. You will be asked to provide
sample weights and other information needed for accurate estimation of standard errors.

Your selections will be saved to a plan file that you can use in any of the analysis procedures in the Complex Samples Option.

What weould you like to do?

@ Create a plan file

Choose this aption if you have sample File:
data but have not created a plan file. 18 [foankloan csplan | @]

© Edtt a plan file

Choose this aption if you want to add,
remove, or modify stages of an
existing plan.

& |f you already have a plan file you can skip the &Analysis Preparation Wizard and go directly

J J_ to any of the analysis procedures inthe Complex Samples Option to analyze your sample.

The Analysis Preparation Wizard guides you through the steps for creating or modifying an
analysis plan for use with the various Complex Samples analysis procedures. Before using the
Wizard, you should have a sample drawn according to a complex design.

Creating a new plan is most useful when you do not have access to the sampling plan file used
to draw the sample (recall that the sampling plan contains a default analysis plan). If you do
have access to the sampling plan file used to draw the sample, you can use the default analysis
plan contained in the sampling plan file or override the default analysis specifications and save
your changes to a new file.

© Copyright SPSS Inc. 1989, 2010 19
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Creating a New Analysis Plan

>

From the menus choose:
Analyze > Complex Samples > Prepare for Analysis...

Select Create a plan file, and choose a plan filename to which you will save the analysis plan.
Click Next to continue through the Wizard.

Specify the variable containing sample weights in the Design Variables step, optionally defining
strata and clusters.

You can now click Finish to save the plan.

Optionally, in further steps you can:

Select the method for estimating standard errors in the Estimation Method step.

m  Specify the number of units sampled or the inclusion probability per unit in the Size step.
®  Add a second or third stage to the design.
m  Paste your selections as command syntax.

Analysis Preparation Wizard: Design Variables

Figure 3-2
Analysis Preparation Wizard, Design Variables step

H Analysis Preparation Wizard

Stage 1: Design YVariables

In this panel you can select variables that define strata or clusters. & sample weight variable must be selected in the first stage.

You can alzo provide a label for the stage that will be used inthe output.

Wielcome

Wariahles: Strata:
Stage 1 & Mumkber of custamers [noust]
- b Design Yariables &) Customer 1D [customer]
E=timation Method y Age in vears [agel
Sumimary E[I Lewvel of education [ed]
Completion f “ears with current employ ...
ef “ears at current address [ Clusters:
& Househaold income inthous.. &) Eranch [branch]

& Debt to income ratio (x100) .

ef Credit card debt inthousan...
& Cther debit in thousands [of...
&) Previously defaulted [default]

& inclrob_s1 Sample Weight:
& inclpron_s2 - |y finabaeight

Stane Label | |
[< Eack]lé |[ Finizh ][Cancel ][ Help ]
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This step allows you to identify the stratification and clustering variables and define sample
weights. You can also provide a label for the stage.

Strata. The cross-classification of stratification variables defines distinct subpopulations, or strata.
Your total sample represents the combination of independent samples from each stratum.

Clusters. Cluster variables define groups of observational units, or clusters. Samples drawn in
multiple stages select clusters in the earlier stages and then subsample units from the selected
clusters. When analyzing a data file obtained by sampling clusters with replacement, you should
include the duplication index as a cluster variable.

Sample Weight. You must provide sample weights in the first stage. Sample weights are computed
automatically for subsequent stages of the current design.

Stage Label. You can specify an optional string label for each stage. This is used in the output to
help identify stagewise information.

Note: The source variable list has the same contents across steps of the Wizard. In other words,
variables removed from the source list in a particular step are removed from the list in all steps.
Variables returned to the source list show up in all steps.

Tree Controls for Navigating the Analysis Wizard

At the left side of each step of the Analysis Wizard is an outline of all the steps. You can navigate
the Wizard by clicking on the name of an enabled step in the outline. Steps are enabled as long as
all previous steps are valid—that is, as long as each previous step has been given the minimum
required specifications for that step. For more information on why a given step may be invalid,
see the Help for individual steps.
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Analysis Preparation Wizard: Estimation Method

Figure 3-3
Analysis Preparation Wizard, Estimation Method step

i Analysis Preparation Wizard

Stage 1: Estimation hethod

In thiz panel you select & method for estimating standard errors.

The estimation method depends on assumptions about how the sample was drasvn.

: Wigloome
E| @ Stage 1 Which of the following sample designs should be assumed for estimation’?
Lk Design Yariakles
P Estimation Method 2 Wi rsampling with replacement)
Size

If you choose this option you will not be able to add additional stages. Any sample stages
after the current stage will be ignored when the data are analyzed.

Ed

® Egjual WOR (ecual probakilty sampling without replacement)

The next panel will ask you to specify inclusion probabilities ar population sizes.

@ Uregual WOR (unedqual probability sampling withaut replacement)

Jaint probabilties will be required to analyze sample data. This option iz available in stage 1
anly.

@ = incomplete section

This step allows you to specify an estimation method for the stage.

WR (sampling with replacement). WR estimation does not include a correction for sampling from a
finite population (FPC) when estimating the variance under the complex sampling design. You
can choose to include or exclude the FPC when estimating the variance under simple random
sampling (SRS).

Choosing not to include the FPC for SRS variance estimation is recommended when the
analysis weights have been scaled so that they do not add up to the population size. The SRS
variance estimate is used in computing statistics like the design effect. WR estimation can be
specified only in the final stage of a design; the Wizard will not allow you to add another stage if
you select WR estimation.

Equal WOR (equal probability sampling without replacement). Equal WOR estimation includes the
finite population correction and assumes that units are sampled with equal probability. Equal
WOR can be specified in any stage of a design.

Unequal WOR (unequal probability sampling without replacement). In addition to using the finite
population correction, Unequal WOR accounts for sampling units (usually clusters) selected with
unequal probability. This estimation method is available only in the first stage.



23

Preparing a Complex Sample for Analysis

Analysis Preparation Wizard: Size

Figure 3-4

Analysis Preparation Wizard, Size step

5] Analysis Preparation Wizard

Stage 1: Size

Wielcome
_ Stage 1

In this panel you specify inclusion probabilties or populstion sizes for the current stage.

Wariables:

f Mumber of customers [nowst]

f Household income inthousan...
f Debt to incame ratio (1000 [d...
@& Credit card debt in thousands...
& Other debt in thousands [oth...

&) Previously defautted [default]
@& inclprob_s2

“ou can provide a size that is fixed across strata or specify sizes on a per-stratum basis.

Units: |inclusion Probakilties

Design *ariables &5 Customer ID [customer]
Estimation tethad @& Agein years [age] @ walue:
: Size ol Level of education [sd]
o Summary &P “ears with current employer ...
o Stage 2 &7 ‘ears st current address [ad...
Completion

@ Read values from variakle:

| f inclprob_s1

(< Back | [flexd =] | Finish | | concel | Hel |

This step is used to specify inclusion probabilities or population sizes for the current stage. Sizes

can be fixed or can vary across strata. For the purpose of specifying sizes, clusters specified in

previous stages can be used to define strata. Note that this step is necessary only when Equal
WOR is chosen as the Estimation Method.

Units. You can specify exact population sizes or the probabilities with which units were sampled.

m  Value. A single value is applied to all strata. If Population Sizes is selected as the unit metric,
you should enter a non-negative integer. If Inclusion Probabilities is selected, you should enter
a value between 0 and 1, inclusive.

®  Unequal values for strata. Allows you to enter size values on a per-stratum basis via the Define
Unequal Sizes dialog box.

m  Read values from variable. Allows you to select a numeric variable that contains size values

for strata.
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Define Unequal Sizes

Figure 3-5
Define Unequal Sizes dialog box

. - [ |
ﬁ Define Unequal Sizes
Size Specifications: = E Exclude:
county count
-

1

2 | Central

3 |western
4 |Morthern hd

5 | Southern

g

7

—

Refresh Strata

The Define Unequal Sizes dialog box allows you to enter sizes on a per-stratum basis.

Size Specifications grid. The grid displays the cross-classifications of up to five strata or

cluster variables—one stratum/cluster combination per row. Eligible grid variables include all
stratification variables from the current and previous stages and all cluster variables from previous
stages. Variables can be reordered within the grid or moved to the Exclude list. Enter sizes in the
rightmost column. Click Labels or Values to toggle the display of value labels and data values for
stratification and cluster variables in the grid cells. Cells that contain unlabeled values always
show values. Click Refresh Strata to repopulate the grid with each combination of labeled data
values for variables in the grid.

Exclude. To specify sizes for a subset of stratum/cluster combinations, move one or more variables
to the Exclude list. These variables are not used to define sample sizes.
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Analysis Preparation Wizard: Plan Summary

Figure 3-6

Analysis Preparation Wizard, Plan Summary step

5| Analysis Preparation Wizard

Stage 1: Plan Summary

Wielcome

Stage 1
Design Variables
Estimation hdethod
Size

Sumimary
Add Stage 2
Completion

Thiz panel summatizes the plan so far. You can add ancther stage to the plan.

If wou choose not to add a stage the next panel is the Completion panel.

SUmmary:

Stage  |Lskel |Strata  |Clusters Weights | Size [ method

1 [Mone) branch finalneeight [Read from inclprob_s1) Egqual WWOR
U L

File: /bankloan.csplan

Do you wwant to acdd stage 27

@ Yes, add stage 2 now Mo, do not add another stage now
Choose this aption if the sample Choose this option if this is the last stage of the
containzs anather stage. sample.

This is the last step within each stage, providing a summary of the analysis design specifications
through the current stage. From here, you can either proceed to the next stage (creating it if
necessary) or save the analysis specifications.

If you cannot add another stage, it is likely because:

®  No cluster variable was specified in the Design Variables step.

B You selected WR estimation in the Estimation Method step.

®m  This is the third stage of the analysis, and the Wizard supports a maximum of three stages.
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Analysis Preparation Wizard: Finish

Figure 3-7
Analysis Preparation Wizard, Finish step

3] Analysis Preparation Wizard

Completing the Analysis Wizard

You have provided all of the information needed to create a plan.

You can use the plan file in any Complex Samples analysis procedure when you are ready to analyze the data.

Wielcome

=8 Stage 1

' Design Variables

i I Estimation Method

Summary

B . Stage 2 (#) Paste the syntax generated by the Wizard into & syntao: window
' Design “ariskles
i~ | Estimation hiethod
Sumimary

o Completion

Wyhat do vou want to do?

@ Save your specifications to a plan file

To cloge this wizard, click Finish.

= Back I Finizh | [ Cancel ][ Help ]

This is the final step. You can save the plan file now or paste your selections to a syntax window.
When making changes to stages in the existing plan file, you can save the edited plan to a new

file or overwrite the existing file. When adding stages without making changes to existing stages,

the Wizard automatically overwrites the existing plan file. If you want to save the plan to a

new file, choose to Paste the syntax generated by the Wizard into a syntax window and change the

filename in the syntax commands.

Modifying an Existing Analysis Plan

» From the menus choose:
Analyze > Complex Samples > Prepare for Analysis...

» Select Edit a plan file, and choose a plan filename to which you will save the analysis plan.

» Click Next to continue through the Wizard.
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» Review the analysis plan in the Plan Summary step, and then click Next.

Preparing a Complex Sample for Analysis

Subsequent steps are largely the same as for a new design. For more information, see the Help
for individual steps.

» Navigate to the Finish step, and specify a new name for the edited plan file, or choose to overwrite
the existing plan file.

Optionally, you can remove stages from the plan.

Analysis Preparation Wizard: Plan Summary
Figure 3-8

Analysis Preparation Wizard, Plan Summary step

H Analysis Preparation Wizard

Plan Summary

Welcome

- B Plan Summary
El..

Stage 1
Design Variables
Estimation hethod
Size
Summary
Stage 2
Design “ariskles
Estimation Method
Size
Summary
Add Stage 3
Completion

Thiz panel summarizes the plan. You can delete stages before proceeding.

SUmMmary:
Stage  |Label Clusters Wieights | Size [ Method
1 [Mone) branch finalweight [Read fram inc Exqual WOl
lprokb_s11
2 [Mone) (Read fram inc Exqual WOl
lprok_=21
U — 1

File: bankloan.csaplan

Ei Remaove stages from the plan:

[: Eack“iﬂe)d >” Finizh ”Cancel ” Helg ]

This step allows you to review the analysis plan and remove stages from the plan.

Remove Stages. You can remove stages 2 and 3 from a multistage design. Since a plan must have
at least one stage, you can edit but not remove stage 1 from the design.



Chapter
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Complex Samples Plan

Complex Samples analysis procedures require analysis specifications from an analysis or sample
plan file in order to provide valid results.

Figure 4-1
Complex Samples Plan dialog box

H Complex Samples Plan for Frequencies An...

Flan

File: |nhisQDDD_suh331 csaplan | |Erowse.i|

If ywou do not have a plan file for your complex sample,
you can use the Analysis Preparation Wizard to create
one. Choose Prepare for Analysis from the Complex
Samples menu to access the wizard,

Jaint Probabilties

Joint probakilties are required if the plan requests
unegual probabilty WIOR estimation. Ctherwise, they are
igrored.

® Use default file  [rhis2000_subset sav)

@ an open detaset

© Custom file

[Continue][ Cancel ][ Helg ]

Plan. Specify the path of an analysis or sample plan file.

Joint Probabilities. In order to use Unequal WOR estimation for clusters drawn using a PPS WOR
method, you need to specify a separate file or an open dataset containing the joint probabilities.
This file or dataset is created by the Sampling Wizard during sampling.

© Copyright SPSS Inc. 1989, 2010 28
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Complex Samples Frequencies

The Complex Samples Frequencies procedure produces frequency tables for selected variables
and displays univariate statistics. Optionally, you can request statistics by subgroups, defined by
one or more categorical variables.

Example. Using the Complex Samples Frequencies procedure, you can obtain univariate tabular
statistics for vitamin usage among U.S. citizens, based on the results of the National Health
Interview Survey (NHIS) and with an appropriate analysis plan for this public-use data.

Statistics. The procedure produces estimates of cell population sizes and table percentages,
plus standard errors, confidence intervals, coefficients of variation, design effects, square roots
of design effects, cumulative values, and unweighted counts for each estimate. Additionally,
chi-square and likelihood-ratio statistics are computed for the test of equal cell proportions.

Data. Variables for which frequency tables are produced should be categorical. Subpopulation
variables can be string or numeric but should be categorical.

Assumptions. The cases in the data file represent a sample from a complex design that should
be analyzed according to the specifications in the file selected in the Complex Samples Plan
dialog box.

Obtaining Complex Samples Frequencies

» From the menus choose:
Analyze > Complex Samples > Frequencies...

» Select a plan file. Optionally, select a custom joint probabilities file.

» Click Continue.

© Copyright SPSS Inc. 1989, 2010 29
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Figure 5-1
Frequencies dialog box

H Complex Samples Plan for Frequencies Analysis

Wariahles: Frequency Tables:
& Stratum for varianc... [ f Yitamindmineral suppim...
& PSU for variance ... hizsing Values...

@ﬁ Wizight - Final &nnu...
& Sex [SEX]

& sge [MGE_P]

& Region [REGION]

‘g& Smoking frequency ..
f Take any multi-vita...
f Take herbal supple. . Subpopulations:
@& Freg vigorous activi... f Age category [age_cat]
f Freg moderate activ...

f Freq strength activit...
& Desirable Bady Wel... Each combination of
& Daly activities, mavi... catenories defines &
f Daily activities, liftin... | subpopulation.

[ Ok, ” Paste ”Reset ”Cancel” Help ]

» Select at least one frequency variable.

Optionally, you can specify variables to define subpopulations. Statistics are computed separately
for each subpopulation.

Complex Samples Frequencies Statistics

Figure 5-2
Frequencies Statistics dialog box

H Complex Samples Frequencies: Statistics
rCells
E Population size |:| Tahle percent
Statistics
[+ Standard error [T Urreveighted court
[7] confidence interval [7] Design effect
|:| Square root of design effect
|:| Coetficient of variation |:| Cumulative values

|:| Test of equal cell propartions

|Corrt|nue” Cancel ” Help ]

Cells. This group allows you to request estimates of the cell population sizes and table percentages.

Statistics. This group produces statistics associated with the population size or table percentage.

m  Standard error. The standard error of the estimate.
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Confidence interval. A confidence interval for the estimate, using the specified level.
Coefficient of variation. The ratio of the standard error of the estimate to the estimate.
Unweighted count. The number of units used to compute the estimate.

Design effect. The ratio of the variance of the estimate to the variance obtained by assuming
that the sample is a simple random sample. This is a measure of the effect of specifying a
complex design, where values further from 1 indicate greater effects.

Square root of design effect. This is a measure of the effect of specifying a complex design,
where values further from 1 indicate greater effects.

Cumulative values. The cumulative estimate through each value of the variable.

Test of equal cell proportions. This produces chi-square and likelihood-ratio tests of the hypothesis
that the categories of a variable have equal frequencies. Separate tests are performed for each
variable.

Complex Samples Missing Values

Figure 5-3
Missing Values dialog box

3] Complex Samples Crosstabs: Missing Values

Tahkles
@ Use all availabile data (table-hy-table deletion)

@ Use consistent caze base (listwise deletion)

Categorical Design Yariakles
@ Uzet-missing values are invalid
(@) Uzer-mizzing values are valid

Cazes with invalid data for any cetegorical design
varishles are excluded from the analysis.

i) (

(Gamie) [canee ) (i

Tables. This group determines which cases are used in the analysis.

Use all available data. Missing values are determined on a table-by-table basis. Thus, the cases
used to compute statistics may vary across frequency or crosstabulation tables.

Use consistent case base. Missing values are determined across all variables. Thus, the cases
used to compute statistics are consistent across tables.

Categorical Design Variables. This group determines whether user-missing values are valid
or invalid.
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Complex Samples Options

Figure 5-4
Options dialog box

i Complex Samples Crosstabs: Options

Subpopulstion Display
@ &l inthe same takle
Each in a separste table

|Cont|nue” Cancel ” Help ]

Subpopulation Display. You can choose to have subpopulations displayed in the same table or in
separate tables.
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Complex Samples Descriptives

The Complex Samples Descriptives procedure displays univariate summary statistics for several
variables. Optionally, you can request statistics by subgroups, defined by one or more categorical
variables.

Example. Using the Complex Samples Descriptives procedure, you can obtain univariate
descriptive statistics for the activity levels of U.S. citizens, based on the results of the National
Health Interview Survey (NHIS) and with an appropriate analysis plan for this public-use data.

Statistics. The procedure produces means and sums, plus ¢ tests, standard errors, confidence
intervals, coefficients of variation, unweighted counts, population sizes, design effects, and square
roots of design effects for each estimate.

Data. Measures should be scale variables. Subpopulation variables can be string or numeric
but should be categorical.

Assumptions. The cases in the data file represent a sample from a complex design that should
be analyzed according to the specifications in the file selected in the Complex Samples Plan
dialog box.

Obtaining Complex Samples Descriptives

» From the menus choose:
Analyze > Complex Samples > Descriptives...

» Select a plan file. Optionally, select a custom joint probabilities file.

» Click Continue.
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Figure 6-1
Descriptives dialog box

i Complex Samples Descriptives
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Each combination of
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» Select at least one measure variable.

Optionally, you can specify variables to define subpopulations. Statistics are computed separately
for each subpopulation.

Complex Samples Descriptives Statistics

Figure 6-2
Descriptives Statistics dialog box
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Summaries. This group allows you to request estimates of the means and sums of the measure
variables. Additionally, you can request ¢ tests of the estimates against a specified value.

Statistics. This group produces statistics associated with the mean or sum.

Standard error. The standard error of the estimate.

Confidence interval. A confidence interval for the estimate, using the specified level.
Coefficient of variation. The ratio of the standard error of the estimate to the estimate.
Unweighted count. The number of units used to compute the estimate.

Population size. The estimated number of units in the population.

Design effect. The ratio of the variance of the estimate to the variance obtained by assuming
that the sample is a simple random sample. This is a measure of the effect of specifying a
complex design, where values further from 1 indicate greater effects.

Square root of design effect. This is a measure of the effect of specifying a complex design,
where values further from 1 indicate greater effects.

Complex Samples Descriptives Missing Values

Figure 6-3
Descriptives Missing Values dialog box

H Complex Samples Descriptives: Missing Values
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Statistics for Measure Variables. This group determines which cases are used in the analysis.

Use all available data. Missing values are determined on a variable-by-variable basis, thus the
cases used to compute statistics may vary across measure variables.

Ensure consistent case base. Missing values are determined across all variables, thus the
cases used to compute statistics are consistent.

Categorical Design Variables. This group determines whether user-missing values are valid
or invalid.
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Complex Samples Options

Figure 6-4
Options dialog box

i Complex Samples Crosstabs: Options
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Subpopulation Display. You can choose to have subpopulations displayed in the same table or in
separate tables.
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Complex Samples Crosstabs

The Complex Samples Crosstabs procedure produces crosstabulation tables for pairs of selected
variables and displays two-way statistics. Optionally, you can request statistics by subgroups,
defined by one or more categorical variables.

Example. Using the Complex Samples Crosstabs procedure, you can obtain cross-classification
statistics for smoking frequency by vitamin usage of U.S. citizens, based on the results of the
National Health Interview Survey (NHIS) and with an appropriate analysis plan for this public-use
data.

Statistics. The procedure produces estimates of cell population sizes and row, column, and table
percentages, plus standard errors, confidence intervals, coefficients of variation, expected values,
design effects, square roots of design effects, residuals, adjusted residuals, and unweighted counts
for each estimate. The odds ratio, relative risk, and risk difference are computed for 2-by-2 tables.
Additionally, Pearson and likelihood-ratio statistics are computed for the test of independence of
the row and column variables.

Data. Row and column variables should be categorical. Subpopulation variables can be string or
numeric but should be categorical.

Assumptions. The cases in the data file represent a sample from a complex design that should
be analyzed according to the specifications in the file selected in the Complex Samples Plan
dialog box.

Obtaining Complex Samples Crosstabs

» From the menus choose:
Analyze > Complex Samples > Crosstabs...

» Select a plan file. Optionally, select a custom joint probabilities file.

» Click Continue.
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Figure 7-1
Crosstabs dialog box
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» Select at least one row variable and one column variable.

Optionally, you can specify variables to define subpopulations. Statistics are computed separately
for each subpopulation.
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Complex Samples Crosstabs Statistics

Figure 7-2
Crosstabs Statistics dialog box
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Cells. This group allows you to request estimates of the cell population size and row, column,
and table percentages.

Statistics. This group produces statistics associated with the population size and row, column,
and table percentages.

m  Standard error. The standard error of the estimate.

m Confidence interval. A confidence interval for the estimate, using the specified level.

m  Coefficient of variation. The ratio of the standard error of the estimate to the estimate.
|

Expected values. The expected value of the estimate, under the hypothesis of independence
of the row and column variable.

Unweighted count. The number of units used to compute the estimate.

Design effect. The ratio of the variance of the estimate to the variance obtained by assuming

that the sample is a simple random sample. This is a measure of the effect of specifying a
complex design, where values further from 1 indicate greater effects.

m  Square root of design effect. This is a measure of the effect of specifying a complex design,
where values further from 1 indicate greater effects.

m  Residuals. The expected value is the number of cases that you would expect in the cell if there

were no relationship between the two variables. A positive residual indicates that there are

more cases in the cell than there would be if the row and column variables were independent.

m  Adjusted residuals. The residual for a cell (observed minus expected value) divided by an
estimate of its standard error. The resulting standardized residual is expressed in standard
deviation units above or below the mean.
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Summaries for 2-by-2 Tables. This group produces statistics for tables in which the row and column
variable each have two categories. Each is a measure of the strength of the association between
the presence of a factor and the occurrence of an event.

m  Odds ratio. The odds ratio can be used as an estimate of relative risk when the occurrence
of the factor is rare.

m Relative risk. The ratio of the risk of an event in the presence of the factor to the risk of the
event in the absence of the factor.

m Risk difference. The difference between the risk of an event in the presence of the factor and
the risk of the event in the absence of the factor.

Test of independence of rows and columns. This produces chi-square and likelihood-ratio tests of
the hypothesis that a row and column variable are independent. Separate tests are performed
for each pair of variables.

Complex Samples Missing Values

Figure 7-3
Missing Values dialog box

H Complex Samples Crosstabs: Missing Values
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Tables. This group determines which cases are used in the analysis.

m Use all available data. Missing values are determined on a table-by-table basis. Thus, the cases
used to compute statistics may vary across frequency or crosstabulation tables.

m Use consistent case base. Missing values are determined across all variables. Thus, the cases
used to compute statistics are consistent across tables.

Categorical Design Variables. This group determines whether user-missing values are valid
or invalid.
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Complex Samples Options

Figure 7-4
Options dialog box

i Complex Samples Crosstabs: Options
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|Cont|nue” Cancel ” Help ]

Subpopulation Display. You can choose to have subpopulations displayed in the same table or in
separate tables.
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Complex Samples Ratios

The Complex Samples Ratios procedure displays univariate summary statistics for ratios of
variables. Optionally, you can request statistics by subgroups, defined by one or more categorical
variables.

Example. Using the Complex Samples Ratios procedure, you can obtain descriptive statistics for
the ratio of current property value to last assessed value, based on the results of a statewide survey
carried out according to a complex design and with an appropriate analysis plan for the data.

Statistics. The procedure produces ratio estimates, ¢ tests, standard errors, confidence intervals,
coefficients of variation, unweighted counts, population sizes, design effects, and square roots of
design effects.

Data. Numerators and denominators should be positive-valued scale variables. Subpopulation
variables can be string or numeric but should be categorical.

Assumptions. The cases in the data file represent a sample from a complex design that should
be analyzed according to the specifications in the file selected in the Complex Samples Plan
dialog box.

Obtaining Complex Samples Ratios

» From the menus choose:
Analyze > Complex Samples > Ratios...

» Select a plan file. Optionally, select a custom joint probabilities file.

» Click Continue.
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Complex Samples Ratios

Figure 8-1
Ratios dialog box
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» Select at least one numerator variable and denominator variable.

Optionally, you can specify variables to define subgroups for which statistics are produced.

Complex Samples Ratios Statistics

Figure 8-2
Ratios Statistics dialog box
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Statistics. This group produces statistics associated with the ratio estimate.

m  Standard error. The standard error of the estimate.

Confidence interval. A confidence interval for the estimate, using the specified level.
Coefficient of variation. The ratio of the standard error of the estimate to the estimate.

Unweighted count. The number of units used to compute the estimate.

Population size. The estimated number of units in the population.



44

Chapter 8

m Design effect. The ratio of the variance of the estimate to the variance obtained by assuming
that the sample is a simple random sample. This is a measure of the effect of specifying a
complex design, where values further from 1 indicate greater effects.

m  Square root of design effect. This is a measure of the effect of specifying a complex design,
where values further from 1 indicate greater effects.

T test. You can request # tests of the estimates against a specified value.

Complex Samples Ratios Missing Values

Figure 8-3
Ratios Missing Values dialog box
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Ratios. This group determines which cases are used in the analysis.

m Use all available data. Missing values are determined on a ratio-by-ratio basis. Thus, the cases
used to compute statistics may vary across numerator-denominator pairs.

m  Ensure consistent case base. Missing values are determined across all variables. Thus, the
cases used to compute statistics are consistent.

Categorical Design Variables. This group
or invalid.

Complex Samples Options

Figure 8-4
Options dialog box
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Complex Samples General Linear
Model

The Complex Samples General Linear Model (CSGLM) procedure performs linear regression
analysis, as well as analysis of variance and covariance, for samples drawn by complex sampling
methods. Optionally, you can request analyses for a subpopulation.

Example. A grocery store chain surveyed a set of customers concerning their purchasing habits,
according to a complex design. Given the survey results and how much each customer spent in the
previous month, the store wants to see if the frequency with which customers shop is related to
the amount they spend in a month, controlling for the gender of the customer and incorporating
the sampling design.

Statistics. The procedure produces estimates, standard errors, confidence intervals, ¢ tests, design
effects, and square roots of design effects for model parameters, as well as the correlations and
covariances between parameter estimates. Measures of model fit and descriptive statistics for the
dependent and independent variables are also available. Additionally, you can request estimated
marginal means for levels of model factors and factor interactions.

Data. The dependent variable is quantitative. Factors are categorical. Covariates are quantitative
variables that are related to the dependent variable. Subpopulation variables can be string or
numeric but should be categorical.

Assumptions. The cases in the data file represent a sample from a complex design that should
be analyzed according to the specifications in the file selected in the Complex Samples Plan
dialog box.

Obtaining a Complex Samples General Linear Model

From the menus choose:
Analyze > Complex Samples > General Linear Model...

» Select a plan file. Optionally, select a custom joint probabilities file.

» Click Continue.
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Figure 9-1
General Linear Model dialog box
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» Select a dependent variable.

Optionally, you can:
m  Select variables for factors and covariates, as appropriate for your data.

m  Specify a variable to define a subpopulation. The analysis is performed only for the selected
category of the subpopulation variable.
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Figure 9-2
Model dialog box
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Specify Model Effects. By default, the procedure builds a main-effects model using the factors
and covariates specified in the main dialog box. Alternatively, you can build a custom model that
includes interaction effects and nested terms.

Non-Nested Terms

For the selected factors and covariates:

Interaction. Creates the highest-level interaction term for all selected variables.
Main effects. Creates a main-effects term for each variable selected.

All 2-way. Creates all possible two-way interactions of the selected variables.
All 3-way. Creates all possible three-way interactions of the selected variables.
All 4-way. Creates all possible four-way interactions of the selected variables.

All 5-way. Creates all possible five-way interactions of the selected variables.
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Nested Terms

You can build nested terms for your model in this procedure. Nested terms are useful for modeling
the effect of a factor or covariate whose values do not interact with the levels of another factor.
For example, a grocery store chain may follow the spending habits of its customers at several store
locations. Since each customer frequents only one of these locations, the Customer effect can be
said to be nested within the Store location effect.

Additionally, you can include interaction effects, such as polynomial terms involving the same
covariate, or add multiple levels of nesting to the nested term.

Limitations. Nested terms have the following restrictions:

m  All factors within an interaction must be unique. Thus, if 4 is a factor, then specifying 4 *4
is invalid.

m  All factors within a nested effect must be unique. Thus, if 4 is a factor, then specifying 4(4)
is invalid.

B No effect can be nested within a covariate. Thus, if 4 is a factor and X is a covariate, then
specifying A(X) is invalid.

Intercept. The intercept is usually included in the model. If you can assume the data pass through
the origin, you can exclude the intercept. Even if you include the intercept in the model, you
can choose to suppress statistics related to it.

Complex Samples General Linear Model Statistics

Figure 9-3
General Linear Model Statistics dialog box
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Model Parameters. This group allows you to control the display of statistics related to the model
parameters.

m Estimate. Displays estimates of the coefficients.
m  Standard error. Displays the standard error for each coefficient estimate.

m Confidence interval. Displays a confidence interval for each coefficient estimate. The
confidence level for the interval is set in the Options dialog box.

B Ttest. Displays a 7 test of each coefficient estimate. The null hypothesis for each test is that
the value of the coefficient is 0.
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m  Covariances of parameter estimates. Displays an estimate of the covariance matrix for the
model coefficients.

m Correlations of parameter estimates. Displays an estimate of the correlation matrix for the
model coefficients.

m  Design effect. The ratio of the variance of the estimate to the variance obtained by assuming
that the sample is a simple random sample. This is a measure of the effect of specifying a
complex design, where values further from 1 indicate greater effects.

m  Square root of design effect. This is a measure of the effect of specifying a complex design,
where values further from 1 indicate greater effects.

Model fit. Displays R? and root mean squared error statistics.

Population means of dependent variable and covariates. Displays summary information about the
dependent variable, covariates, and factors.

Sample design information. Displays summary information about the sample, including the
unweighted count and the population size.

Complex Samples Hypothesis Tests

Figure 9-4
Hypothesis Tests dialog box

H Complex Samples Logistic Regression: Hypothesis Tests
Test Statistic Sampling Degrees of Freedom
® E @ Eased on sample design
© Adjusted F @ Fixed
© Chi-souare

© Adiusted Chi-sguare

Adjustment for Multiple Comparizons
@ Least significart difference

© sequential Sidak

@] Seguential Bonfetroni

© sigak

@ Bonterroni

|§Corﬂinue§|[ Cancel ][ Help ]

Test Statistic. This group allows you to select the type of statistic used for testing hypotheses. You
can choose between F, adjusted F, chi-square, and adjusted chi-square.

Sampling Degrees of Freedom. This group gives you control over the sampling design degrees of
freedom used to compute p values for all test statistics. If based on the sampling design, the value
is the difference between the number of primary sampling units and the number of strata in the
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first stage of sampling. Alternatively, you can set a custom degrees of freedom by specifying a
positive integer.

Adjustment for Multiple Comparisons. When performing hypothesis tests with multiple contrasts,
the overall significance level can be adjusted from the significance levels for the included
contrasts. This group allows you to choose the adjustment method.

m Least significant difference. This method does not control the overall probability of rejecting
the hypotheses that some linear contrasts are different from the null hypothesis values.

m  Sequential Sidak. This is a sequentially step-down rejective Sidak procedure that is much

less conservative in terms of rejecting individual hypotheses but maintains the same overall
significance level.

m  Sequential Bonferroni. This is a sequentially step-down rejective Bonferroni procedure that is

much less conservative in terms of rejecting individual hypotheses but maintains the same
overall significance level.

m  Sidak. This method provides tighter bounds than the Bonferroni approach.

®  Bonferroni. This method adjusts the observed significance level for the fact that multiple
contrasts are being tested.

Complex Samples General Linear Model Estimated Means

Figure 9-5
General Linear Model Estimated Means dialog box
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The Estimated Means dialog box allows you to display the model-estimated marginal means for
levels of factors and factor interactions specified in the Model subdialog box. You can also request
that the overall population mean be displayed.

Term. Estimated means are computed for the selected factors and factor interactions.

Contrast. The contrast determines how hypothesis tests are set up to compare the estimated means.

m  Simple. Compares the mean of each level to the mean of a specified level. This type of contrast
is useful when there is a control group.

m  Deviation. Compares the mean of each level (except a reference category) to the mean of all of
the levels (grand mean). The levels of the factor can be in any order.

m Difference. Compares the mean of each level (except the first) to the mean of previous levels.
They are sometimes called reverse Helmert contrasts.

m  Helmert. Compares the mean of each level of the factor (except the last) to the mean of
subsequent levels.

m Repeated. Compares the mean of each level (except the last) to the mean of the subsequent
level.

®  Polynomial. Compares the linear effect, quadratic effect, cubic effect, and so on. The
first degree of freedom contains the linear effect across all categories; the second degree
of freedom, the quadratic effect; and so on. These contrasts are often used to estimate
polynomial trends.

Reference Category. The simple and deviation contrasts require a reference category or factor
level against which the others are compared.

Complex Samples General Linear Model Save

Figure 9-6
General Linear Model Save dialog box
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Save Variables. This group allows you to save the model predicted values and residuals as new
variables in the working file.
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Export model as SPSS Statistics data. Writes a dataset in IBM® SPSS® Statistics format containing
the parameter correlation or covariance matrix with parameter estimates, standard errors,
significance values, and degrees of freedom. The order of variables in the matrix file is as follows.

m  rowtype_. Takes values (and value labels), COV (Covariances), CORR (Correlations), EST
(Parameter estimates), SE (Standard errors), SIG (Significance levels), and DF (Sampling
design degrees of freedom). There is a separate case with row type COV (or CORR) for each
model parameter, plus a separate case for each of the other row types.

m varname_. Takes values P1, P2, ..., corresponding to an ordered list of all model parameters,
for row types COV or CORR, with value labels corresponding to the parameter strings shown
in the parameter estimates table. The cells are blank for other row types.

m P1, P2, .. These variables correspond to an ordered list of all model parameters, with variable
labels corresponding to the parameter strings shown in the parameter estimates table, and
take values according to the row type. For redundant parameters, all covariances are set
to zero; correlations are set to the system-missing value; all parameter estimates are set at
zero; and all standard errors, significance levels, and residual degrees of freedom are set to
the system-missing value.

Note: This file is not immediately usable for further analyses in other procedures that read a matrix
file unless those procedures accept all the row types exported here.

Export Model as XML. Saves the parameter estimates and the parameter covariance matrix, if
selected, in XML (PMML) format. You can use this model file to apply the model information to
other data files for scoring purposes.

Complex Samples General Linear Model Options

Figure 9-7
General Linear Model Options dialog box
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User-Missing Values. All design variables, as well as the dependent variable and any covariates,
must have valid data. Cases with invalid data for any of these variables are deleted from the
analysis. These controls allow you to decide whether user-missing values are treated as valid
among the strata, cluster, subpopulation, and factor variables.

Confidence Interval. This is the confidence interval level for coefficient estimates and estimated
marginal means. Specify a value greater than or equal to 50 and less than 100.
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CSGLM Command Additional Features

The command syntax language also allows you to:

Specify custom tests of effects versus a linear combination of effects or a value (using the
CUSTOM subcommand).

Fix covariates at values other than their means when computing estimated marginal means
(using the EMMEANS subcommand).

Specify a metric for polynomial contrasts (using the EMMEANS subcommand).
Specify a tolerance value for checking singularity (using the CRITERIA subcommand).
Create user-specified names for saved variables (using the SAVE subcommand).

Produce a general estimable function table (using the PRINT subcommand).

See the Command Syntax Reference for complete syntax information.
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Complex Samples Logistic Regression

The Complex Samples Logistic Regression procedure performs logistic regression analysis on
a binary or multinomial dependent variable for samples drawn by complex sampling methods.
Optionally, you can request analyses for a subpopulation.

Example. A loan officer has collected past records of customers given loans at several different
branches, according to a complex design. While incorporating the sample design, the officer
wants to see if the probability with which a customer defaults is related to age, employment
history, and amount of credit debt.

Statistics. The procedure produces estimates, exponentiated estimates, standard errors, confidence
intervals, ¢ tests, design effects, and square roots of design effects for model parameters, as well as
the correlations and covariances between parameter estimates. Pseudo R? statistics, classification

tables, and descriptive statistics for the dependent and independent variables are also available.

Data. The dependent variable is categorical. Factors are categorical. Covariates are quantitative
variables that are related to the dependent variable. Subpopulation variables can be string or
numeric but should be categorical.

Assumptions. The cases in the data file represent a sample from a complex design that should
be analyzed according to the specifications in the file selected in the Complex Samples Plan
dialog box.

Obtaining Complex Samples Logistic Regression

From the menus choose:
Analyze > Complex Samples > Logistic Regression...

» Select a plan file. Optionally, select a custom joint probabilities file.

» Click Continue.
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Figure 10-1
Logistic Regression dialog box

H Complex Samples Logistic Regression

Variahles: Dependent Variable: Model
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f Mumber of customers [ o
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. f “ears with current ...
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~

Subpopulation

Yariahle:
|

Category:

[ Ok ” Paste ” Rezet ”Cancel” Help ]

» Select a dependent variable.

Optionally, you can:
m  Select variables for factors and covariates, as appropriate for your data.

m  Specify a variable to define a subpopulation. The analysis is performed only for the selected
category of the subpopulation variable.

Complex Samples Logistic Regression Reference Category

Figure 10-2
Logistic Regression Reference Category dialog box

H Complex Samples Logistic Regression: Reference Category

rReference Category
@ Highest value
Lowest value
Custom

[Cormnue” Cancel ” Help ]
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By default, the Complex Samples Logistic Regression procedure makes the highest-valued
category the reference category. This dialog box allows you to specify the highest value, the
lowest value, or a custom category as the reference category.

Complex Samples Logistic Regression Model

Figure 10-3
Logistic Regression Model dialog box

= . = [ ]
H Complex Samples Logistic Regression: Model
rSpecity Model Effect:
Main effects @ Custom
Factors & Covariates: hodel:
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Ii creddeit creddeit

# othdebt othdekt
l *

Mested Term

Tertm: |

rirtercept

[+ Incluce in model
[ Display statistics

|§C0ntinue§” Cancel ” Help ]

Specify Model Effects. By default, the procedure builds a main-effects model using the factors
and covariates specified in the main dialog box. Alternatively, you can build a custom model that
includes interaction effects and nested terms.

Non-Nested Terms

For the selected factors and covariates:
Interaction. Creates the highest-level interaction term for all selected variables.
Main effects. Creates a main-effects term for each variable selected.

All 2-way. Creates all possible two-way interactions of the selected variables.



57

Complex Samples Logistic Regression

All 3-way. Creates all possible three-way interactions of the selected variables.
All 4-way. Creates all possible four-way interactions of the selected variables.

All 5-way. Creates all possible five-way interactions of the selected variables.

Nested Terms

You can build nested terms for your model in this procedure. Nested terms are useful for modeling
the effect of a factor or covariate whose values do not interact with the levels of another factor.
For example, a grocery store chain may follow the spending habits of its customers at several store
locations. Since each customer frequents only one of these locations, the Customer effect can be
said to be nested within the Store location effect.

Additionally, you can include interaction effects, such as polynomial terms involving the same
covariate, or add multiple levels of nesting to the nested term.

Limitations. Nested terms have the following restrictions:

m  All factors within an interaction must be unique. Thus, if 4 is a factor, then specifying 4 *4
is invalid.

m  All factors within a nested effect must be unique. Thus, if 4 is a factor, then specifying 4(4)
is invalid.

®  No effect can be nested within a covariate. Thus, if 4 is a factor and X is a covariate, then
specifying A(X) is invalid.

Intercept. The intercept is usually included in the model. If you can assume the data pass through
the origin, you can exclude the intercept. Even if you include the intercept in the model, you
can choose to suppress statistics related to it.

Complex Samples Logistic Regression Statistics

Figure 10-4
Logistic Regression Statistics dialog box

Complex Samples Logistic Regression: Statistics

tdodel Fit

[ Pseudo R-square

[&f! Classification table

Parameters

Ez Estimate L Covariances of parameter estimates

[ Exponertisted estimate [~ | Correlstions of parameter estimates

BZ Standard errar BZ Design effect
[ confidence interval ] Square roct of design effect
[ t-test

EZ. Summary statistics for model variables
ﬁz. Sample design information

(Lcamen) (Lren)

Model Fit. Controls the display of statistics that measure the overall model performance.
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Pseudo R-square. The R? statistic from linear regression does not have an exact counterpart
among logistic regression models. There are, instead, multiple measures that attempt to mimic
the properties of the R? statistic.

Classification table. Displays the tabulated cross-classifications of the observed category by
the model-predicted category on the dependent variable.

Parameters. This group allows you to control the display of statistics related to the model
parameters.

Estimate. Displays estimates of the coefficients.

Exponentiated estimate. Displays the base of the natural logarithm raised to the power of the
estimates of the coefficients. While the estimate has nice properties for statistical testing, the
exponentiated estimate, or exp(B), is easier to interpret.

Standard error. Displays the standard error for each coefficient estimate.

Confidence interval. Displays a confidence interval for each coefficient estimate. The
confidence level for the interval is set in the Options dialog box.

T test. Displays a ¢ test of each coefficient estimate. The null hypothesis for each test is that
the value of the coefficient is 0.

Covariances of parameter estimates. Displays an estimate of the covariance matrix for the
model coefficients.

Correlations of parameter estimates. Displays an estimate of the correlation matrix for the
model coefficients.

Design effect. The ratio of the variance of the estimate to the variance obtained by assuming
that the sample is a simple random sample. This is a measure of the effect of specifying a
complex design, where values further from 1 indicate greater effects.

Square root of design effect. This is a measure of the effect of specifying a complex design,
where values further from 1 indicate greater effects.

Summary statistics for model variables. Displays summary information about the dependent
variable, covariates, and factors.

Sample design information. Displays summary information about the sample, including the
unweighted count and the population size.
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Figure 10-5

Hypothesis Tests dialog box

Complex Samples Logistic Regression

H Complex Samples Logistic Regression: Hypothesis Tests

Test Statistic

Cl3

© Adjusted F

© Chi-souare

© Adiusted Chi-sguare

Adiuztment for Multiple Comparisons
@ Least significart difference

© sequential Sidak

@] Seguential Bonfetroni

© sigak

@ Bonterroni

Sampling Degrees of Freedom

@ Eased on sample design
@ Fixed

|§Corﬂinue§|[ Cancel ][ Help ]

Test Statistic. This group allows you to select the type of statistic used for testing hypotheses. You
can choose between F, adjusted F, chi-square, and adjusted chi-square.

Sampling Degrees of Freedom. This group gives you control over the sampling design degrees of
freedom used to compute p values for all test statistics. If based on the sampling design, the value
is the difference between the number of primary sampling units and the number of strata in the
first stage of sampling. Alternatively, you can set a custom degrees of freedom by specifying a
positive integer.

Adjustment for Multiple Comparisons. When performing hypothesis tests with multiple contrasts,
the overall significance level can be adjusted from the significance levels for the included
contrasts. This group allows you to choose the adjustment method.

Least significant difference. This method does not control the overall probability of rejecting
the hypotheses that some linear contrasts are different from the null hypothesis values.

Sequential Sidak. This is a sequentially step-down rejective Sidak procedure that is much
less conservative in terms of rejecting individual hypotheses but maintains the same overall

significance level.

Sequential Bonferroni. This is a sequentially step-down rejective Bonferroni procedure that is
much less conservative in terms of rejecting individual hypotheses but maintains the same
overall significance level.

Sidak. This method provides tighter bounds than the Bonferroni approach.

Bonferroni. This method adjusts the observed significance level for the fact that multiple
contrasts are being tested.
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Complex Samples Logistic Regression Odds Ratios

Figure 10-6
Logistic Regression Odds Ratios dialog box
H Complex Samples Logistic Regression: Odds Ratios
Factara: Oddz Retios for Comparing Factor Levels:
d:l Level of educstion [ed] Factor |Reference Categ... |
Lewvel of education [... (Highest value)
Covariates: Oddz Retios for Change in Covariate Yalues:
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f Deht to income ratio...
R .

Covariate |units of Change |
Years with curren... 1 |§|

Dbt to income rati... 1

One set of odds ratios is produced for each variable in the Odds Ratios grids. For
each set, all other factors in the model are evalusted at their highest levels; all cther
covaristes are evaluated at their means.

|§Corﬂinue§|[ Cancel ][ Help ]

The Odds Ratios dialog box allows you to display the model-estimated odds ratios for specified
factors and covariates. A separate set of odds ratios is computed for each category of the
dependent variable except the reference category.

Factors. For each selected factor, displays the ratio of the odds at each category of the factor to
the odds at the specified reference category.

Covariates. For each selected covariate, displays the ratio of the odds at the covariate’s mean value
plus the specified units of change to the odds at the mean.

When computing odds ratios for a factor or covariate, the procedure fixes all other factors at their
highest levels and all other covariates at their means. If a factor or covariate interacts with other
predictors in the model, then the odds ratios depend not only on the change in the specified
variable but also on the values of the variables with which it interacts. If a specified covariate
interacts with itself in the model (for example, age*age), then the odds ratios depend on both the
change in the covariate and the value of the covariate.
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Complex Samples Logistic Regression Save

Figure 10-7
Logistic Regression Save dialog box

H Complex Samples Logistic Regression: Save

Save Vatiahles

|| Predicted probahbilties (one per category of the dependent variable)

Export Model as PASW Statistics Data

File: | | [ Browese... ]

@ Parameter estimates and covariance matrix

@' Parameter estimates and correlation matrix

Export Model as XML

File: | | [ Broweze. .. ]

@ Parameter estimates and covariance matrix

@] Parameter estimates only

(

Cancel ][ Helpy ]

Save Variables. This group allows you to save the model-predicted category and predicted
probabilities as new variables in the active dataset.

Export model as SPSS Statistics data. Writes a dataset in IBM® SPSS® Statistics format containing
the parameter correlation or covariance matrix with parameter estimates, standard errors,
significance values, and degrees of freedom. The order of variables in the matrix file is as follows.

rowtype_. Takes values (and value labels), COV (Covariances), CORR (Correlations), EST
(Parameter estimates), SE (Standard errors), SIG (Significance levels), and DF (Sampling
design degrees of freedom). There is a separate case with row type COV (or CORR) for each
model parameter, plus a separate case for each of the other row types.

varname_. Takes values P1, P2, ..., corresponding to an ordered list of all model parameters,
for row types COV or CORR, with value labels corresponding to the parameter strings shown
in the parameter estimates table. The cells are blank for other row types.

P1, P2, ... These variables correspond to an ordered list of all model parameters, with variable
labels corresponding to the parameter strings shown in the parameter estimates table, and
take values according to the row type. For redundant parameters, all covariances are set

to zero; correlations are set to the system-missing value; all parameter estimates are set at
zero; and all standard errors, significance levels, and residual degrees of freedom are set to
the system-missing value.

Note: This file is not immediately usable for further analyses in other procedures that read a matrix
file unless those procedures accept all the row types exported here.

Export Model as XML. Saves the parameter estimates and the parameter covariance matrix, if
selected, in XML (PMML) format. You can use this model file to apply the model information to
other data files for scoring purposes.
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Complex Samples Logistic Regression Options

Figure 10-8
Logistic Regression Options dialog box

HH Com plex Samples Logistic Regression: Options
Es=timation User-Missing Values
Maximum terations: 100 © Treat as invalid
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|| Display iteration histary

Cancel ][ Helps ]

Estimation. This group gives you control of various criteria used in the model estimation.

Maximum Iterations. The maximum number of iterations the algorithm will execute. Specify a
non-negative integer.

Maximum Step-Halving. At each iteration, the step size is reduced by a factor of 0.5 until the
log-likelihood increases or maximum step-halving is reached. Specify a positive integer.

Limit iterations based on change in parameter estimates. When selected, the algorithm stops
after an iteration in which the absolute or relative change in the parameter estimates is less
than the value specified, which must be non-negative.

Limit iterations based on change in log-likelihood. When selected, the algorithm stops after an
iteration in which the absolute or relative change in the log-likelihood function is less than the
value specified, which must be non-negative.

Check for complete separation of data points. When selected, the algorithm performs tests to
ensure that the parameter estimates have unique values. Separation occurs when the procedure
can produce a model that correctly classifies every case.

Display iteration history. Displays parameter estimates and statistics at every » iterations
beginning with the 0th iteration (the initial estimates). If you choose to print the iteration
history, the last iteration is always printed regardless of the value of n.

User-Missing Values. All design variables, as well as the dependent variable and any covariates,
must have valid data. Cases with invalid data for any of these variables are deleted from the
analysis. These controls allow you to decide whether user-missing values are treated as valid
among the strata, cluster, subpopulation, and factor variables.
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Confidence Interval. This is the confidence interval level for coefficient estimates, exponentiated
coefficient estimates, and odds ratios. Specify a value greater than or equal to 50 and less than 100.

CSLOGISTIC Command Additional Features

The command syntax language also allows you to:

Specify custom tests of effects versus a linear combination of effects or a value (using the
CUSTOM subcommand).

Fix values of other model variables when computing odds ratios for factors and covariates
(using the ODDSRATIOS subcommand).

Specify a tolerance value for checking singularity (using the CRITERIA subcommand).
Create user-specified names for saved variables (using the SAVE subcommand).

Produce a general estimable function table (using the PRINT subcommand).

See the Command Syntax Reference for complete syntax information.
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The Complex Samples Ordinal Regression procedure performs regression analysis on a binary
or ordinal dependent variable for samples drawn by complex sampling methods. Optionally,
you can request analyses for a subpopulation.

Example. Representatives considering a bill before the legislature are interested in whether there
is public support for the bill and how support for the bill is related to voter demographics.
Pollsters design and conduct interviews according to a complex sampling design. Using Complex
Samples Ordinal Regression, you can fit a model for the level of support for the bill based upon
voter demographics.

Data. The dependent variable is ordinal. Factors are categorical. Covariates are quantitative
variables that are related to the dependent variable. Subpopulation variables can be string or
numeric but should be categorical.

Assumptions. The cases in the data file represent a sample from a complex design that should
be analyzed according to the specifications in the file selected in the Complex Samples Plan
dialog box.

Obtaining Complex Samples Ordinal Regression

From the menus choose:
Analyze > Complex Samples > Ordinal Regression...

» Select a plan file. Optionally, select a custom joint probabilities file.

» Click Continue.

© Copyright SPSS Inc. 1989, 2010 64
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Figure 11-1

Ordinal Regression dialog box

Complex Samples Ordinal Regression

H Complex Samples Ordinal Regression
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Save...
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» Select a dependent variable.

Optionally, you can:

Select variables for factors and covariates, as appropriate for your data.

Specify a variable to define a subpopulation. The analysis is performed only for the selected

category of the subpopulation variable, although variances are still properly estimated based

]
]

on the entire dataset.
®  Select a link function.

Link function. The link function is a transformation of the cumulative probabilities that allows
estimation of the model. Five link functions are available, summarized in the following table.

Function

Form

Typical application

Logit

log(&/(1-9))

Evenly distributed categories

Complementary log-log

log(—log(1-¢))

Higher categories more probable

Negative log-log

—log(-log(¢))

Lower categories more probable

Probit

RG]

Latent variable is normally
distributed

Cauchit (inverse Cauchy)

tan(n(£—0.5))

Latent variable has many extreme
values
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Complex Samples Ordinal Regression Response Probabilities
Figure 11-2

Ordinal Regression Response Probabilities dialog box

i Complex Samples Ordinal Regression: Response Probabilities

Cumulative Response Probakilitie

® Accumulste from lowest value of dependent variable to highest value

Accumulste from highest value of dependert variable ta lowest value

|C0rrt|nue” cancel ” Help ]

The Response Probabilities dialog box allows you to specify whether the cumulative probability
of a response (that is, the probability of belonging up to and including a particular category of the
dependent variable) increases with increasing or decreasing values of the dependent variable.

Complex Samples Ordinal Regression Model

Figure 11-3
Ordinal Regression Model dialog box

H Complex Samples Ordinal Regression: Model

—specity Model Effect:

Main effects @ custom
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ECDntinueé” Cancel ” Help ]

Specify Model Effects. By default, the procedure builds a main-effects model using the factors

and covariates specified in the main dialog box. Alternatively, you can build a custom model that
includes interaction effects and nested terms.
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Non-Nested Terms

For the selected factors and covariates:

Interaction. Creates the highest-level interaction term for all selected variables.
Main effects. Creates a main-effects term for each variable selected.

All 2-way. Creates all possible two-way interactions of the selected variables.
All 3-way. Creates all possible three-way interactions of the selected variables.
All 4-way. Creates all possible four-way interactions of the selected variables.

All 5-way. Creates all possible five-way interactions of the selected variables.

Nested Terms

You can build nested terms for your model in this procedure. Nested terms are useful for modeling
the effect of a factor or covariate whose values do not interact with the levels of another factor.
For example, a grocery store chain may follow the spending habits of its customers at several store
locations. Since each customer frequents only one of these locations, the Customer effect can be
said to be nested within the Store location effect.

Additionally, you can include interaction effects, such as polynomial terms involving the same
covariate, or add multiple levels of nesting to the nested term.

Limitations. Nested terms have the following restrictions:

m  All factors within an interaction must be unique. Thus, if 4 is a factor, then specifying 4 *4
is invalid.

m  All factors within a nested effect must be unique. Thus, if 4 is a factor, then specifying 4(4)
is invalid.

B No effect can be nested within a covariate. Thus, if 4 is a factor and X is a covariate, then
specifying A(X) is invalid.
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Complex Samples Ordinal Regression Statistics

Figure 11-4
Ordinal Regression Statistics dialog box
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Model Fit. Controls the display of statistics that measure the overall model performance.

Pseudo R-square. The R? statistic from linear regression does not have an exact counterpart
among ordinal regression models. There are, instead, multiple measures that attempt to mimic
the properties of the R? statistic.

Classification table. Displays the tabulated cross-classifications of the observed category by
the model-predicted category on the dependent variable.

Parameters. This group allows you to control the display of statistics related to the model

parameters.

m Estimate. Displays estimates of the coefficients.

m  Exponentiated estimate. Displays the base of the natural logarithm raised to the power of the
estimates of the coefficients. While the estimate has nice properties for statistical testing, the
exponentiated estimate, or exp(B), is easier to interpret.

Standard error. Displays the standard error for each coefficient estimate.
Confidence interval. Displays a confidence interval for each coefficient estimate. The
confidence level for the interval is set in the Options dialog box.

m Ttest. Displays a 7 test of each coefficient estimate. The null hypothesis for each test is that
the value of the coefficient is 0.

m  Covariances of parameter estimates. Displays an estimate of the covariance matrix for the
model coefficients.

m  Correlations of parameter estimates. Displays an estimate of the correlation matrix for the

model coefficients.



69

Complex Samples Ordinal Regression

m  Design effect. The ratio of the variance of the estimate to the variance obtained by assuming
that the sample is a simple random sample. This is a measure of the effect of specifying a
complex design, where values further from 1 indicate greater effects.

m  Square root of design effect. This is a measure, expressed in units comparable to those of
the standard error, of the effect of specifying a complex design, where values further from
1 indicate greater effects.

Parallel Lines. This group allows you to request statistics associated with a model with nonparallel
lines where a separate regression line is fitted for each response category (except the last).

m  Wald test. Produces a test of the null hypothesis that regression parameters are equal for all
cumulative responses. The model with nonparallel lines is estimated and the Wald test of
equal parameters is applied.

m Parameter estimates. Displays estimates of the coefficients and standard errors for the model
with nonparallel lines.

m  Covariances of parameter estimates. Displays an estimate of the covariance matrix for the
coefficients of the model with nonparallel lines.

Summary statistics for model variables. Displays summary information about the dependent
variable, covariates, and factors.

Sample design information. Displays summary information about the sample, including the
unweighted count and the population size.

Complex Samples Hypothesis Tests

Figure 11-5
Hypothesis Tests dialog box

Complex Samples Logistic Regression: Hypothesis Tests
Test Statistic Sampling Degrees of Freedom
@ F @ Eased an sample design
© Adjusted F © Fixed
© Chi-zguare

@ adjusted Chi-sguare

Adjustment for Multiple Comparizons
@ Least significart difference

@ sequertial Sidak

© Sequential Bonferrani

© sidak

@ Bonterroni

|§Corﬂinue§|[ Cancel ][ Help ]
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Test Statistic. This group allows you to select the type of statistic used for testing hypotheses. You
can choose between F, adjusted F, chi-square, and adjusted chi-square.

Sampling Degrees of Freedom. This group gives you control over the sampling design degrees of
freedom used to compute p values for all test statistics. If based on the sampling design, the value
is the difference between the number of primary sampling units and the number of strata in the
first stage of sampling. Alternatively, you can set a custom degrees of freedom by specifying a
positive integer.

Adjustment for Multiple Comparisons. When performing hypothesis tests with multiple contrasts,
the overall significance level can be adjusted from the significance levels for the included
contrasts. This group allows you to choose the adjustment method.

m Least significant difference. This method does not control the overall probability of rejecting
the hypotheses that some linear contrasts are different from the null hypothesis values.

m  Sequential Sidak. This is a sequentially step-down rejective Sidak procedure that is much
less conservative in terms of rejecting individual hypotheses but maintains the same overall
significance level.

m  Sequential Bonferroni. This is a sequentially step-down rejective Bonferroni procedure that is
much less conservative in terms of rejecting individual hypotheses but maintains the same
overall significance level.

m  Sidak. This method provides tighter bounds than the Bonferroni approach.

m  Bonferroni. This method adjusts the observed significance level for the fact that multiple
contrasts are being tested.

Complex Samples Ordinal Regression Odds Ratios

Figure 11-6
Ordinal Regression Odds Ratios dialog box

H Complex Samples Ordinal Regression: Odds Ratios

Factors: Cumulative Odds Ratins for Comparing Factar Levels:
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+
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each set, all ather factors in the model are evaluated at their highest levels; all other covariates
are evaluated at their means.

[ cancel ][ Help ]

The Odds Ratios dialog box allows you to display the model-estimated cumulative odds ratios for
specified factors and covariates. This feature is only available for models using the Logit link
function. A single cumulative odds ratio is computed for all categories of the dependent variable
except the last; the proportional odds model postulates that they are all equal.
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Factors. For each selected factor, displays the ratio of the cumulative odds at each category of the
factor to the odds at the specified reference category.

Covariates. For each selected covariate, displays the ratio of the cumulative odds at the covariate’s
mean value plus the specified units of change to the odds at the mean.

When computing odds ratios for a factor or covariate, the procedure fixes all other factors at their
highest levels and all other covariates at their means. If a factor or covariate interacts with other
predictors in the model, then the odds ratios depend not only on the change in the specified
variable but also on the values of the variables with which it interacts. If a specified covariate
interacts with itself in the model (for example, age*age), then the odds ratios depend on both the
change in the covariate and the value of the covariate.

Complex Samples Ordinal Regression Save

Figure 11-7
Ordinal Regression Save dialog box
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Save Variables. This group allows you to save the model-predicted category, probability of
predicted category, probability of observed category, cumulative probabilities, and predicted
probabilities as new variables in the active dataset.

Export model as SPSS Statistics data. Writes a dataset in IBM® SPSS® Statistics format containing
the parameter correlation or covariance matrix with parameter estimates, standard errors,
significance values, and degrees of freedom. The order of variables in the matrix file is as follows.
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m rowtype_. Takes values (and value labels), COV (Covariances), CORR (Correlations), EST
(Parameter estimates), SE (Standard errors), SIG (Significance levels), and DF (Sampling
design degrees of freedom). There is a separate case with row type COV (or CORR) for each
model parameter, plus a separate case for each of the other row types.

m varname_. Takes values P1, P2, ..., corresponding to an ordered list of all model parameters,
for row types COV or CORR, with value labels corresponding to the parameter strings shown

in the parameter estimates table. The

cells are blank for other row types.

m P1, P2, .. These variables correspond to an ordered list of all model parameters, with variable
labels corresponding to the parameter strings shown in the parameter estimates table, and
take values according to the row type. For redundant parameters, all covariances are set
to zero; correlations are set to the system-missing value; all parameter estimates are set at
zero; and all standard errors, significance levels, and residual degrees of freedom are set to

the system-missing value.

Note: This file is not immediately usable for further analyses in other procedures that read a matrix

file unless those procedures accept all the

row types exported here.

Export model as XML. Saves the parameter estimates and the parameter covariance matrix, if
selected, in XML (PMML) format. You can use this model file to apply the model information to

other data files for scoring purposes.

Complex Samples Ordinal Regression Options

Figure 11-8
Ordinal Regression Options dialog box
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Estimation Method. You can select a parameter estimation method; choose between
Newton-Raphson, Fisher scoring, or a hybrid method in which Fisher scoring iterations are
performed before switching to the Newton-Raphson method. If convergence is achieved during
the Fisher scoring phase of the hybrid method before the maximum number of Fisher iterations is
reached, the algorithm continues with the Newton-Raphson method.

Estimation. This group gives you control of various criteria used in the model estimation.

®  Maximum lterations. The maximum number of iterations the algorithm will execute. Specify a
non-negative integer.

®  Maximum Step-Halving. At each iteration, the step size is reduced by a factor of 0.5 until the
log-likelihood increases or maximum step-halving is reached. Specify a positive integer.

m Limit iterations based on change in parameter estimates. When selected, the algorithm stops
after an iteration in which the absolute or relative change in the parameter estimates is less
than the value specified, which must be non-negative.

®m Limit iterations based on change in log-likelihood. When selected, the algorithm stops after an
iteration in which the absolute or relative change in the log-likelihood function is less than the
value specified, which must be non-negative.

m  Check for complete separation of data points. When selected, the algorithm performs tests to
ensure that the parameter estimates have unique values. Separation occurs when the procedure
can produce a model that correctly classifies every case.

m Display iteration history. Displays parameter estimates and statistics at every » iterations
beginning with the Oth iteration (the initial estimates). If you choose to print the iteration
history, the last iteration is always printed regardless of the value of n.

User-Missing Values. Scale design variables, as well as the dependent variable and any covariates,
should have valid data. Cases with invalid data for any of these variables are deleted from the
analysis. These controls allow you to decide whether user-missing values are treated as valid
among the strata, cluster, subpopulation, and factor variables.

Confidence Interval. This is the confidence interval level for coefficient estimates, exponentiated
coefficient estimates, and odds ratios. Specify a value greater than or equal to 50 and less than 100.

CSORDINAL Command Additional Features

The command syntax language also allows you to:

m  Specify custom tests of effects versus a linear combination of effects or a value (using the
CUSTOM subcommand).

m  Fix values of other model variables at values other than their means when computing
cumulative odds ratios for factors and covariates (using the ODDSRATIOS subcommand).

m  Use unlabeled values as custom reference categories for factors when odds ratios are requested
(using the ODDSRATIOS subcommand).

m  Specify a tolerance value for checking singularity (using the CRITERIA subcommand).
®  Produce a general estimable function table (using the PRINT subcommand).

m  Save more than 25 probability variables (using the SAVE subcommand).

See the Command Syntax Reference for complete syntax information.
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The Complex Samples Cox Regression procedure performs survival analysis for samples drawn
by complex sampling methods. Optionally, you can request analyses for a subpopulation.

Examples. A government law enforcement agency is concerned about recidivism rates in their area
of jurisdiction. One of the measures of recidivism is the time until second arrest for offenders. The
agency would like to model time to rearrest using Cox Regression but are worried the proportional
hazards assumption is invalid across age categories.

Medical researchers are investigating survival times for patients exiting a rehabilitation program
post-ischemic stroke. There is the potential for multiple cases per subject, since patient histories
change as the occurrence of significant nondeath events are noted and the times of these events
recorded. The sample is also left-truncated in the sense that the observed survival times are
“inflated” by the length of rehabilitation, because while the onset of risk starts at the time of the
ischemic stroke, only patients who survive past the rehabilitation program are in the sample.

Survival Time. The procedure applies Cox regression to analysis of survival times—that is, the
length of time before the occurrence of an event. There are two ways to specify the survival time,
depending upon the start time of the interval:

®  Time=0. Commonly, you will have complete information on the start of the interval for each
subject and will simply have a variable containing end times (or create a single variable with
end times from Date & Time variables; see below).

m Varies by subject. This is appropriate when you have left-truncation, also called delayed
entry; for example, if you are analyzing survival times for patients exiting a rehabilitation
program post-stroke, you might consider that their onset of risk starts at the time of the stroke.
However, if your sample only includes patients who have survived the rehabilitation program,
then your sample is left-truncated in the sense that the observed survival times are “inflated”
by the length of rehabilitation. You can account for this by specifying the time at which they
exited rehabilitation as the time of entry into the study.

Date & Time Variables. Date & Time variables cannot be used to directly define the start and

end of the interval; if you have Date & Time variables, you should use them to create variables
containing survival times. If there is no left-truncation, simply create a variable containing end
times based upon the difference between the date of entry into the study and the observation date.
If there is left-truncation, create a variable containing start times, based upon the difference
between the date of the start of the study and the date of entry, and a variable containing end times,
based upon the difference between the date of the start of the study and the date of observation.

Event Status. You need a variable that records whether the subject experienced the event of interest
within the interval. Subjects for whom the event has not occurred are right-censored.

© Copyright SPSS Inc. 1989, 2010 74
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Subject Identifier. You can easily incorporate piecewise-constant, time-dependent predictors by
splitting the observations for a single subject across multiple cases. For example, if you are
analyzing survival times for patients post-stroke, variables representing their medical history
should be useful as predictors. Over time, they may experience major medical events that alter
their medical history. The following table shows how to structure such a dataset: Patient ID is the
subject identifier, End time defines the observed intervals, Status records major medical events,
and Prior history of heart attack and Prior history of hemorrhaging are piecewise-constant,
time-dependent predictors.

Patient ID | End time | Status Prior history of Prior history of
heart attack hemorrhaging
1 5 Heart Attack No No
1 7 Hemorrhaging Yes No
1 8 Died Yes Yes
2 24 Died No No
3 8 Heart Attack No No
3 15 Died Yes No

Assumptions. The cases in the data file represent a sample from a complex design that should
be analyzed according to the specifications in the file selected in the Complex Samples Plan
dialog box.

Typically, Cox regression models assume proportional hazards—that is, the ratio of hazards
from one case to another should not vary over time. If this assumption does not hold, you may
need to add time-dependent predictors to the model.

Kaplan-Meier Analysis. If you do not select any predictors (or do not enter any selected predictors
into the model) and choose the product limit method for computing the baseline survival curve on
the Options tab, the procedure performs a Kaplan-Meier type of survival analysis.

To Obtain Complex Samples Cox Regression

From the menus choose:
Analyze > Complex Samples > Cox Regression...

Select a plan file. Optionally, select a custom joint probabilities file.

Click Continue.
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Figure 12-1

Cox Regression dialog box, Time and Event tab
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» Specify the survival time by selecting the entry and exit times from the study.

» Select an event status variable.

» Click Define Event and define at least one event value.

Optionally, you can select a subject identifier.
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Define Event

Figure 12-2
Define Event dialog box
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Specify the values that indicate a terminal event has occurred.

m Individual value(s). Specify one or more values by entering them into the grid or selecting them
from a list of values with defined value labels.

m Range of values. Specify a range of values by entering the minimum and maximum values or
selecting values from a list with defined value labels.
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Figure 12-3
Cox Regression dialog box, Predictors tab
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The Predictors tab allows you to specify the factors and covariates used to build model effects.
Factors. Factors are categorical predictors; they can be numeric or string.
Covariates. Covariates are scale predictors; they must be numeric.

Time-Dependent Predictors. There are certain situations in which the proportional hazards
assumption does not hold. That is, hazard ratios change across time; the values of one (or more)
of your predictors are different at different time points. In such cases, you need to specify
time-dependent predictors. For more information, see the topic Define Time-Dependent Predictor
on p. 79. Time-dependent predictors can be selected as factors or covariates.
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Define Time-Dependent Predictor

Figure 12-4
Cox Regression Define Time-Dependent Predictor dialog box
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The Define Time-Dependent Predictor dialog box allows you to create a predictor that is
dependent upon the built-in time variable, T . You can use this variable to define time-dependent
covariates in two general ways:

If you want to estimate an extended Cox regression model that allows nonproportional
hazards, you can do so by defining your time-dependent predictor as a function of the time
variable 7 and the covariate in question. A common example would be the simple product of
the time variable and the predictor, but more complex functions can be specified as well.

Some variables may have different values at different time periods but aren’t systematically
related to time. In such cases, you need to define a segmented time-dependent predictor,
which can be done using logical expressions. Logical expressions take the value 1 if true
and 0 if false. Using a series of logical expressions, you can create your time-dependent
predictor from a set of measurements. For example, if you have blood pressure measured
once a week for the four weeks of your study (identified as BP1 to BP4), you can define your
time-dependent predictor as (T_<1)*BPI+(T >=1& T <2)*BP2+(T_ >=2& T <3)
*BP3+ (T _>=3 & T_<4)* BP4. Notice that exactly one of the terms in parentheses will
be equal to 1 for any given case and the rest will all equal 0. In other words, this function
means that if time is less than one week, use BP/; if it is more than one week but less than
two weeks, use BP2; and so on.
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Note: 1f your segmented, time-dependent predictor is constant within segments, as in the blood
pressure example given above, it may be easier for you to specify the piecewise-constant,
time-dependent predictor by splitting subjects across multiple cases. See the discussion on
Subject Identifiers in Complex Samples Cox Regression on p. 74 for more information.

In the Define Time-Dependent Predictor dialog box, you can use the function-building controls
to build the expression for the time-dependent covariate, or you can enter it directly in the
Numeric Expression text area. Note that string constants must be enclosed in quotation marks
or apostrophes, and numeric constants must be typed in American format, with the dot as the
decimal delimiter. The resulting variable is given the name you specify and should be included
as a factor or covariate on the Predictors tab.

Subgroups

Figure 12-5
Cox Regression dialog box, Subgroups tab
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Baseline Strata. A separate baseline hazard and survival function is computed for each value of
this variable, while a single set of model coefficients is estimated across strata.

Subpopulation Variable. Specify a variable to define a subpopulation. The analysis is performed
only for the selected category of the subpopulation variable.
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Figure 12-6
Cox Regression dialog box, Model tab
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Specify Model Effects. By default, the procedure builds a main-effects model using the factors
and covariates specified in the main dialog box. Alternatively, you can build a custom model that
includes interaction effects and nested terms.

Non-Nested Terms

For the selected factors and covariates:

Interaction. Creates the highest-level interaction term for all selected variables.
Main effects. Creates a main-effects term for each variable selected.

All 2-way. Creates all possible two-way interactions of the selected variables.
All 3-way. Creates all possible three-way interactions of the selected variables.
All 4-way. Creates all possible four-way interactions of the selected variables.

All 5-way. Creates all possible five-way interactions of the selected variables.



82

Chapter 12

Nested Terms

You can build nested terms for your model in this procedure. Nested terms are useful for modeling
the effect of a factor or covariate whose values do not interact with the levels of another factor.
For example, a grocery store chain may follow the spending habits of its customers at several store
locations. Since each customer frequents only one of these locations, the Customer effect can be
said to be nested within the Store location effect.

Additionally, you can include interaction effects, such as polynomial terms involving the same
covariate, or add multiple levels of nesting to the nested term.

Limitations. Nested terms have the following restrictions:
m  All factors within an interaction must be unique. Thus, if 4 is a factor, then specifying A4 *4
is invalid.

All factors within a nested effect must be unique. Thus, if 4 is a factor, then specifying 4(4)
is invalid.

B No effect can be nested within a covariate. Thus, if 4 is a factor and X is a covariate, then
specifying A(X) is invalid.

Statistics

Figure 12-7
Cox Regression dialog box, Statistics tab
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Sample design information. Displays summary information about the sample, including the
unweighted count and the population size.

Event and censoring summary. Displays summary information about the number and percentage of
censored cases.

Risk set at event times. Displays number of events and number at risk for each event time in
each baseline stratum.

Parameters. This group allows you to control the display of statistics related to the model
parameters.

m Estimate. Displays estimates of the coefficients.

m  Exponentiated estimate. Displays the base of the natural logarithm raised to the power of the
estimates of the coefficients. While the estimate has nice properties for statistical testing, the
exponentiated estimate, or exp(B), is easier to interpret.

m  Standard error. Displays the standard error for each coefficient estimate.

m  Confidence interval. Displays a confidence interval for each coefficient estimate. The
confidence level for the interval is set in the Options dialog box.

m t-test. Displays a ¢ test of each coefficient estimate. The null hypothesis for each test is that the
value of the coefficient is 0.

m Covariances of parameter estimates. Displays an estimate of the covariance matrix for the
model coefficients.

m  Correlations of parameter estimates. Displays an estimate of the correlation matrix for the
model coefficients.

m  Design effect. The ratio of the variance of the estimate to the variance obtained by assuming
that the sample is a simple random sample. This is a measure of the effect of specifying a
complex design, where values further from 1 indicate greater effects.

m  Square root of design effect. This is a measure of the effect of specifying a complex design,
where values further from 1 indicate greater effects.

Model Assumptions. This group allows you to produce a test of the proportional hazards
assumption. The test compares the fitted model to an alternative model that includes
time-dependent predictors x* TF for each predictor x, where TF is the specified time function.

m  Time Function. Specifies the form of _TF for the alternative model. For the identity function,
_TF=T . For the log function, TF=log(T ). For Kaplan-Meier, TF=1-Sgm(T ), where
Skwm(.) is the Kaplan-Meier estimate of the survival function. For rank, TF is the rank-order
of T_among the observed end times.

m Parameter estimates for alternative model. Displays the estimate, standard error, and confidence
interval for each parameter in the alternative model.

m  Covariance matrix for alternative model. Displays the matrix of estimated covariances between
parameters in the alternative model.

Baseline survival and cumulative hazard functions. Displays the baseline survival function and
baseline cumulative hazards function along with their standard errors.

Note: If time-dependent predictors defined on the Predictors tab are included in the model, this
option is not available.
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Plots

Figure 12-8
Cox Regression dialog box, Plots tab
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The Plots tab allows you to request plots of the hazard function, survival function, log-minus-log
of the survival function, and one minus the survival function. You can also choose to plot
confidence intervals along the specified functions; the confidence level is set on the Options tab.

Predictor patterns. You can specify a pattern of predictor values to be used for the requested plots
and the exported survival file on the Export tab. Note that these options are not available if
time-dependent predictors defined on the Predictors tab are included in the model.

m  Plot Factors at. By default, each factor is evaluated at its highest level. Enter or select a
different level if desired. Alternatively, you can choose to plot separate lines for each level
of a single factor by selecting the check box for that factor.

m Plot Covariates at. Each covariate is evaluated at its mean. Enter or select a different value
if desired.
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Hypothesis Tests

Figure 12-9
Cox Regression dialog box, Hypothesis Tests tab
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Test Statistic. This group allows you to select the type of statistic used for testing hypotheses. You
can choose between F, adjusted F, chi-square, and adjusted chi-square.

Sampling Degrees of Freedom.

This group gives you control over the sampling design degrees of

freedom used to compute p values for all test statistics. If based on the sampling design, the value
is the difference between the number of primary sampling units and the number of strata in the
first stage of sampling. Alternatively, you can set a custom degrees of freedom by specifying a

positive integer.

Adjustment for Multiple Compa

risons. When performing hypothesis tests with multiple contrasts,

the overall significance level can be adjusted from the significance levels for the included
contrasts. This group allows you to choose the adjustment method.

m Least significant difference. This method does not control the overall probability of rejecting

the hypotheses that some

linear contrasts are different from the null hypothesis values.

m  Sequential Sidak. This is a sequentially step-down rejective Sidak procedure that is much

less conservative in terms
significance level.

of rejecting individual hypotheses but maintains the same overall
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Save

m  Sequential Bonferroni. This is a sequentially step-down rejective Bonferroni procedure that is
much less conservative in terms of rejecting individual hypotheses but maintains the same
overall significance level.

Sidak. This method provides tighter bounds than the Bonferroni approach.

Bonferroni. This method adjusts the observed significance level for the fact that multiple
contrasts are being tested.

Figure 12-10
Cox Regression dialog box, Save tab
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Save Variables. This group allows you to save model-related variables to the active dataset for
further use in diagnostics and reporting of results. Note that none of these are available when
time-dependent predictors are included in the model.

m  Survival function. Saves the probability of survival (the value of the survival function) at the
observed time and predictor values for each case.

® Lower bound of confidence interval for survival function. Saves the lower bound of the
confidence interval for the survival function at the observed time and predictor values for
each case.
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Upper bound of confidence interval for survival function. Saves the upper bound of the confidence
interval for the survival function at the observed time and predictor values for each case.

Cumulative hazard function. Saves the cumulative hazard, or —In(survival), at the observed time
and predictor values for each case.

Lower bound of confidence interval for cumulative hazard function. Saves the lower bound of
the confidence interval for the cumulative hazard function at the observed time and predictor
values for each case.

Upper bound of confidence interval for cumulative hazard function. Saves the upper bound of
the confidence interval for the cumulative hazard function at the observed time and predictor
values for each case.

Predicted value of linear predictor. Saves the linear combination of reference value corrected
predictors times regression coefficients. The linear predictor is the ratio of the hazard function
to the baseline hazard. Under the proportional hazards model, this value is constant across
time.

Schoenfeld residual. For each uncensored case and each nonredundant parameter in the
model, the Schoenfeld residual is the difference between the observed value of the predictor
associated with the model parameter and the expected value of the predictor for cases in
the risk set at the observed event time. Schoenfeld residuals can be used to help assess the
proportional hazards assumption; for example, for a predictor x, plots of the Schoenfeld
residuals for the time-dependent predictor x*In(7" ) versus time should show a horizontal
line at 0 if proportional hazards holds. A separate variable is saved for each nonredundant
parameter in the model. Schoenfeld residuals are only computed for uncensored cases.

Martingale residual. For each case, the martingale residual is the difference between the
observed censoring (0 if censored, 1 if not) and the expectation of an event during the
observation time.

Deviance residual. Deviance residuals are martingale residuals “adjusted” to appear more
symmetrical about 0. Plots of deviance residuals against predictors should reveal no patterns.

Cox-Snell residual. For each case, the Cox-Snell residual is the expectation of an event during
the observation time, or the observed censoring minus the martingale residual.

Score residual. For each case and each nonredundant parameter in the model, the score
residual is the contribution of the case to the first derivative of the pseudo-likelihood. A
separate variable is saved for each nonredundant parameter in the model.

DFBeta residual. For each case and each nonredundant parameter in the model, the DFBeta
residual approximates the change in the value of the parameter estimate when the case is
removed from the model. Cases with relatively large DFBeta residuals may be exerting undue
influence on the analysis. A separate variable is saved for each nonredundant parameter in
the model.

Aggregated residuals. When multiple cases represent a single subject, the aggregated residual
for a subject is simply the sum of the corresponding case residuals over all cases belonging
to the same subject. For Schoenfeld’s residual, the aggregated version is the same as that of
the non-aggregated version because Schoenfeld’s residual is only defined for uncensored
cases. These residuals are only available when a subject identifier is specified on the Time
and Event tab.
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Names of Saved Variables. Automatic name generation ensures that you keep all your work.

Custom names allow you to discard/replace results from previous runs without first deleting the
saved variables in the Data Editor.

Export

Figure 12-11
Cox Regression dialog box, Export tab

H Complex Samples Cox Regression

D Export model az SPSS Statistics data |:| Export survival function &z SPSS Statistics data

rDestination

rDestination

rContents

@

[T] Export model a= XML

5

[ Pazte ”Reset ”Cancel” Help ]

Export model as SPSS Statistics data. Writes a dataset in IBM® SPSS® Statistics format containing
the parameter correlation or covariance matrix with parameter estimates, standard errors,
significance values, and degrees of freedom. The order of variables in the matrix file is as follows.

m rowtype_. Takes values (and value labels), COV (Covariances), CORR (Correlations), EST
(Parameter estimates), SE (Standard errors), SIG (Significance levels), and DF (Sampling
design degrees of freedom). There is a separate case with row type COV (or CORR) for each
model parameter, plus a separate case for each of the other row types.
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varname_. Takes values P1, P2, ..., corresponding to an ordered list of all model parameters,
for row types COV or CORR, with value labels corresponding to the parameter strings shown
in the parameter estimates table. The cells are blank for other row types.

P1, P2, ... These variables correspond to an ordered list of all model parameters, with variable
labels corresponding to the parameter strings shown in the parameter estimates table, and
take values according to the row type. For redundant parameters, all covariances are set

to zero; correlations are set to the system-missing value; all parameter estimates are set at
zero; and all standard errors, significance levels, and residual degrees of freedom are set to
the system-missing value.

Note: This file is not immediately usable for further analyses in other procedures that read a matrix
file unless those procedures accept all the row types exported here.

Export survival function as SPSS Statistics data. Writes a dataset in SPSS Statistics format
containing the survival function; standard error of the survival function; upper and lower bounds
of the confidence interval of the survival function; and the cumulative hazards function for each
failure or event time, evaluated at the baseline and at the predictor patterns specified on the Plot
tab. The order of variables in the matrix file is as follows.

Baseline strata variable. Separate survival tables are produced for each value of the strata
variable.

Survival time variable. The event time; a separate case is created for each unique event time.

Sur_0, LCL_Sur_0, UCL_Sur_0. Baseline survival function and the upper and lower bounds
of its confidence interval.

Sur_R, LCL_Sur_R, UCL_Sur_R. Survival function evaluated at the “reference” pattern (see the
pattern values table in the output) and the upper and lower bounds of its confidence interval.

Sur_#4, LCL_Sur_#.#, UCL_Sur_#4#, ... Survival function evaluated at each of the predictor
patterns specified on the Plots tab and the upper and lower bounds of their confidence
intervals. See the pattern values table in the output to match patterns with the number #.#.

Haz_0, LCL_Haz_0, UCL_Haz_0. Baseline cumulative hazard function and the upper and lower
bounds of its confidence interval.

Haz_R, LCL_Haz_R, UCL_Haz_R. Cumulative hazard function evaluated at the “reference”
pattern (see the pattern values table in the output) and the upper and lower bounds of its
confidence interval.

Haz_#.#, LCL_Haz_##, UCL _Haz_#4#, ... Cumulative hazard function evaluated at each of the
predictor patterns specified on the Plots tab and the upper and lower bounds of their confidence
intervals. See the pattern values table in the output to match patterns with the number #.#.

Export model as XML. Saves all information needed to predict the survival function, including
parameter estimates and the baseline survival function, in XML (PMML) format. You can use this
model file to apply the model information to other data files for scoring purposes.
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Options

Figure 12-12
Cox Regression dialog box, Options tab

& Complex Samples Cox Regression

Time and Evert  Predictors  Subgroups  Model  Statistice  Plats Hypathesiz Tests Save  Export Options

Confidence intervall %)

Estimation Survival Functions

Meimum Rerations: 100 Method for estimating baseline survival functions:

@ Efron method

Maimum Step-Halving: © Breslow method

© Product-limit method
7] Limit terstions based on change in parameter estimates Confidence intervals of survival functions:

@ Compute based on transformed survival

hdinimum Change: |0.000001 Type: function, then back transform to original units

..... Tranzformation: || ag -

()] Compute based on origingl units
of survival function

|| Dizplary iteration history
Uzer-mMissing Values

@ Trest as inealicd

Tie-hreaking method for parameter estimation: © Treat == valid
@ Efron This setting applies to all categorical model and
© Eresiow sample design variables.

(easte) (goset.) (cance) (o)

Estimation. These controls specify criteria for estimation of regression coefficients.

Maximum Iterations. The maximum number of iterations the algorithm will execute. Specify a
non-negative integer.

Maximum Step-Halving. At each iteration, the step size is reduced by a factor of 0.5 until the
log-likelihood increases or maximum step-halving is reached. Specify a positive integer.

Limit iterations based on change in parameter estimates. When selected, the algorithm stops
after an iteration in which the absolute or relative change in the parameter estimates is less
than the value specified, which must be positive.

Limit iterations based on change in log-likelihood. When selected, the algorithm stops after an
iteration in which the absolute or relative change in the log-likelihood function is less than
the value specified, which must be positive.

Display iteration history. Displays the iteration history for the parameter estimates and pseudo
log-likelihood and prints the last evaluation of the change in parameter estimates and pseudo
log-likelihood. The iteration history table prints every n iterations beginning with the Oth
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iteration (the initial estimates), where 7 is the value of the increment. If the iteration history is
requested, then the last iteration is always displayed regardless of n.

Tie breaking method for parameter estimation. When there are tied observed failure times, one of
these methods is used to break the ties. The Efron method is more computationally expensive.

Survival Functions. These controls specify criteria for computations involving the survival function.

Method for estimating baseline survival functions. The Breslow (or Nelson-Aalan or empirical)
method estimates the baseline cumulative hazard by a nondecreasing step function with
steps at the observed failure times, then computes the baseline survival by the relation
survival=exp(—cumulative hazard). The Efron method is more computationally expensive
and reduces to the Breslow method when there are no ties. The product limit method
estimates the baseline survival by a non-increasing right continuous function; when there are
no predictors in the model, this method reduces to Kaplan-Meier estimation.

Confidence intervals of survival functions. The confidence interval can be calculated in three
ways: in original units, via a log transformation, or a log-minus-log transformation. Only the
log-minus-log transformation guarantees that the bounds of the confidence interval will lie
between 0 and 1, but the log transformation generally seems to perform “best.”

User Missing Values. All variables must have valid values for a case to be included in the analysis.
These controls allow you to decide whether user-missing values are treated as valid among
categorical models (including factors, event, strata, and subpopulation variables) and sampling
design variables.

Confidence interval(%). This is the confidence interval level used for coefficient estimates,
exponentiated coefficient estimates, survival function estimates, and cumulative hazard function
estimates. Specify a value greater than or equal to 0, and less than 100.

CSCOXREG Command Additional Features

The command language also allows you to:

Perform custom hypothesis tests (using the CUSTOM subcommand and /PRINT LMATRIX).
Tolerance specification (using /CRITERIA SINGULAR).

General estimable function table (using /PRINT GEF).

Multiple predictor patterns (using multiple PATTERN subcommands).

Maximum number of saved variables when a rootname is specified (using the SAVE
subcommand). The dialog honors the CSCOXREG default of 25 variables.

See the Command Syntax Reference for complete syntax information.
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Complex Samples Sampling Wizard

The Sampling Wizard guides you through the steps for creating, modifying, or executing a
sampling plan file. Before using the wizard, you should have a well-defined target population, a
list of sampling units, and an appropriate sample design in mind.

Obtaining a Sample from a Full Sampling Frame

A state agency is charged with ensuring fair property taxes from county to county. Taxes are based
on the appraised value of the property, so the agency wants to survey a sample of properties
by county to be sure that each county’s records are equally up to date. However, resources for
obtaining current appraisals are limited, so it’s important that what is available is used wisely. The
agency decides to employ complex sampling methodology to select a sample of properties.

A listing of properties is collected in property_assess_cs.sav. For more information, see the
topic Sample Files in Appendix A in IBM SPSS Complex Samples 19. Use the Complex Samples
Sampling Wizard to select a sample.

Using the Wizard

» To run the Complex Samples Sampling Wizard, from the menus choose:
Analyze > Complex Samples > Select a Sample...

© Copyright SPSS Inc. 1989, 2010 93
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Figure 13-1
Sampling Wizard, Welcome step

ampling Wizar

Welcome to the Sampling vizard

The Sampling Wizard helps you design and select a complex sample. Your selections will be saved to a plan file that vou can use at analysis

timme to indicate howe the data were sampled.
“ou can also use the wizard to modify a sampling plan or dravy a sample according to an existing plan.

What weould you like to do?

@ Design a sample

Choose thiz option if you have not created a plan Fie: [jroperty_sssess .ol E i

file. ou wvill have the option to draw the sample.

()] Edit a sample design

Choose this option if you wart to add, remove,
or modify stages of an existing plan. you will File:

have the option to drave the sample.

©) Draw the sample

Choose this option if you slready have a plan file i

and want to draw a sample.

o (el )

» Select Design a sample, browse to where you want to save the file, and type property_assess.csplan
as the name of the plan file.

» Click Next.
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Figure 13-2
Sampling Wizard, Design Variables step (stage 1)

H Sampling Wizard

Stage 1: Design Wariables
In thiz panel you can stratify your sample or define clusters, You can alzo provide a label for the stage that will be used in the output.

If zampling weights exist from a prior stage of the sample design you can use them as input to the current stage.

; Wiglcome Wariables: Stratity By
= ® Stage 1 _ _ & Property D [propic] & County [county]
Design *ariahles &b Neighhorhood [nbrhaad)]
Method ) &’ Years since |last appraisal [time]
Sample Size & ‘alue ot last appraisal [lastval]
Clusters:
= & Township [town]

Input Zample Weight.
|

Stage Label: |

@ = incomplete section

» Select County as a stratification variable.
» Select Township as a cluster variable.

» Click Next, and then click Next in the Sampling Method step.

This design structure means that independent samples are drawn for each county. In this stage,
townships are drawn as the primary sampling unit using the default method, simple random
sampling.
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Figure 13-3
Sampling Wizard, Sample Size step (stage 1)

H Sampling Wizard

Stage 1: Sample Size

In thiz panel you can specify the number or proportion of units to be sampled inthe current stage. The sample size can be fixed across strata
at it can vary for different strata.

If you specify sample sizes as proportions you can alzo set the minimum or maximum numker of units to draw.

Wielcome
i Design Yariahles ‘3
Hethod f @ ‘alus:

b Sample Size f The siTe value applies
Cutput arishles I:I to each stratum.
SUmihaEry

Add Stage 2 Unequal values for strata;
=3 Draae Sample
; Selection Options
Ot Files Read values from variable:
Completion - |

[< Back] : Finish ”Cancel ” Help ]

» Select Counts from the Units drop-down list.
» Type 4 as the value for the number of units to select in this stage.

» Click Next, and then click Next in the Output Variables step.
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Figure 13-4
Sampling Wizard, Plan Summary step (stage 1)

Complex Samples Sampling Wizard

H Sampling Wizard

:

Stacge 1: Plan Summaty

Welcome

Thiz panel summarizes the sampling plan so far. You can add another stage to the desion.

If you choose not to add a next stage the next step is to set options for drawing your sample.

Choose thiz option if the warking data
file containz data for stage 2.

SUmmary:
B Staged Stage | Label | strata Clusters | Size [ Methao
: Design Variables 1 (Mane) county town 4 per stratum  Simple Random Sampling
Methon NOR)
Sample Size
Output Yarishles
P Summary
A Stage 2
B Draw Sample File: Crtempiproperty_sssess.csplan
Selection Options
Output Files Do you weant to add stage 27
Completion @ Yes, add stage 2 now Mo, do not add another stage now

Choose thiz aption if stage 2 data are not
available yet or your design has only one stage.

» Select Yes, add stage 2 now.

» Click Next.
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Figure 13-5
Sampling Wizard, Design Variables step (stage 2)

H Sampling Wizard

Stage 20 Design Wariables
In thiz panel you can stratify your sample or define clusters, You can alzo provide a label for the stage that will be used in the output.

If zampling weights exist from a prior stage of the sample design you can use them as input to the current stage.

: Wiglcome
B Stage 1
Design Yariables

“ariahles: Stratify By
&3 Praperty 1D [propic] &) Meighbarhood [Rkrhoocd]
f Years since last appraisal [time]

Methond g@ Walue at last appraisal [lastval] -
Sample Size

Cutput Varisbles
SUmihaEry

=3 @ Stage 2

- Design Variables Clusters:

Method

Sample Size

Stage Label: |

@ = incomplete section

» Select Neighborhood as a stratification variable.

» Click Next, and then click Next in the Sampling Method step.

This design structure means that independent samples are drawn for each neighborhood of the
townships drawn in stage 1. In this stage, properties are drawn as the primary sampling unit using
simple random sampling.
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Figure 13-6
Sampling Wizard, Sample Size step (stage 2)

Complex Samples Sampling Wizard

H Sampling Wizard

:

Stage 2 Satmple Size

can vary for different strata.

Welcome

In this panel you can specify the number or proportion of units to be sampled in the current stage. The sample size can be fized across strata or it

If you specify sample sizes as proporions you can also set the minimum or maximum number of units to draw.

EI Stage 1

Design Yariahles

Method

Sample Size

Output Yarishles

SUmmary

=3 Stage 2
Design Yariahles
Method

- b Sample Size
output Yarisbles
Summary

A Stage 3
B Draw Sample
Selection Options
Outpt Files
Cotmpletion

AR

@ “alue:
The size value applies
to each stratum.

Unequal values for strata:

Read values from variahle:

| |
Minimum Ilazimum
Count: |:| Count: |:|

[« Back | [

Finish ”Cancel ” Helfa ]

» Select Proportions from the Units drop-down list.

» Type 0.2 as the value of the proportion of units to sample from each stratum.

» Click Next, and then click Next in the Output Variables step.
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Figure 13-7
Sampling Wizard, Plan Summary step (stage 2)

H Sampling Wizard

Stage 2 Plan Summaty

Welcome Summary:

Thiz panel summarizes the sampling plan so far. You can add another stage to the desion.

If you choose not to add a next stage the next step is to set options for drawing your sample.

B Stage 1 Sese

[Lakel | Strats

Clusters Size

Methodd

Design Yariahles 4
Method
Sample Size 2
Output Yarishles
SUmmary

=3 Stage 2

(Mone) cournty bowen

(Mane) nbrhood

4 per stratum Simple Random Sampling

WOR

0.2 per stratum Simple Random Sampling

WOR

Design Yariahles
Methion
Sample Size
output Yarisbles
- P Summary
A Stage 3
B Draw Sample
Selection Options
Outpt Files
Cotmpletion

File: C:tempiproperty_assess csplan

Do you weant to add stage 37
Yes, add stage 3 now

Choose thiz option if the warking data
file containz data for stage 3.

® Mo, do not add another stage now

Choose thiz option if stage 3 data are not
available yet or your design has only two
stages.

[: Elack]

” Finish ” Cancel ” Helfa ]

» Look over the sampling design, and then click Next.
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Figure 13-8
Sampling Wizard, Draw Sample, Selection Options step

H Sampling Wizard

Draw Sample: Selection Options

In thiz panel you can choose whether to draw & sample. You can pick which stages to extract and zet other sampling options such as the seed
uzed far random number generation.

: Wiglcome
B Stage 1 Do you ywant to draw: a sample’?
Design Yariahles

Methion ® ves Stages: |4y (1,2) =

Sample Size Mo
Cutput Warishles
Summaty What type of seed value do yvou want to use?
B Stage 2
Design Varisbles A randomly-chosen number
Method . @ Custom vale: E:::]E ;;L;z’:.om zeed value if you wart to reproduce the
Sample Size
output Yarisbles
SUmITEEY [T] Inciude in the sample frame cases with user-missing values of stratification or

Ei Wiorking data are sorted by stratification variables (presorted data may speed
=8 ~ Draw Sample

i~ B Selection Optionz
Outpt Files

(< Back |[iu

Finish ”Cancel ” Helgp ]

» Select Custom value for the type of random seed to use, and type 241972 as the value.

Using a custom value allows you to replicate the results of this example exactly.

» Click Next, and then click Next in the Draw Sample Output Files step.
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Figure 13-9
Sampling Wizard, Finish step

H Sampling Wizard

Completing the Sampling Wizard

You have provided all of the information needed to creste a sample design and draw a sample.
You can return to the Sampling wizard later it you need to add or modify stages. After all the stages have been sampled you can use the
plan file in any Complex Samples analysis procedure to indicate how the sample was drawn.

: Wiglcome
EI Stage 1
Design Yariables
= (gtale]
Sample Size
Cutput Varisbles
SUmihaEry
=3 Stage 2
Design Yariables
Method
Sample Size
Outpt Variables
Summary
Add Stage 3
B Draw Satmple
Selection Cptions
Cutput Files
e Caompletion

What do you want to da?

@ Save the design ta a plan file and draw the sample

Paste the syrtax genersted by the Wizard into & eyntsx window

To claze this wizard, click Finizh.

= Back

[Cancel ” Helgp ]

» Click Finish.

These selections produce the sampling plan file property assess.csplan and draw a sample
according to that plan.
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Figure 13-10
Plan summary
Stage 1 Stage 2
Design Stratification 1 Meighborhio
“ariahles County ad
Cluster 1 Towenizhip
Sample . Selection Method Simple Simple
Infarmation
rancatn randam
sampling sampling
without without
replacement replacement
Mumber of Units Sampled 4
“ariahles Stagewise Inclusion Inclusion Incluzion
Created or [Selection) Probability Frobabiity 1 Probakility _
Mocified e
Stagewize Cumulative Sample Sample
Sample Wisight Weight Wyieight
Cumulstive_ Cumulative_
1_ 2_
Proportion of Units Sampled 4
ii?:rl;;sion Estimatar Assumption Equal Equsal
probability probability
sampling sampling
withot weithout
replacement replacement
Inclusion Prokakility Chtained
Ohtained fram
from varisble variahle
Incluzion Incluszion
Probability_1_ | Probability_
2

Plan File: cpropetty_assess csplan
Weight “Variable: Sampleieight_Final_

Complex Samples Sampling Wizard

The summary table reviews your sampling plan and is useful for making sure that the plan
represents your intentions.

Sampling Summary

Figure 13-11
Stage summary
Propartion of Units
Mumber of Units Sampled Sampled

Courty Reguested Actual Requested Actual
Eastern 4 4 44 4% 44 4%
Central 4 4 57 1% s71%
Western 4 4 25.0% 25.0%
Marthern 4 4 44 4% 44 49
Southern 4 4 50.0% 50.0%

Flan File: cproperty_assess.csplan

This summary table reviews the first stage of sampling and is useful for checking that the sampling
went according to plan. Four townships were sampled from each county, as requested.
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Figure 13-12
Stage summary

Prapartion of Units
Mumber of Units Sampled Sampled

Courty Towvnship Meighbarhood | Reguested Actusl Reguested Actual
Eastern 2 a 4 4 20.0% 19.0%
9 14 14 200% 20.6%
10 7 7 20.0% 18.9%
11 14 14 20.0% 20.0%
B 36 13 13 20.0% 20.3%
37 14 14 20.0% 20.6%
35 13 13 200% 206%
7 43 12 12 20.0% 20.7%
44 11 11 20.0% 19.6%
45 11 11 20.0% 20.8%
46 13 13 200% 20.0%
9 a7 13 13 20.0% 20.6%
58 5 5 200% 18.5%
59 11 11 20.0% 19.3%
g0 13 13 20.0% 19.4%
Central 22 148 ] 9 20.0% 19.6%
149 g g 20.0% 20.0%

This summary table (the top part of which is shown here) reviews the second stage of sampling.
It is also useful for checking that the sampling went according to plan. Approximately 20% of
the properties were sampled from each neighborhood from each township sampled in the first
stage, as requested.

Sample Results
Figure 13-13
Data Editor with sample results
propid | nbrhoad| town | county time‘ lastval IncIusiUnF’i‘SampleWei InclusinnF’i‘SampleWei SampleWyell
obability_1_| ghtCumulat{ abability_2_| ghtCumulat]{ ght_Final_
ve_1 ve_2
273| 577.0 g 2 1 41 181.70
274| 578.0 3 2 1 5| 189.60
275| 579.0 3 2 1 4| 20010
276| 580.0 g 2 1 50 211.50
277| 581.0 g 2 1 4| 181.50
278| B641.0 9 2 1 7 192,40 . . . . .
279| B42.0 9 2 1 6| 236.70 A4 225 21 10.93 10.93
280| B43.0 9 2 1 6| 150.40 A4 225 21 10.93 10.93
281| 644.0 9 2 1 8| 204.80
282| 6450 9 2 1 6| 22540 . . . . .
283| B46.0 9 2 1 7| 180.80 44 225 21 10.93 10.93
284| B47.0 9 2 1 5] 176.90 . . . . o
1 v |\Data View £ Variahle View f |« Sl

You can see the sampling results in the Data Editor. Five new variables were saved to the working
file, representing the inclusion probabilities and cumulative sampling weights for each stage, plus
the final sampling weights.

m  Cases with values for these variables were selected to the sample.

m  Cases with system-missing values for the variables were not selected.
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The agency will now use its resources to collect current valuations for the properties selected in
the sample. Once those valuations are available, you can process the sample with Complex
Samples analysis procedures, using the sampling plan property assess.csplan to provide the
sampling specifications.

Obtaining a Sample from a Partial Sampling Frame

A company is interested in compiling and selling a database of high-quality survey information.
The survey sample should be representative but efficiently carried out, so complex sampling
methods are used. The full sampling design calls for the following structure:

Stage  Strata Clusters
1 Region Province
2 District City

3 Subdivision

In the third stage, households are the primary sampling unit, and selected households will be
surveyed. However, since information is easily available only to the city level, the company plans
to execute the first two stages of the design now and then collect information on the numbers of
subdivisions and households from the sampled cities. The available information to the city level is
collected in demo_cs_1.sav. For more information, see the topic Sample Files in Appendix A in
IBM SPSS Complex Samples 19. Note that this file contains a variable Subdivision that contains
all 1’s. This is a placeholder for the “true” variable, whose values will be collected after the first
two stages of the design are executed, that allows you to specify the full three-stage sampling
design now. Use the Complex Samples Sampling Wizard to specify the full complex sampling
design, and then draw the first two stages.

Using the Wizard to Sample from the First Partial Frame

» To run the Complex Samples Sampling Wizard, from the menus choose:
Analyze > Complex Samples > Select a Sample...
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Figure 13-14
Sampling Wizard, Welcome step

ampling Wizar

Welcome ta the Sampling Wizard

The Sampling Wizard helps you design and select a complex sample. Your selections will be saved to a plan file that you can use st analysis time

o indicate how the data were sampled.
You can also use the wizard to modify a sampling plan or draw & sample according to an existing plan.

Wyhat weould vou like to do?

@ Design & sample

Choose this option it you have not crested a plan file. File:  [raema.cspian M

“ou will have the option to drawy the sample,

@ Ediit a sample desion
Choose thiz option if you wwant to add, remove, or
modify stages of an existing plan. You will have the File:
option to draw the sample.

©) Draw the sample

Choosze thiz option if you already have a plan file and e

weant to drawe a sample.

= Back

» Select Design a sample, browse to where you want to save the file, and type demo.csplan as
the name of the plan file.

» Click Next.
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Figure 13-15
Sampling Wizard, Design Variables step (stage 1)

H Sampling Wizard

Stage 1: Design Wariables
In thiz panel you can stratify your sample or define clusters, You can alzo provide a label for the stage that will be used in the output.

If zampling weights exist from a prior stage of the sample design you can use them as input to the current stage.

; Wiglcome Wariables: Stratity By
= @ Stage 1 & District [district] & Region [region]
Design Yariables &) City [city]
Methad &b Subdivision [subdivision]
Sample Size
Clusters:
8 &5 Province [provinee]

Input Zample Weight.

Stage Label: ||

@ = incomplete section

» Select Region as a stratification variable.
» Select Province as a cluster variable.

» Click Next, and then click Next in the Sampling Method step.

This design structure means that independent samples are drawn for each region. In this stage,
provinces are drawn as the primary sampling unit using the default method, simple random
sampling.
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» Select Counts from the Units drop-down list.

Figure 13-16
Sampling Wizard, Sample Size step (stage 1)

H Sampling Wizard

Stage 1: Sathple Size

In this panel you can specify the number or proportion of units to be sampled in the current stage. The sample size can be fized across strata or it

can vary for different strata.

If you specify sample sizes as proporions you can also set the minimum or maximum number of units to draw.

: Wiglcome

EI . Stage 1

i Design Yariahles
Method

» Sample Size
Output Yarishles

SUmmary
A Stage 2

= Dranne Sample

Selection Options

e Output Files
Cotmpletion

@ *alue:

The size value applies

Unequal values for strata:

Read values from variable:

&
&
&
> |
[: Elack“é.r.\l Finish ” Cancel ” Help ]

» Type 3 as the value for the number of units to select in this stage.

» Click Next, and then click Next in the Output Variables step.
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Figure 13-17
Sampling Wizard, Plan Summary step (stage 1)

H Sampling Wizard

Stacge 1: Plan Summaty
Thiz panel summarizes the sampling plan so far. You can add another stage to the desion.

If you choose not to add a next stage the next step is to set options for drawing your sample.

Wielcome Summary;
B Staged Stage | Label | strata Clusters | Size | Methos
= 1 Design Variables 1 (Mone) region province 3 per stratum Simple Random Sampling
Methaed [WOR]
Sample Size
Output Yarishles
P Summary
A Stage 2
Bl Draw Sample File: ctempidemo csplan
i Selection Cptions
Output Files Do you weant to add stage 27
Cotnpletion @ ves, add stage 2 now Mo, do not add another stage now
Choose thiz option if the warking data Choose thiz aption if stage 2 data are not
file contains data for stage 2. available yet or your desian has only one stage.

» Select Yes, add stage 2 now.

» Click Next.
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Figure 13-18
Sampling Wizard, Design Variables step (stage 2)

H Sampling Wizard

Stage 20 Design Wariables
In thiz panel you can stratify your sample or define clusters, You can alzo provide a label for the stage that will be used in the output.

If zampling weights exist from a prior stage of the sample design you can use them as input to the current stage.

: Wiglcome

EI Stage 1

Design Yariables
= (gtale]

Sample Size

Cutput Varisbles

“ariahles: Stratify By
& Subdivision [subdivision] & District [district]

SUmihaEry
=3 @ Stage 2
- P Design Variables Clusters:
Wethod & City [oity)
Sample Size

Stage Label: |

@ = incomplete section

Select District as a stratification variable.
Select City as a cluster variable.

Click Next, and then click Next in the Sampling Method step.

This design structure means that independent samples are drawn for each district. In this stage,
cities are drawn as the primary sampling unit using the default method, simple random sampling.
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Figure 13-19

Complex Samples Sampling Wizard

Sampling Wizard, Sample Size step (stage 2)

H Sampling Wizard

Stage 20 Sample Size

at it can vary for different strata.

: Wiglcome
EI Stage 1
Design Yariables
= (gtale]
Sample Size
Cutput Varisbles
SUmihaEry
=3 Stage 2
Design Yariables
Method
o Sample Size
Outpt Variables
Summary
Add Stage 3
Bl Draw Satmple
Selection Cptions
Cutput Files
Completion

In thiz panel you can specify the number or proportion of units to be sampled inthe current stage. The sample size can be fixed across strata

If you specify sample sizes as proportions you can alzo set the minimum or maximum numker of units to draw.

3
@ Walle:
The size value applies
Lo each stratum.

© Unequal values for strata:

Read values from variable:

Iinimum Maimum
ot ] o [

[< Back] i

Finish ”Cancel ” Helg ]

hnd | |

» Select Proportions from the Units drop-down list.

» Type 0.1 as the value of the proportion of units to sample from each strata.

» Click Next, and then click Next in the Output Variables step.
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» Select Yes, add stage 3 now.

Figure 13-20

Sampling Wizard, Plan Summary step (stage 2)

H Sampling Wizard

Stage 20 Plan Summary

: Wiglcome
B Stage 1

Methiod

Sample Size
Cutput Varisbles
SUmihaEry

=3 Stage 2

Method
Sample Size
Outpt Variables
- Summary
Add Stage 3
Bl Draw Satple

Cutput Files
Completion

Design Yariables

Design Yariables

Selection Cptions

Thiz panel summarizes the sampling plan so far. You can add another stage to the design.

If you chooze not to add & next stage the next step is to =et options for drawing your sample.

SUmmary:

Stage  |Lakel  |Strata Clusters | Size Methad

1 (Mone) region province 3 per stratum Simple Random Sampling
VDR

2 (Maone) district city 0.1 per stratum Simple Random Sampling

VWOR

File: ctempidemo.csplan

Do you want to add stage 37

@ Yes, add stage 3 now

Chioose this option if the waorking
data file contains data for stage 3.

Mo, do not add another stage novw

Choose this option if stage 3 data are not
available yet or your design has only two
stages.

» Click Next.
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Figure 13-21
Sampling Wizard, Design Variables step (stage 3)

H Sampling Wizard

Stage 3: Design Variables
In thiz panel you can stratify your sample or define clusters, You can alzo provide a label for the stage that will be used in the output.

If zampling weights exist from a prior stage of the sample design you can use them as input to the current stage.

: Wiglcome
EI Stage 1
Design Yariables
Methoc
Sample Size
Cutput Varisbles
SUmihaEry
B Stage 2
Design Y ariables Clusters:
Method
Sample Size
Outpt Variables
Summary
=3 @ Stage 3
- P Design Variables
Methiod
Sample Size

“ariahles: Stratify By
& Subdivision [subdivision]

Stage Label: |

@ = incomplete section

» Select Subdivision as a stratification variable.

» Click Next, and then click Next in the Sampling Method step.

This design structure means that independent samples are drawn for each subdivision. In this
stage, household units are drawn as the primary sampling unit using the default method, simple
random sampling.



114

Chapter 13

Figure 13-22
Sampling Wizard, Sample Size step (stage 3)

H Sampling Wizard

Stage 3 Sample Size

In thiz panel you can specify the number or proportion of units to be sampled inthe current stage. The sample size can be fixed across strata
at it can vary for different strata.
If you specify sample sizes as proportions you can alzo set the minimum or maximum numker of units to draw.

Wyelcome -

Design Yariables
Mhethio @ alle:
Sample Size The size value spplies
Cutput ariables Lo each stratum.

SUmihaEry
B Stage? Unegual values for strata:

Design Yariables
Method
Sample Size
Outpt Variables - | |
Summary
B Stage3 Wi l:l Mamum l:l
Design Variables Court: Count:
Methiod
= 3 Sample Size
Outpt Variables
Summary

Read values from variable:

=3 Draae Sample
; Selection Options
Cutout Files s

[< Back] : Finish ”Cancel ” Help ]

» Select Proportions from the Units drop-down list.
» Type 0.2 as the value for the proportion of units to select in this stage.

» Click Next, and then click Next in the Output Variables step.
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Figure 13-23

Complex Samples Sampling Wizard

Sampling Wizard, Plan Summary step (stage 3)

H Sampling Wizard

Stage 3: Plan Summary

: Viiglcome
EI Stage 1
Design Yariables
Mhethio
Sample Size
Cutput Variables
Summary
B Stage 2
Design Variables
Mhethiod
Sample Size
Cutput Varisbles
Surmimary
B Stage 3
Design Yariables
Methiod
Sample Size
Cutput Varisbles
= B Summary

Bl Draw Sample

; Selection Options
Output Files

Completion

Thiz panel summarizes the sampling plan so far. The next step is to set options for drasing your sample.

SLmmary:

Stage |Lahel |Stra1a Clusters | Size
1

hdethod

[FGne]  region Brovince 3 per stratum

2 [Mone)  district city 0.1 per stratum

] [(Mone)  subdivision 0.2 per stratum

IMplE Random sampling
WOR

Simple Random Sampling
WIOR:

Simple Random Sampling
WIOR:

File; ctempidema.csplan

[< Back [ Finish ”Cancel ” Help ]

» Look over the sampling design, and then click Next.
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Figure 13-24
Sampling Wizard, Draw Sample Selection Options step

H Sampling Wizard

Drarwy Sample: Selection Options

\Wiglcome

Stage 1
Design “ariables
Method
Sample Size
Cutput Varisbles
SUmihaEry

Stage 2
Design Yariables
= (gtale]
Sample Size
Cutput Varisbles
SUmihaEry

Stage 3
Design Yariables
Method
Sample Size
Outpt Variables
Summary

o Dirawy Sample

P Selection Options
Output Files

In thiz panel you can choose whether to drave a sample. You can pick which stages to extract and set other sampling options such as the
seed used for random number generation.

Do you swant to draw @ sample’?

@ ves
Mo

Stages: |12 -

What type of seed value do you want to use?

A randomly-chosen number
@ Custom value: (241972

Erter & custom seed walue if you warnt to reproduce
the sample later.

[i Inchude in the sample frame cases with user-missing values of stratificstion or
clustering variables

Ei Working data are sorted by stratification varisbles (presorted data may speed
processing)

[< Back] : Finish ”Cancel ” Help ]

» Select 1, 2 as the stages to sample now.

» Select Custom value for the type of random seed to use, and type 241972 as the value.

Using a custom value allows you to replicate the results of this example exactly.

» Click Next, and then click Next in the Draw Sample Output Files step.
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Figure 13-25
Sampling Wizard, Finish step

H Sampling Wizard

Completing the Sampling Wizard

You have provided all of the information needed to creste a sample design and draw a sample.
You can return to the Sampling wizard later it you need to add or modify stages. After all the stages have been sampled you can use the
plan file in any Complex Samples analysis procedure to indicate how the sample was dravwn.

B Stage “
Design Yariables
Wethad What do you wwant to do’?
Sample Size
Cutput Variables
Summary

B Stage 2

Design Variables
Mhethiod

Sample Size
Cutput Varisbles
Surmimary

B Stage 3

Design Yariables
Mhethio

Sample Size
Cutput Varisbles
SUmihaEry

@ Save the design ta a plan file and draw the sample

Paste the syrtax genersted by the Wizard into & eyntsx window

Bl Draw Sample

; Selection Options
Output Files

o Completion -

To claze this wizard, click Finizh.

i [Cancel ” Helg ]

» Click Finish.

These selections produce the sampling plan file demo.csplan and draw a sample according to the
first two stages of that plan.
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Sample Results
Figure 13-26
Data Editor with sample results
region | province | district] city Inclusinnpi‘ Sarmplebei IncIusionF‘i‘SampleWei Sampletei] »
obability 1 | ghtCurnulat{ obability 2 |ghtCurnulat] ght_Final_
ve_1 ve 2

205 1 2 10] 295
295 1 2 10] 296
297 1 2 100 297 . . . . .
293 1 2 100 293 20 £.00 0 50.00 50.00
203 1 2 10] 299 . . . . .
300 1 2 101 300 20 £.00 0 50.00 50.00
301 1 2 11 3M
302 1 2 11| 302
303 1 2 11| 303
304 1 2 11 304
305 1 2 11| 305
306 1 2 11| 306 . . . . .
307 1 2 11| 307 20 500 0 50.00 50.00
308 1 2 11| 308
— 4 A PR T w

<+ \Data View £ variable View / < >

You can see the sampling results in the Data Editor. Five new variables were saved to the working
file, representing the inclusion probabilities and cumulative sampling weights for each stage, plus
the “final” sampling weights for the first two stages.

m  Cities with values for these variables were selected to the sample.

m  Cities with system-missing values for the variables were not selected.

For each city selected, the company acquired subdivision and household unit information and
placed it in demo_cs_2.sav. Use this file and the Sampling Wizard to sample the third stage
of this design.

Using the Wizard to Sample from the Second Partial Frame

» To run the Complex Samples Sampling Wizard, from the menus choose:
Analyze > Complex Samples > Select a Sample...
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Figure 13-27

Sampling Wizard, Welcome step

Complex Samples Sampling Wizard

ampling Wizar

Welcome to the Sampling vizard

The Sampling Wizard helps you design and select a complex sample. Your selections will be saved to a plan file that vou can use at analysis

timme to indicate howe the data were sampled.
“ou can also use the wizard to modify a sampling plan or dravy a sample according to an existing plan.

What weould you like to do?

@ Design a sample

Choose thiz option if you have not created a plan
file. ou wvill have the option to draw the sample.

@) Edit a sample design

Choose this option if you wart to add, remove,
o modify stages of an existing plan. “ou wil
have the option to drave the sample.

@) Draw the sample

Choose this option if you already have a plan file
and want to draw a sample.

File:

Broweze..,

File: Brovyse

File:  |fdema. caplan M

o (el )

» Select Draw a sample, browse to where you saved the plan file, and select the demo.csplan plan

>

file that you created.

Click Next.
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Figure 13-28

Sampling Wizard, Plan Summary step (stage 3)

H Sampling Wizard

£

Plan Sumthary

\Wiglcome
P Plan Summary
. Drravy Sample
Selection Options
Output Files
Completion

Thiz panel summarizes the sampling plan. Indicate any stages that have already been draven and should not be resampled.

SLmmary:
Stage |Label  |Strata Clusters |Size | Methad
1 [Mone) region province 3.0 per stratum  Simple Random Sampling
(OR)
2 [Maone) digtrict ity 0.1 per stratum Simple Random Sampling
(WOR)
] [Mone) subdivision 0.2 per stratum Simple Random Sampling

[AOR)

File: demo.csplan

Which stages have already been sampled?

Stages:

[< Back [ Finish ”Cancel ” Help ]

» Select 1, 2 as stages already sampled.

» Click Next.
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Figure 13-29
Sampling Wizard, Draw Sample Selection Options step

= Sampling Wizard

Drawy Sample: Selection Options

In thiz panel you can choose which stages to extract and set other sampling options such as the seed used for random number generation.

Wielcome
Plan Summary Which stages do you wart to sample?
Dirawy Sample
i b Selection Options Stages:
Cutput Files
Cormiletion What type of seed value do you wart to use?

A randomly-chosen number

) Enter & custom zeed walue if you want to reproduce
@ custom value: 4231346 the sampl fater.

[ Include inthe sample frame cases with user-missing values of stratification or
clustering vatiables

Ei ‘Working data are sorted by stratification warishles (presored data may speed
processing)

3‘ Q a @ Micrasaft Outlook We. .. “ @ Tutarial n 23 Ciipocuments and Se. . “ E*Outputl [Dracur

» Select Custom value for the type of random seed to use and type 4231946 as the value.

» Click Next, and then click Next in the Draw Sample Output Files step.
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Figure 13-30
Sampling Wizard, Finish step

H Sampling Wizard

Completing the Sampling Wizard

You have provided all of the information needed to draw 3 sample.
You can return to the Sampling wizard later it you need to add or modify stages. After all the stages have been sampled you can use the
plan file in any Complex Samples analysis procedure to indicate how the sample was drawn.

Wielcome

Plan Summary
What do you want to da?

_ Dirawy Sample
Selection Options Drav the sample
Output Files @ paste the syrtax generated by the Wizard into & syntax window
= ] Completion

To claze this wizard, click Finizh.

= Back

|n|shm§”Canc:eI ” Helgp ]

» Select Paste the syntax generated by the Wizard into a syntax window.

» Click Finish.

The following syntax is generated:

* Sampling Wizard.

CSSELECT

/PLAN FILE='demo.csplan'

/CRITERIA STAGES = 3 SEED = 4231946
/CLASSMISSING EXCLUDE

/DATA RENAMEVARS

/PRINT SELECTION.

Printing the sampling summary in this case produces a cumbersome table that causes problems in
the Output Viewer. To turn off display of the sampling summary, replace SELECTION with CPS in
the PRINT subcommand. Then run the syntax within the syntax window.

These selections draw a sample according to the third stage of the demo.csplan sampling plan.
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Sample Results

Figure 13-31
Data Editor with sample results

city | subdivision| unit IncIusionF’i‘SampleWei IncIusionF’i‘SampleWei IncIusionF’i‘SampleWei SampleyVe ~
obability_1_|ghtCurmulat{ obability_2 | ghtCurmulat{obability_3 | ghtCumulat]{ ght_Final_
ve | ve 2 ve 3
141 190 Q45| S4514 .20 5.00 A0 50.00
15] 190 Q45| 94515 .20 5.00 A0 50.00 . . .
16] 190 45| 54516 20 £.00 A0 50.00 20 244 44 244 44
171 190 45| B4As17 .20 5.00 A0 50.00
18] 190 Q45| 94518 .20 5.00 A0 50.00
191 190 Q45| 54519 20 5.00 A0 50.00
201 190 45| 54520 .20 5.00 A0 50.00
21] 190 Q45| 94521 .20 5.00 A0 50.00
221 190 Q45| 4522 20 5.00 A0 50.00
23] 190 45| 54523 .20 5.00 A0 50.00 . . .
241 190 45| 4524 20 £.00 A0 50.00 20 244 44 244 44
25] 190 Q45| S4525 20 5.00 A0 50.00
26] 190 45| 54526 .20 5.00 A0 50.00
271 190 Q45| 04527 20 £.00 A0 50.00
28] 190 Q45| 54528 20 5.00 A0 50.00 . . .
28] 190 Q45| 54529 .20 5.00 A0 50.00 .20 244 44 244 44
301 190 945 | 594530 20 £.00 A0 50.00 .
<> \Data viow A variabio view [ ol e TS St

You can see the sampling results in the Data Editor. Three new variables were saved to the
working file, representing the inclusion probabilities and cumulative sampling weights for the
third stage, plus the final sampling weights. These new weights take into account the weights
computed during the sampling of the first two stages.

m  Units with values for these variables were selected to the sample.
®  Units with system-missing values for these variables were not selected.
The company will now use its resources to obtain survey information for the housing units selected

in the sample. Once the surveys are collected, you can process the sample with Complex Samples
analysis procedures, using the sampling plan demo.csplan to provide the sampling specifications.

Sampling with Probability Proportional to Size (PPS)

Representatives considering a bill before the legislature are interested in whether there is public
support for the bill and how support for the bill is related to voter demographics. Pollsters design
and conduct interviews according to a complex sampling design.

A list of registered voters is collected in poll_cs.sav. For more information, see the topic
Sample Files in Appendix A in IBM SPSS Complex Samples 19. Use the Complex Samples
Sampling Wizard to select a sample for further analysis.

Using the Wizard

» To run the Complex Samples Sampling Wizard, from the menus choose:
Analyze > Complex Samples > Select a Sample...
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Figure 13-32
Sampling Wizard, Welcome step

ampling Wizar

Welcome to the Sampling vizard

The Sampling Wizard helps you design and select a complex sample. Your selections will be saved to a plan file that vou can use at analysis

timme to indicate howe the data were sampled.
“ou can also use the wizard to modify a sampling plan or dravy a sample according to an existing plan.

What weould you like to do?

@ Design a sample

Choose this aption if you have not created a plan File:  [ipal.cspian M

file. ou wvill have the option to draw the sample.

(@) Edit a sample design

Choose this option if you wart to add, remove,
or modify stages of an existing plan. you will File:
have the option to drave the sample.

©) Draw the sample

Choose this option if you slready have a plan file i

and want to draw a sample.

o (el )

()

» Select Design a sample, browse to where you want to save the file, and type poll.csplan as the
name of the plan file.

» Click Next.
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Figure 13-33
Sampling Wizard, Design Variables step (stage 1)

H Sampling Wizard

Stage 1: Design Wariables
In thiz panel you can stratify your sample or define clusters, You can alzo provide a label for the stage that will be used in the output.

If zampling weights exist from a prior stage of the sample design you can use them as input to the current stage.

; Wiglcome Wariables: Stratity By
= @ Stage 1 _ &b ater ID [voteid] & County [county]
Design *ariahles &b Neighhorhood [nbrhaad)]
Sample Size
Clusters:
8 & Township [town]

Input Zample Weight.
|

Stage Label: |

@ = incomplete section

Select County as a stratification variable.
Select Township as a cluster variable.

Click Next.

This design structure means that independent samples are drawn for each county. In this stage,
townships are drawn as the primary sampling unit.
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Figure 13-34
Sampling Wizard, Sampling Method step (stage 1)

H Sampling Wizard

Stage 1: Sampling Method

In thiz panel you can choose how to select tems from the working data file. If you choose a PPS (probability proportional to size) sampling
method you must also specify a measure of size (MOS).

; Wiglcome tethod
B Stage 1
@ sta - - & Tyee: [pps -
Design Y ariables ‘3 -
b Method 8 Without replacement (WOR)
Sample Size ‘With replacement (WR)

|:| Use Wr estimation for analysis
Measure of Size (MOS)
Read from wariable:

» | |

@ Court data records

dimiirmLr: l:l haxituim: l:l

@ = incomplete section

» Select PPS as the sampling method.
» Select Count data records as the measure of size.

» Click Next.

Within each county, townships are drawn without replacement with probability proportional to the
number of records for each township. Using a PPS method generates joint sampling probabilities
for the townships; you will specify where to save these values in the Output Files step.
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Figure 13-35
Sampling Wizard, Sample Size step (stage 1)

Complex Samples Sampling Wizard

H Sampling Wizard

Stage 1: Sample Size

at it can vary for different strata.

Wielcome

In thiz panel you can specify the number or proportion of units to be sampled inthe current stage. The sample size can be fixed across strata

If you specify sample sizes as proportions you can alzo set the minimum or maximum numker of units to draw.

Bl Stage F

; Design Yariables ﬁ

Methiod

Sample Size

Cutput Varisbles

SUmihaEry

Add Stage 2

=3 Draae Sample

; Selection Options
Cutput Files

Completion

@ Walue:
The size value applies
to each stratum.

Unequal values for strata;

Read values from wvariable:

| |
Minimuim Maximurm
Count: Count:

[< Eack]

[ Finish ”Cancel ” Help ]

Select Proportions from the Units drop-down list.

Type 0.3 as the value for the proportion of townships to select per county in this stage.

Legislators from the Western county point out that there are fewer townships in their county than
in others. In order to ensure adequate representation, they would like to establish a minimum of 3

townships sampled from each county.

Type 3 as the minimum number of townships to select and 5 as the maximum.

Click Next, and then click Next in the Output Variables step.
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Figure 13-36
Sampling Wizard, Plan Summary step (stage 1)

H Sampling Wizard

£

Stage 1: Plan Summary

Thiz panel summarizes the sampling plan so far. You can add another stage to the design.

If you chooze not to add & next stage the next step is to =et options for drawing your sample.

: Velcome: Summary:
B , Stage Stage  |Label | strata Clusters Size [Method
- Design Variables 1 (Mone) county ko 0.3 per stratum  PPSOAICOR)
Methiod
Sample Size
Cutput Varisbles
L b Summary
Add Stage 2 S —— L
Bl Draw Sample File: o:tempyal csplan
i Selection Options
Cutput Files Do you want to add stage 27
Carmpletion @ Yes, add stage 2 now Mo, do not add another stage novw
Chioose this option if the waorking Choose this option if stage 2 data are not
data file contains data for stage 2. available yet or your design has only one
stage.

» Select Yes, add stage 2 now.

» Click Next.
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Figure 13-37
Sampling Wizard, Design Variables step (stage 2)

H Sampling Wizard

Stage 20 Design Wariables
In thiz panel you can stratify your sample or define clusters, You can alzo provide a label for the stage that will be used in the output.

If zampling weights exist from a prior stage of the sample design you can use them as input to the current stage.

: Wiglcome

EI Stage 1

Design Yariables
Methioct

Sample Size
Cutput Varisbles
SUmihaEry

=3 @ Stage 2

- Design Variables Clusters:

Method

“ariahles: Stratify By
&5 Water ID [vateid] & Neighborhoad [nbrhond]

Sample Size

Stage Label: |

@ = incomplete section

» Select Neighborhood as a stratification variable.

» Click Next, and then click Next in the Sampling Method step.

This design structure means that independent samples are drawn for each neighborhood of the
townships drawn in stage 1. In this stage, voters are drawn as the primary sampling unit using
simple random sampling without replacement.
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Figure 13-38

Sampling Wizard, Sample Size step (stage 2)

H Sampling Wizard

Stage 20 Sample Size

at it can vary for different strata.

: Wiglcome
EI Stage 1
Design Yariables
Method
Sample Size
Cutput Varisbles
SUrihaEry
=3 Stage 2
Design Yariables
Method
o Sample Size
Outpt Variables
Summary'
Add Stage 3
Bl Draw Satmple
Selection Cptions
Cutput Files
Completion

In thiz panel you can specify the number or proportion of units to be sampled inthe current stage. The sample size can be fixed across strata

If you specify sample sizes as proportions you can alzo set the minimum or maximum numkber of units to draw.

&
@ Walle:

Unegual values for strata:

The size value applies
Lo each stratum.

Read values from variable:

Iinimum
Cournt:

Maximum
Count:

[T G ]

[< Back] i

Finish ”Cancel ” Helg ]

hnd | |

» Select Proportions from the Units drop-down list.

» Type 0.2 as the value of the proportion of units to sample from each strata.

» Click Next, and then click Next in the Output Variables step.
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Figure 13-39
Sampling Wizard, Plan Summary step (stage 2)
=
H Sampling Wizard
Stage 20 Plan Summary
Thiz panel summarizes the sampling plan so far. You can add another stage to the design.
If you chooze not to add & next stage the next step is to =et options for drawing your sample.
Wiglcome Summary:
B Stage Stage |Label |strata |Clusters  |Size Method
Dezion ariables 1 (Mone) county town 0.3 per stratum  PPSWOR
Methiod 2 [Mone) nbrhood 0.2 per stratum Simple Random Sampling
Sample Size WIOR
Cutput Varisbles
SUmihaEry
B Stage 2
Design *ariables File: o tempynal caplan
Method
Sample Size Do you want to add stage 37
Cutput Variables ez, add stage 3 now @ Mo, do not add another stage novw
* b Summary Chooze this option if the working Chooze this aption if stage 3 data are not
Add Stage 3 data file contains data for stage 3. available yet or your design haz only two
=3 Dirany Sample stages.
Selection Cptions
Cutput Files
Completion
[< Back [ Finish ] [ Cancel ] [ Help ]

» Look over the sampling design, and then click Next.
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» Select Custom value for the type of random seed to use, and type 592004 as the value.

>

Figure 13-40
Sampling Wizard, Draw Sample Selection Options step

H Sampling Wizard

Drarwy Sample: Selection Options

seed used for random number generation.

Wielcome

Stage 1 Do you swant to draw @ sample’?
Design Yariables

Method ® ves Stages: [al(1,2) =

Sample Size ils}

Cutput Varisbles

Summary What type of seed value do you want to use?
B Stage 2

Design Yariables A randomly-chosen number

In thiz panel you can choose whether to drave a sample. You can pick which stages to extract and set other sampling options such as the

Erter & custom seed walue if you want to reprocuce
Metho @ Custom value: |532004 J B

the sample later.

[< Back | |iMext ” Finizh ”Cancel ” Help ]

Sample Size
Outpt Variables
Summary [ Inciude inthe sample frame cases with user-missing values of stratification or
Add Stage 3 clustering variahles
=8 Drawiv Sample [ wiiorking cata are sorted by stratification varisbles (presored data may speed
b Selection Options processing)
Cutput Files
Completion

Using a custom value allows you to replicate the results of this example exactly.

Click Next.
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Figure 13-41
Sampling Wizard, Draw Sample Selection Options step

H Sampling Wizard

Drarwy Sample: Output Files

In thiz panel you can choose where to save sample output deta. You must save sampled cases to an external file if sampling is done with
replacement. The selected cases are saved along with the variables if the destination is a new dataset or file.
Joint probahbilties are saved if you request PPS sampling without replacement. They are needed for WOR estimation of PPS designs.

: Wiglcome

[_j Stage 1 Where do you want to save sample data?
Design Yariables
Method! Active dataset
Sample Size © Mew dataset: [poll_os_sample
Cutput Varisbles
Summary External file:

=3 Stage 2
Design Yariables Where do you want to save joint probabilities?
Method )
Sample Size Fil: *|ipall joirtprob sav | [Brgwse... ] [Qefault.._ ]
Outpt Variables
Summary = Save caze selection rules

Add Stage 3

B Draw Satple

Selection Cptions

- b Output Files
Completion

[< Eack] ; Finizh ”Cancel ” Help ]

Choose to save the sample to a new dataset, and type poll_cs_sample as the name of the dataset.

Browse to where you want to save the joint probabilities and type poll_jointprob.sav as the name
of the joint probabilities file.

Click Next.
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Figure 13-42
Sampling Wizard, Finish step

H Sampling Wizard

Completing the Sampling Wizard

You have provided all of the information needed to creste a sample design and draw a sample.
You can return to the Sampling wizard later it you need to add or modify stages. After all the stages have been sampled you can use the
plan file in any Complex Samples analysis procedure to indicate how the sample was drawn.

Wielcome
B Stage 1
Design Yariables

What do you want to da?

Method @ Save the design ta a plan file and draw the sample

Sample Size Paste the syntax genersted by the Wizard into & syntax window
Cutput Varisbles

SUmihaEry

=3 Stage 2
Design Yariables
Method
Sample Size
Outpt Variables
Summary

Add Stage 3

B Draw Satmple

Selection Cptions

Cutput Files

e Caompletion

To claze this wizard, click Finizh.

H [Cancel ” Helgp ]

» Click Finish.

These selections produce the sampling plan file poll.csplan and draw a sample according to that
plan, save the sample results to the new dataset poll _cs_sample, and save the joint probabilities
file to the external data file poll jointprob.sav.
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Complex Samples Sampling Wizard

Figure 13-43
Plan summary
Stage 1 Stage 2
Design Stratification 1 County Meighborhood
“ariables Cluster 1 Towwnship
Sample Selection Methoo PPS zampling Simple rancom
Information without sampling without
replacement replacement
Meazure of Size Ohtsined from data
Proportion of Units Sampled 3 2
Minimum Mumber of Units Sampled 3
Mazimum Mumber of Units Sampled 5
“ariahles Created or Stagewise Inclusion Inclusion Incluzion
Madified (Selection) Probakbility Probability _1_ Probahility_2_
Stagewize Cumulative Sampleieight Sampleiiight
Sample Weight Cumulative_1_ Cumulative_2_
Analysis Estimator Azsumgtion Unequal prokakility
Information sampling without Equial probability
replacement (using sampling without
joint inclusion replacement
probabilities)
Inclusion Probakility Ohtsined from Chtained from
variable variable
Incluzion Incluzion
Probability_1_ Probability_2_

Plan File: cpoll.ceplan
Wizight Yarishle: SampleWWeight _Final_

The summary table reviews your sampling plan and is useful for making sure that the plan

represents your intentions.

Sampling Summary

Figure 13-44
Stage summary

Proportion of Units
Mumber of Units Sampled Sampled
Courty Requested Actual Requested Actual
Eastern 4 4 30.0% 30.8%
Central 4 4 30.0% 30.8%
Western 3 3 30.0% a0.0%
Marthern S 5 30.0% 3353%
Southern 3 3 30.0% S0.0%

Plan File: c:'poall czplan

This summary table reviews the first stage of sampling and is useful for checking that the sampling
went according to plan. Recall that you requested a 30% sample of townships by county; the
actual proportions sampled are close to 30%, except in the Western and Southern counties. This is
because these counties each have only six townships, and you also specified that a minimum of
three townships should be selected per county.
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Figure 13-45
Stage summary
Proportion of Units
Mumber of Units Sampled Sampled

County Township  Meighborhood | Requested Actual Feguested Actual
Eaztern q 1 49 49 200% 19.9%
2 143 143 20.0% 20.0%
3 113 113 200% 20.0%
4 7 77 20.0% 20.0%
5 139 139 2000% 20.0%
5] 120 120 2000% 20.0%
10 1 149 149 2000% 201%
2 17 M7 2000% 20.0%
3 116 116 200% 20.0%
4 2] B9 2000% 19.9%
1 1 65 ;53 200% 19.9%
2 72 72 20.0% 19.9%
3 109 109 2000% 20.0%
4 140 140 20.0% 20.0%
5 42 42 2000% 19.8%
5] 142 142 2000% 20.0%
12 1 145 145 20.0% 201%
2 2] B9 2000% 201%
3 a5 a5 200% 201%
4 134 134 20.0% 20.0%
E 114 114 200% 20.0%
5 137 137 200% 19.9%
Central 2 1 119 1149 2000% 201%
2 153 153 200% 19.9%
3 101 101 2000% 20.0%
4 52 52 2000% 19.8%
E 144 144 200% 20.0%

Plan File; c;'poll.csplan

This summary table (the top part of which is shown here) reviews the second stage of sampling.
It is also useful for checking that the sampling went according to plan. Approximately 20%

of the voters were sampled from each neighborhood from each township sampled in the first
stage, as requested.
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Sample Results
Figure 13-46
Data Editor with sample results
voteid | nbrhood| towe | county IncIusinnF‘i‘ Sarmpledyei IncIusionF‘i‘SampleWei Sampleye -
obability_1_|ghtCurnulat{ obability_2 | ghtCurmulat] ght_Final_
ve 1 ve 2
76|  3E3 4 ) 1 44 226 20 11.28 11.28
77| 3E9 4 9 1 44 226 20 11.28 11.28
a7e| I74 4 9 1 44 276 20 11.28 11.28
79| 76 4 9 1 44 226 .20 11.28 1128
380 379 4 9 1 44 226 .20 11.28 1128
381 380 4 9 1 44 226 .20 11.28 1128
352|382 4 9 1 44 226 .20 11.28 1128
383 13 5 9 1 44 226 .20 11.26 1126
384 18 5 9 1 44 226 .20 11.26 11.26
385 23 5 9 1 44 226 .20 11.26 11.26
386 38 5 9 1 44 226 .20 11.26 11.26
387 349 5 9 1 44 228 .20 11.26 11.26
388 40 5 9 1 44 226 20 11.26 11.26
389 41 5 9 1 44 226 20 11.26 11.26
=) 43 5 9 1 44 2R N 11 7R 11 7R v
1 >Q\Data\ﬂew,{\‘fariable\fiew/ [« ¥

You can see the sampling results in the newly created dataset. Five new variables were saved to
the working file, representing the inclusion probabilities and cumulative sampling weights for
each stage, plus the final sampling weights. Voters who were not selected to the sample are
excluded from this dataset.

The final sampling weights are identical for voters within the same neighborhood because they
are selected according to a simple random sampling method within neighborhoods. However, they
are different across neighborhoods within the same township because the sampled proportions are
not exactly 20% in all neighborhoods.
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Figure 13-47
Data Editor with sample results
voteid | nbrhood | town | county IncIusinnF‘i‘SampleWei IncIusionF‘i‘SampleWei SampleyVei -
obability_1_{ghtCurnulat{ obability_2 | ghtCurmulat] ght_Final_
ve | ve 2
B35| &77 £ ) 1 44 226 20 11.30 11.30
G35| 478 5 9 1 44 226 20 11.30 11.30
G37| 482 5 9 1 44 226 20 11.30 11.30
638 590 G 9 1 44 226 .20 11.30 11.30
639 594 G 9 1 44 226 .20 11.30 11.30
G40 597 G 9 1 44 226 .20 11.30 11.30
641 GO0 G 9 1 44 226 .20 11.30 11.30
f42 4 1 10 1 | 321 .20 16.00 16.00
643 5 1 10 1 3 321 .20 16.00 16.00
G4 9 1 10 1 cyl 321 .20 16.00 16.00
645 10 1 10 1 cyl 321 .20 16.00 16.00
G465 12 1 10 1 cyl 3.1 .20 16.00 16.00
B47 16 1 10 1 3 34 20 16.00 16.00
548 17 1 10 1 3 34 20 16.00 16.00
45 14 1 n 1 1 I 2N 1R 1N 1R N v
1 FF\Data\ﬂew A variable View [ [« >

Unlike voters in the second stage, the first-stage sampling weights are not identical for townships
within the same county because they are selected with probability proportional to size.

Figure 13-48
Joint probabilities file

county town | Unit_Ma_ JDint_F'roh‘{.JDint_F'rUh‘{JDint_F'roh‘{JUint_F'rDh‘|J0int_F'r0h‘{ s
1 2 3 4 E
1] 1 10 1 | A0 1 A2
2 1 11 2 A0 39 15 16
3 1 9 3 M 15 44 21
4 1 12 4 12 1B 21 .48
5 2 12 1 22 04 07 .08
5 2 B 2 04 23 07 .08
7 2 7 3 07 a7 A1 19
g 2 2 4 .08 i 19 45
g 3 5 1 .58 .31 32
10 3 3 2 )| 1 .36
11 3 4 3 32 .36 63 . .
12 4 14 1 .26 i 06 07 .03
13 4 g 2 06 29 07 .08 10
14 4 4 3 0B a7 29 .08 10
15 4 2 4 07 g .08 33 12
16 4 13 5 .09 A0 10 2 43
17 5 3 1 74 25 e
18 5 B 2 25 A1 13
19 5 4 3 27 13 43 o
» QBata\ﬂew,{\iariahle wiew f |2 2]

The file poll_jointprob.sav contains first-stage joint probabilities for selected townships within
counties. County is a first-stage stratification variable, and Township is a cluster variable.
Combinations of these variables identify all first-stage PSUs uniquely. Unit No_ labels PSUs
within each stratum and is used to match up with Joint Prob 1 _, Joint Prob_2 , Joint Prob 3 |,
Joint_Prob_4_, and Joint_Prob_5 . The first two strata each have 4 PSUs; therefore, the joint
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inclusion probability matrices are 4x4 for these strata, and the Joint Prob 5 column is left empty
for these rows. Similarly, strata 3 and 5 have 3x3 joint inclusion probability matrices, and stratum
4 has a 5x5 joint inclusion probability matrix.

The need for a joint probabilities file is seen by perusing the values of the joint inclusion
probability matrices. When the sampling method is not a PPS WOR method, the selection of a PSU
is independent of the selection of another PSU, and their joint inclusion probability is simply the
product of their inclusion probabilities. In contrast, the joint inclusion probability for Townships 9
and 10 of County 1 is approximately 0.11 (see the first case of Joint Prob 3 or the third case of
Joint_Prob_1 ), or less than the product of their individual inclusion probabilities (the product of
the first case of Joint Prob I and the third case of Joint Prob 3 is 0.31x0.44=0.1364).

The pollsters will now conduct interviews for the selected sample. Once the results are
available, you can process the sample with Complex Samples analysis procedures, using the
sampling plan poll.csplan to provide the sampling specifications and poll_jointprob.sav to provide
the needed joint inclusion probabilities.

Related Procedures

The Complex Samples Sampling Wizard procedure is a useful tool for creating a sampling plan
file and drawing a sample.

m  To ready a sample for analysis when you do not have access to the sampling plan file, use
the Analysis Preparation Wizard.
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14

Complex Samples Analysis
Preparation Wizard

The Analysis Preparation Wizard guides you through the steps for creating or modifying an
analysis plan for use with the various Complex Samples analysis procedures. It is most useful
when you do not have access to the sampling plan file used to draw the sample.

Using the Complex Samples Analysis Preparation Wizard to Ready
NHIS Public Data

The National Health Interview Survey (NHIS) is a large, population-based survey of the U.S.
civilian population. Interviews are carried out face-to-face in a nationally representative sample
of households. Demographic information and observations about health behavior and status
are obtained for members of each household.

A subset of the 2000 survey is collected in nhis2000_subset.sav. For more information, see
the topic Sample Files in Appendix A in /IBM SPSS Complex Samples 19. Use the Complex
Samples Analysis Preparation Wizard to create an analysis plan for this data file so that it can be
processed by Complex Samples analysis procedures.

Using the Wizard

» To prepare a sample using the Complex Samples Analysis Preparation Wizard, from the menus
choose:
Analyze > Complex Samples > Prepare for Analysis...

© Copyright SPSS Inc. 1989, 2010 140
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Complex Samples Analysis Preparation Wizard

Figure 14-1
Analysis Preparation Wizard, Welcome step

= Analysis Preparation Wizard

Wielcome to the &nalysis Preparation Wizard

The Analysis Preparation Wizard helps you describe your complex sample and choose an estimation method. You will be asked to provide
sample weights and ather information needed for accurate estitmation of standard errors.

“Your selections will be saved to a plan file that you can use in any of the analysis procedures in the Complex Samples Option.

What weould you like to do?

@ create a plan file

Choaze this option if you have sample File: .
ile:
data but have not created a plan file. : Rhis2000_sUibset csaplan | [BEOWSE"' ]

Ediit & plan file

Choose this aption if you want to add,
remove, or modify stages of an
existing plan.

’i |t wou already have a plan file you can =kip the Analysis Preparation \Wizard and go directly

A to any of the analysis procedures in the Complex Samples Option to analyze your sathple.

» Browse to where you want to save the plan file and type nhis2000_subset.csaplan as the name for

the analysis plan file.

» Click Next.
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vV v v VY

Figure 14-2

Analysis Preparation Wizard, Design Variables step (stage 1)

H Analysis Preparation Wizard

Stage 1: Design YVariables

: Welcome

E| Stage 1

D » Design Variables
Estimation hethod
Sumimary

Completion

“You can alzo provide a label for the stage that will be used inthe output.

In this panel you can select variables that define strata or clusters. & sample weight variable must be selected in the first stage.

Wariahles: Strata:
& Sex [SEX] f Stratum for variance estimation ...
& age [AGE_P|

& Region [REGION]
& Smoking frequency [ShKHM. ..

& Desirable Body Weight [DE...

& Age category [age_cat]

& Yitamindmineral supplmnts-p...
f Take any multi-witaming in gp...
& Take herbal supplements o,
& Freq vigorous activity (time..
ef Freq moderate activity (time...
& Freq strength activity (times...

f Diaily activities, moving arou...
& Diaily activities, lifting or car...

Clusters:

f PSU for variance estimation [PSU]

Sample Yeight:

| y Wieight - Final Annual PATEA_SA]

Stage Label: |

[: Back ] |Ne

Finizh ”Cancel ” Helg ]

The data are obtained using a complex multistage sample. However, for end users, the original

NHIS design variables were transformed to a simplified set of design and weight variables whose
results approximate those of the original design structures.

Select Stratum for variance estimation as a strata variable.
Select PSU for variance estimation as a cluster variable.

Select Weight - Final Annual as the sample weight variable.

Click Finish.
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Summary
Figure 14-3
Summary
Stage 1
Design Yariakles Stratification 1 Stratum for
variance
estimation
Cluster 1 PSL for warisnce
estimation
Analysis Information  Estimator Assumption
Sampling with
replacement

Plan File: cnhis2000_subset csaplan
Weight “Wariahle: Yeight - Final Annual
SRS Estimator: Sampling without replacement

The summary table reviews your analysis plan. The plan consists of one stage with a design of
one stratification variable and one cluster variable. With-replacement (WR) estimation is used,
and the plan is saved to c:\nhis2000_subset.csaplan. You can now use this plan file to process

nhis2000 _subset.sav with Complex Samples analysis procedures.

Preparing for Analysis When Sampling Weights Are Not in the Data File

A loan officer has a collection of customer records, taken according to a complex design;
however, the sampling weights are not included in the file. This information is contained in
bankloan _cs_noweights.sav. For more information, see the topic Sample Files in Appendix A in
IBM SPSS Complex Samples 19. Starting with what she knows about the sampling design, the
officer wants to use the Complex Samples Analysis Preparation Wizard to create an analysis plan
for this data file so that it can be processed by Complex Samples analysis procedures.

The loan officer knows that the records were selected in two stages, with 15 out of 100 bank
branches selected with equal probability and without replacement in the first stage. One hundred
customers were then selected from each of those banks with equal probability and without
replacement in the second stage, and information on the number of customers at each bank is
included in the data file. The first step to creating an analysis plan is to compute the stagewise
inclusion probabilities and final sampling weights.

Computing Inclusion Probabilities and Sampling Weights

» To compute the inclusion probabilities for the first stage, from the menus choose:
Transform > Compute Variable...
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Figure 14-4
Compute Variable dialog box
H Compute Yariable
Target Wariable: Mumeric Expression:
|inclpr0b_s1 | = 015

Type & Lakel...
&) Branch [branch]

‘gﬁ Mumber of customers [ ...
&) Customer D [customer]
& Age inyears [age]

il Level of education [ed)
f Years with current em...

Function group:

& -
Arithmetic

CDF & Moncertral COF

& Wears st currert addre... Conversion .
& Househald income in th... Current DateTime ||
Date Arithmetic hal

@& Debt to income ratio (x...
& Credit card dett intho...
‘gﬁ Cther debt in thowsand...
&) Previously defaulted [d..

EEE0E

Functions and Special Yariables:
2| T

(Dptional caze selection condition)

| k. ” Paste ”Reset ”Cancel” Help ]

Fifteen out of one hundred bank branches were selected without replacement in the first stage;
thus, the probability that a given bank was selected is 15/100 = 0.15.

» Type inclprob_s1 as the target variable.
» Type 0.15 as the numeric expression.

» Click OK.
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Complex Samples Analysis Preparation Wizard

Figure 14-5
Compute Variable dialog box

H Compute Yariable

Target Wariable: Mumeric Expression:

|inclpr0b_s2 | = 100/mcust

Type & Label...

&) Eranch [branch] «

‘gﬁ Mumber of customers [ ...
&) Customer D [customer]
& Age inyears [age]

il Level of education [ed)
f Years with current em...

Function group:

& -
Arithmetic

CDF & Moncertral COF

& Wears st currert addre... Conversion .
& Househald income in th... Current DateTime ||
Date Arithmetic Il

@& Debt to income ratio (x...
& Credit card dett in tho...
‘gﬁ Cther debt in thowsand...
&) Previously defaulted [d..
f inclprob_s1

Functions and Special Yariahles:

EEE0E

(Dptional caze selection condition)

[ Cl “ Paste ”Reset ”Cancel” Help ]

One hundred customers were selected from each branch in the second stage; thus, the stage
2 inclusion probability for a given customer at a given bank is 100/the number of customers at
that bank.

Recall the Compute Variable dialog box.
Type inclprob_s2 as the target variable.
Type 100/ncust as the numeric expression.

Click OK.
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Figure 14-6
Compute Variable dialog box

H Compute Yariable

Target Wariable: Mumeric Expression:

|finalweight | = 1iinclprab_s1 * inclprob_s2)

Type & Label...

&) Eranch [branch] «

‘gﬁ Mumber of customers [ ...
&) Customer D [customer]
& Age inyears [age]

il Level of education [ed)
f Years with current em...

Function group:

& -
Arithmetic

CDF & Moncertral COF

& Wears st currert addre... Conversion .
& Househald income in th... Current DateTime ||
Date Arithmetic hal

@& Debt to income ratio (x...
& Credit card dett intho...
‘gﬁ Cther debt in thowsand...
&) Previously defaulted [d..
f inclprob_s1
‘g& inclprob_s2

EEE0E

Functions and Special Yariables:
F

(Dptional caze selection condition)

@ Microsoft Qutlook We. .. n @ Tutarial n E *#Output] [Docurment. .,

Now that you have the inclusion probabilities for each stage, it’s easy to compute the final
sampling weights.

» Recall the Compute Variable dialog box.
» Type finalweight as the target variable.
» Type 1/(inclprob_s1 * inclprob_s2) as the numeric expression.

» Click OK.

You are now ready to create the analysis plan.

Using the Wizard

» To prepare a sample using the Complex Samples Analysis Preparation Wizard, from the menus
choose:

Analyze > Complex Samples > Prepare for Analysis...
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Figure 14-7
Analysis Preparation Wizard, Welcome step

H Analysis Preparation Wizard

Welcome to the Analysis Preparation vizard

The Analysis Preparation Wizard helps you describe your complex sample and choose an estimation method. You will be asked to provide
sample weights and other information needed for accurate estimation of standard errors.

Your selections will be saved to a plan file that you can use in any of the analysis procedures in the Complex Samples Option.

What weould vou like to do?

@ Create a plan file

Chooze this option if you have sample File:
ile:
data but have not crested s plan file, : fbankloan cspian | [BEDWSB"' ]

Edit & plan file

Chooze this option if you weant to add,
remove, or modify stages of an
existing plan.

’i |t wou already have a plan file you can =kip the Analysis Preparation \Wizard and go directly
A to any of the analysis procedures in the Complex Samples Option to analyze your sathple.

» Browse to where you want to save the plan file and type bankloan.csaplan as the name for the

analysis plan file.

» Click Next.
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Figure 14-8

Analysis Preparation Wizard, Design Variables step (stage 1)

H Analysis Preparation Wizard

Stage 1: Design YVariables

: Welcome
E| Stage 1
» Design Variables

Estimation hethod
Sumimary

Completion

You can alzo provide a label for the stage that will be used inthe output.

Wariahles:

In this panel you can select variables that define strata or clusters. & sample weight variable must be selected in the first stage.

Strata:

& Mumber of customers [noust]
% Customer 1D [customer]

ef Age in years [age]

d:l Level of educstion [ed]

& Years with current employ..
f Years gt current address [
& Household income inthous..

& Debt to income ratio (x100) .

ef Credit card debt inthousan...
& Cther debt in thousands [of...
% Previously defaulted [default]
f inclorok_s1
& inclprob_s2

Clusters:

&) Branch [branch]

Sample YWeight:

| & finalweighi

Stage Label: |

[: Back ] | et

Finizh ”Cancel ” Help ]

» Select Branch as a cluster variable.

» Select finalweight as the sample weight variable.

>

Click Next.
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Figure 14-9
Analysis Preparation Wizard, Estimation Method step (stage 1)

H Analysis Preparation Wizard

Stage 1: Estimation Method

Inthis panel you select & method for estimating standard errors.

The estimation method depends on assumptions about how the sample was draswn.

Wielcome

E|® Stage 1

Design Yariakles

P Estimation Method
Size

@ = incomplete section

Which of the following sample designs should be assumed far estimation’?

WR (zampling with replacement)

If you choose this option you will not be able to add additional stages. Any sample stages
after the current stage will be ignored when the data are analyzed.

@ Exjual WOR (ecual probakility sampling without replacement)

The next panel will ask you to specify inclusion probabilities or populstion sizes.
Unecual WOR (unequal probahilty sampling without replacement)

Joint probabilties will be required to analyze sample data. This option iz available in stage 1
anly.

» Click Next.

» Select Equal WOR as the first-stage estimation method.
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Figure 14-10
Analysis Preparation Wizard, Size step (stage 1)

H Analysis Preparation Wizard

Stage 1: Size

In this panel you specify inclusion probahilities or populstion sizes for the current stage.

Yol can provide a size that is fived across strata or specify sizes on a per-straturm basis.

Welcome Wariahles:

) . Stage 1 & Mumber of customers [noust] Units: |Incluzion Probakilties =
Design ‘Yariables &) Cuzstamer I [customer]

Estimation Method & boein years [age] “alue:

b size d:l Level of education [ed)]
Summary @& Years with current employver ... -
Adld Stage 2 & Vesrs st current address [ad... h=
Completion

& Household income inthousan...
@& Dekbt to income ratio (1000 [d...
f Credit card debt in thousands... ® Read values from variakle:
& Cther debt in thousands [oth... | f inclprob_s1

&) Freviously defaulted [default]
f inclprob_s2

[: Elack“jmext Finizh ”Cancel ” Help ]

» Select Read values from variable and select inclprob_si as the variable containing the first-stage
inclusion probabilities.

» Click Next.
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Figure 14-11
Analysis Preparation Wizard, Plan Summary step (stage 1)

H Analysis Preparation Wizard

Stage 1: Plan Summary

This panel summarizes the plan o far. You can add another stage to the plan.

If wou choose not to addd a stage the next panel i the Completion panel.

Welcome Summary:

o, Staged Stage  |Label |Strata  |Clusters Weights | Size [ Methaod
i Design Yarishles 1 (Maone) branch finakweight  (Read from inclprob_s1) Equal WoR
Estimation hethod
Size

» Summary
Add Stage 2

Completion 3 ¥

File: /bankloan.csplan

Do wou wwant to acdd stage 27

@ Yesz, add stage 2 now Mo, do not add ancther stage now
Chooze this option if the sample Chooze this option if this is the last stage of the
contains ancther stage. sample.

» Select Yes, add stage 2 now.

» Click Next, and then click Next in the Design Variables step.
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Figure 14-12

Analysis Preparation Wizard, Estimation Method step (stage 2)

H Analysis Preparation Wizard

Stage 20 Estimation Method

: Welcome
EI Stage 1
Design Variables
Estimation hethod
Size
Summary
=3 @ Stage 2
Design Variables
-} Estimation Method
Size

@ = incomplete section

Inthis panel you select & method for estimating standard errors.

The estimation method depends on assumptions about how the sample was draswn.

Which of the following sample designs should be assumed far estimation’?
WR (zampling with replacement)

If you choose this option you will not be able to add additional stages. Any sample stages
after the current stage will be ignored when the data are analyzed.

@ Exjual WOR (ecual probakility sampling without replacement)

The next panel will ask you to specify inclusion probabilities or populstion sizes.

Joint probabilties will be required to analyze sample data. This option iz available in stage 1
anly.

» Select Equal WOR as the second-stage estimation method.

» Click Next.
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Figure 14-13
Analysis Preparation Wizard, Size step (stage 2)

H Analysis Preparation Wizard

Stage 1: Size

In this panel you specify inclusion probahilities or populstion sizes for the current stage.

Yol can provide a size that is fived across strata or specify sizes on a per-straturm basis.

: Wielcome Variables:
B Stage & Mumber of customers [neust] Unitz:
Design Yariables & Customer ID [customer]
Estimation Method & Agein years [age] @ walue:
Size ol Level of education [=o]
Summary & “vears with current employer ..
& Stage 2 f Vears at current address [ad.. © Unequal values for strata:
Design Variables & Househald incame in thousan...
Estimation Method & Dett to income ratio (1001 [d...
- b Size f Credit card debt in thousands.. @ Read values from variahle:
Sumimary & Other dekt in thousands [oth... | & inciprab_s2
Add Stage 3 & Previously defautted [defaut]
Completion

[: Back ] | et

Finizh ”Cancel ” Helg ]

» Select Read values from variable and select inclprob_s2 as the variable containing the second-stage

>

inclusion probabilities.

Click Finish.
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Summary
Figure 14-14
Summary table
Stage 1 Stage 2
Dezign Cluster 1
Wariahles Branch
Analysis Estimator Assumption
Information
Ecual probability Ecjual probability
sampling without sampling without
replacement replacement

Incluzion Probability

Ohtained fram
variable inclprob_
32

Chbtained from
wariable inclprob_s1

Plan File: c:'bankloan.cssplan
Wigight arisble: finalweight
SRS Estimator: Sampling wwithout replacemernt

The summary table reviews your analysis plan. The plan consists of two stages with a design

of one cluster variable. Equal probability without replacement (WOR) estimation is used,

and the plan is saved to c:\bankloan.csaplan. You can now use this plan file to process
bankloan_noweights.sav (with the inclusion probabilities and sampling weights you’ve computed)
with Complex Samples analysis procedures.

Related Procedures

The Complex Samples Analysis Preparation Wizard procedure is a useful tool for readying a
sample for analysis when you do not have access to the sampling plan file.

m  To create a sampling plan file and draw a sample, use the Sampling Wizard.
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Complex Samples Frequencies

The Complex Samples Frequencies procedure produces frequency tables for selected variables
and displays univariate statistics. Optionally, you can request statistics by subgroups, defined by
one or more categorical variables.

Using Complex Samples Frequencies to Analyze Nutritional
Supplement Usage

A researcher wants to study the use of nutritional supplements among U.S. citizens, using the
results of the National Health Interview Survey (NHIS) and a previously created analysis plan.
For more information, see the topic Using the Complex Samples Analysis Preparation Wizard to
Ready NHIS Public Data in Chapter 14 on p. 140.

A subset of the 2000 survey is collected in nkis2000 subset.sav. The analysis plan is stored
in nhis2000_subset.csaplan. For more information, see the topic Sample Files in Appendix A
in IBM SPSS Complex Samples 19. Use Complex Samples Frequencies to produce statistics for
nutritional supplement usage.

Running the Analysis

» To run a Complex Samples Frequencies analysis, from the menus choose:
Analyze > Complex Samples > Frequencies...

© Copyright SPSS Inc. 1989, 2010 155
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Figure 15-1
Complex Samples Plan dialog box

H Complex Samples Plan for Frequencies An...

rPlan

File: |nhisQDDD_suh331 csaplan | |iBrowse..i|

If ywou do not have a plan file for your complex sample,
you can use the Analysis Preparation Wizard to create
one. Choose Prepare for Analysis from the Complex
Samples menu to access the wizard,

rdairt Probakilitie

Joint probakilties are required if the plan requests
unegual probabilty WIOR estimation. Ctherwise, they are
igrored.

® Use default file  [rhis2000_subset sav)

@ an open detaset

nhis2000_subset sav [$0ataset]

© Custom file

File: Brorese...

[Continue” Cancel ” Help ]

» Browse to and select nhis2000_subset.csaplan. For more information, see the topic Sample Files
in Appendix A in /IBM SPSS Complex Samples 19.

» Click Continue.
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Figure 15-2
Frequencies dialog box

H Complex Samples Plan for Frequencies Analysis

Wariahles:

Frequency Tables:

£ Stratum for varianc...
& PSU for vatiance e..

@ﬁ Wizight - Final &nnu...

& Sex [SEX]
& sge [AGE_P]
& Region [REGION]

‘g& Smoking frequency ..

f Take any multi-vita...
f Take herbal supple...

@& Freg vigorous activi...
f Freg moderate activ...
f Freq strength activit...

& Desirable Body Wei...

@ﬁ Daily activities, mawi...

& Daily activities, littin.

- f Yitamindmineral suppim...

Subpopulations:

f Age category [age_cat]

Each combination of
categories defines a
subpopulation.

4

Pazte ” Reset ”Cancel” Help ]

Miszing Values. ..

Click Statistics.

Select Age category as a subpopulation variable.

Figure 15-3

Frequencies Statistics dialog box

Select Vitamin/mineral supplmnts-past 12 m as a frequency variable.

H Complex Samples Frequencies: Statistics

ricells

E Population size

E Tahle percent

=tatistic:

[+ Standard error

E Confidence interval

Lewvel(%):

|:| Coetficient of variation

[T Ureaveighte court

|:| Desian effect

|:| Sguare root of desian effect

|:| Cumulative values

|:| Test of equal cell proportions

” Cancel ” Help ]

Select Table percent in the Cells group.

Select Confidence interval in the Statistics group.

»
>
» Click Continue.
>

Click OK in the Frequencies dialog box.

Complex Samples Frequencies
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Frequency Table
Figure 15-4
Frequency table for variable/situation
95% Confidence nterval
Ex=timate Stanclard Error Liowver Upper
Populstion Size | Yes | 102767095 | 1185126709 | 100435967 | 105006223
Mo a0794234 | 1094401948 | 88E41560 | 92046903
Total | 193561329 | 1780088713 | 190042196 | 197060462
% of Total Yes 531% A% 524% 53.8%
Mo 46 0% A%, 48 2% 47 B%
Total 100 0% 0% 100 0% 100.0%

Each selected statistic is computed for each selected cell measure. The first column contains
estimates of the number and percentage of the population that do or do not take vitamin/mineral
supplements. The confidence intervals are non-overlapping; thus, you can conclude that, overall,
more Americans take vitamin/mineral supplements than not.

Frequency by Subpopulation

Figure 15-5
Frequency table by subpopulation
Lge 955% Confidence Interval
category Estimate Standard Error Lovwwer Upper
18-24 Populstion | “es 10018312 30602352 | 93286819 10707942
Size Mo 15472365 4991525391 14430453 16454253
Tatal 25490650 EE0732.812 241516588 26529672
% of Tatal Yes F9.53% 1.0% 3T 4% 4 2%
o BO.7 % 1.0% 55.8% B2 6%
Total 100.0% 0% 100.0% 100.0%
25-44 Populstion | Yes 391683540 EE0355.719 37863946 40463734
Size Mo 39503150 545934 157 35232606 40773694
Total 666990 961114325 JET7E451 805574589
% of Tatal es 48 5% E% 45.7% S0.9%
Mo S0.2% E% 49.1% 51.3%
Total 100.0% 0% 100.0% 100.0%
45-64 Population Yes 34154952 S98603.725 F2977507 35332397
Size Mo 240053512 497723833 23026496 24954525
Total 58160464 214680415 SE557099 59752929
% of Tatal es S5.7% E% a7 5% E0.0%
Mo 41.3% B% 40.0% 42.5%
Total 100.0% 0% 100.0% 100.0%
ES+ Population Yes 19429991 439459793 18565580 20294402
Size Mo 11813204 314235073 11195102 12431306
Tatal 31243195 587623439 30057345 F2399042
% of Total es B2.2% T B0.7% E3.6%
Mo I7E% T% 36.4% 39.3%
Tatal 100.0% 0% 100.0% 100.0%

When computing statistics by subpopulation, each selected statistic is computed for each selected
cell measure by value of Age category. The first column contains estimates of the number and
percentage of the population of each category that do or do not take vitamin/mineral supplements.
The confidence intervals for the table percentages are all non-overlapping; thus, you can conclude
that the use of vitamin/mineral supplements increases with age.
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Summary

Using the Complex Samples Frequencies procedure, you have obtained statistics for the use of
nutritional supplements among U.S. citizens.

®  Overall, more Americans take vitamin/mineral supplements than not.

®  When broken down by age category, greater proportions of Americans take vitamin/mineral
supplements with increasing age.

Related Procedures

The Complex Samples Frequencies procedure is a useful tool for obtaining univariate descriptive
statistics of categorical variables for observations obtained via a complex sampling design.

m  The Complex Samples Sampling Wizard is used to specify complex sampling design
specifications and obtain a sample. The sampling plan file created by the Sampling Wizard
contains a default analysis plan and can be specified in the Plan dialog box when you are
analyzing the sample obtained according to that plan.

m  The Complex Samples Analysis Preparation Wizard is used to set analysis specifications for
an existing complex sample. The analysis plan file created by the Sampling Wizard can be
specified in the Plan dialog box when you are analyzing the sample corresponding to that plan.

m  The Complex Samples Crosstabs procedure provides descriptive statistics for the
crosstabulation of categorical variables.

m  The Complex Samples Descriptives procedure provides univariate descriptive statistics for
scale variables.
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The Complex Samples Descriptives procedure displays univariate summary statistics for several

variables. Optionally, you can request statistics by subgroups, defined by one or more categorical
variables.

Using Complex Samples Descriptives to Analyze Activity Levels

A researcher wants to study the activity levels of U.S. citizens, using the results of the National
Health Interview Survey (NHIS) and a previously created analysis plan. For more information,
see the topic Using the Complex Samples Analysis Preparation Wizard to Ready NHIS Public
Data in Chapter 14 on p. 140.

A subset of the 2000 survey is collected in nhis2000 subset.sav. The analysis plan is stored
in nhis2000_subset.csaplan. For more information, see the topic Sample Files in Appendix A
in /BM SPSS Complex Samples 19. Use Complex Samples Descriptives to produce univariate
descriptive statistics for activity levels.

Running the Analysis

» To run a Complex Samples Descriptives analysis, from the menus choose:
Analyze > Complex Samples > Descriptives...

© Copyright SPSS Inc. 1989, 2010 160



161

Figure 16-1
Complex Samples Plan dialog box

H Complex Samples Plan for Frequencies An...

rPlan

File: |nhisQDDD_suh331 csaplan | |iBrowse..i|

If ywou do not have a plan file for your complex sample,
you can use the Analysis Preparation Wizard to create
one. Choose Prepare for Analysis from the Complex
Samples menu to access the wizard,

rdairt Probakilitie

Joint probakilties are required if the plan requests
unegual probabilty WIOR estimation. Ctherwise, they are
igrored.

® Use default file  [rhis2000_subset sav)

@ an open detaset

nhis2000_subset sav [$0ataset]

© Custom file

File: Brorese...

[Continue” Cancel ” Help ]

Complex Samples Descriptives

» Browse to and select nhis2000_subset.csaplan. For more information, see the topic Sample Files

>

in Appendix A in /IBM SPSS Complex Samples 19.

Click Continue.
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Figure 16-2
Descriptives dialog box

i Complex Samples Descriptives

Wariahles:

‘gﬁ Stratum for variance e..
f PZU for variance estim...
& \wigight - Final Annual ...

Measures:

‘gﬁ Freq vigorous activity (...
f Freq moderate activity ...

Miszing Values...

f Freg strenoth activity (..

& Sex [5EX]

& sge [MGE_P]

& Region [REGION]

f Smioking freguency [S...

‘gﬁ Yitamindmineral suppim...
f Take any multi-vitamins...
& Take herbal supplemen...
‘gﬁ Desirable Body YWeight...
f Daily activities, moving ...
& Daily activities, litting o...

Subpopulations:
f Age category [age_cat]

Each combination of
categories defines a
subpopulstion.

[ Paste ” Reset ”Cancel” Hela ]

» Select Freq vigorous activity (times per wk) through Freq strength activity (times per wk) as
measure variables.

» Select Age category as a subpopulation variable.

» Click Statistics.

Figure 16-3
Descriptives Statistics dialog box
H Complex Samples Descriptives: Statistics
rSUmmariss
[ mean [T] sum
[T test [
r=tatistics
m Standard errar |:| Unweeighted count
m Confidence interval |:| Populstion size
Level (%) [7] Design effect
|:| Coefficient of wariation |:| Square root of design effect
[ ontmue” Cancel ” Helg ]

» Select Confidence interval in the Statistics group.
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» Click Continue.

» Click OK in the Complex Samples Descriptives dialog box.

Univariate Statistics

Figure 16-4
Univariate statistics

95% Confidence
Standard Irterval
Estimate: Errar Lot Upper
Mean Freq vigorous activity 273 053 366 379
ttimes per wk) . : : .
Freq moderate activity 440 041 487 o4 0
ftimes per wh) ) : : )
Freq strength activity 352 04z 343 360
times per wh)

Complex Samples Descriptives

Each selected statistic is computed for each measure variable. The first column contains estimates
of the average number of times per week that a person engages in a particular type of activity. The
confidence intervals for the means are non-overlapping. Thus, you can conclude that, overall,
Americans engage in a strength activity less often than vigorous activity, and they engage in

vigorous activity less often than moderate activity.

Univariate Statistics by Subpopulation

Figure 16-5
Univariate statistics by subpopulation
95% Confidence
Standard Irdet el

Age category E=timate Error Lower Upper

18-24 Mean Fr_'eq vigorous activity ey a7 575 409
fimes per whk)
Freq modersle activity 513 a37 4.91 545
fimes per whk)
Freq strength ctivity 345 0ss 328 | 3E2
times per wh)

25-44 Iean Fr_'eq wigorous activity G55 4 245 1S
fimes per whk)
Freq moderale activity 473 06 462 | 424
times per wh)
Freq strength activity 328 052 318 | 338
times per whk)

45-64 Iean Freq vigorous activity
times per k) 374 0E3 3E6 3m
Freg moderate activity 458 070 474 502
times per wh)
Freq strenoth activity 365 09z 347 | 384
times per whk)

ES+ Iean Freq vinorous activity
ftimes per ok 418 A1 396 439
Freq modsrate activiy 522 084 5.06 539
times per whk)
Freq strength activity 468 155 436 | 497
times per whk)
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Each selected statistic is computed for each measure variable by values of Age category. The first
column contains estimates of the average number of times per week that people of each category

engage in a particular type of activity. The confidence intervals for the means allow you to make
some interesting conclusions.

® In terms of vigorous and moderate activities, 25—44-year-olds are less active than those 18-24
and 45-64, and 45—-64-year-olds are less active than those 65 or older.

m In terms of strength activity, 25—44-year-olds are less active than those 45-64, and 18-24 and
45—64-year-olds are less active than those 65 or older.

Summary

Using the Complex Samples Descriptives procedure, you have obtained statistics for the activity
levels of U.S. citizens.

m  Overall, Americans spend varying amounts of time at different types of activities.

®  When broken down by age, it roughly appears that post-collegiate Americans are initially less
active than they were while in school but become more conscientious about exercising as
they age.

Related Procedures

The Complex Samples Descriptives procedure is a useful tool for obtaining univariate descriptive
statistics of scale measures for observations obtained via a complex sampling design.

®  The Complex Samples Sampling Wizard is used to specify complex sampling design
specifications and obtain a sample. The sampling plan file created by the Sampling Wizard
contains a default analysis plan and can be specified in the Plan dialog box when you are
analyzing the sample obtained according to that plan.

m  The Complex Samples Analysis Preparation Wizard is used to set analysis specifications for
an existing complex sample. The analysis plan file created by the Sampling Wizard can be
specified in the Plan dialog box when you are analyzing the sample corresponding to that plan.

m  The Complex Samples Ratios procedure provides descriptive statistics for ratios of scale
measures.

m  The Complex Samples Frequencies procedure provides univariate descriptive statistics of
categorical variables.
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Complex Samples Crosstabs

The Complex Samples Crosstabs procedure produces crosstabulation tables for pairs of selected
variables and displays two-way statistics. Optionally, you can request statistics by subgroups,
defined by one or more categorical variables.

Using Complex Samples Crosstabs to Measure the Relative Risk of
an Event

A company that sells magazine subscriptions traditionally sends monthly mailings to a purchased
database of names. The response rate is typically low, so you need to find a way to better

target prospective customers. One suggestion is to focus mailings on people with newspaper
subscriptions, on the assumption that people who read newspapers are more likely to subscribe to
magazines.

Use the Complex Samples Crosstabs procedure to test this theory by constructing a two-by-two
table of Newspaper subscription by Response and computing the relative risk that a person with a
newspaper subscription will respond to the mailing. This information is collected in demo_cs.sav
and should be analyzed using the sampling plan file demo.csplan. For more information, see the
topic Sample Files in Appendix A in IBM SPSS Complex Samples 19.

Running the Analysis

» To run a Complex Samples Crosstabs analysis, from the menus choose:
Analyze > Complex Samples > Crosstabs...

© Copyright SPSS Inc. 1989, 2010 165
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Figure 17-1
Complex Samples Plan dialog box

H Complex Samples Plan for Crosstabs Analysis m

rPlan

File: |demo.csplan | W

If you do nat have a plan file for your complex sample, you
can uze the Analysis Preparation YWizard to create one.
Choose Prepare for Analysis from the Complex Samples
menu to access the wizard.

rdiirt Probskilitie:

Joint probakilties are reguired if the plan requests unegual
probability WOR estimation. Ctherwize, they are ignored.

@ Use defaul file  (hased on name of plan file)
O an open dataset
demo_cs.sav [DataSet1]

© Custom file

File: Erowse...

(comrve) (cance J_ew )

» Browse to and select demo.csplan. For more information, see the topic Sample Files in
Appendix A in IBM SPSS Complex Samples 19.

» Click Continue.
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Figure 17-2

Crosstabs dialog box

i Complex Samples Crosstabs

Wariahles:

&) Region [region]

&) Province [province]
& District [district]

&b City [city]

&5 Subdivision [subdivi...
&b Unit [unit]

gﬁ Age in years [age]
f Marital status [marital]
‘gﬁ “ears at current ad...
f Household income ..
‘g& Price of primary ve...
{I Primary wehicle pric...
‘f Level of education [...
@& Years with current ...
&P Retired [retirs]

il ears with current ...

gﬁ Gender [gender]
-~

&2 Job satisfaction [ioh...

-

Riowya:

f Mewspaper subscription...

Column:

| @ﬁ Fesponse [responze]

Subpopulations:

|;[l Income category in thous...

Each combination of categories

defines & subpooulation.

[ O, ” Fazte ” Reset ”Cancel” Help ]

Miszing Yalues...

Select Newspaper subscription as a row variable.

Select Response as a column variable.

Complex Samples Crosstabs

There is also some interest in seeing the results broken down by income categories, so select
Income category in thousands as a subpopulation variable.

Click Statistics.
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Figure 17-3
Crosstabs Statistics dialog box

H Complex Samples Crosstabs: Statistics

Cells

Ei Population size EI Column percert

@ Roww percent Ei Tahlz percent

Statistics

|_1_{'| Standard error [I Urreveighted cournt
Ei Confidence interyval Ei Design effect

Ei Sguare root of design effect

|_i Coefficient of variation IE‘

[ [
Sumimaties for 2-by-2 Tables

[ odds ratio  [7] Risk difference
[ Relative risk

EI Test af independence of rovws and columnz

IéCordinueéI[ Cancel ][ Help ]

» Deselect Population size and select Row percent in the Cells group.
» Select Odds ratio and Relative risk in the Summaries for 2-by-2 Tables group.
» Click Continue.

» Click OK in the Complex Samples Crosstabs dialog box.

These selections produce a crosstabulation table and risk estimate for Newspaper subscription by
Response. Separate tables with results split by Income category in thousands are also created.

Crosstabulation
Figure 17-4
Crosstabulation for newspaper subscription by response
Mewspaper Responze
subsctiption Yes Mo Tatal
Yes Yo weithin Mevwspaper | Estimate 17.2% 82.8% 100.0%
subscription Standard Error 1.0% 1.0% 0%
Mo Yo weithin Mevwspaper | Estimate 10.3% 89.7% 100.0%
subsCription Standard Error T T% 0%
Tatal % wvithin Meswspaper | Estimate 128% &7.2% 100.0%
subscription Standard Errar T 7% 0%

The crosstabulation shows that, overall, few people responded to the mailing. However, a greater
proportion of newspaper subscribers responded.
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Risk Estimate

Figure 17-5
Risk estimate for newspaper subscription by response

Estimate
Meswespaper subscription Oz Ratio 1812
* Responss Relative For cohort Response = Yes 1673

Rizk For cohort Response = Mo
823

Statistics are computed only for 2-by-2 tables with all cells chzerved.

The relative risk is a ratio of event probabilities. The relative risk of a response to the mailing

is the ratio of the probability that a newspaper subscriber responds to the probability that a
nonsubscriber responds. Thus, the estimate of the relative risk is simply 17.2%/10.3% = 1.673.
Likewise, the relative risk of nonresponse is the ratio of the probability that a subscriber does not
respond to the probability that a nonsubscriber does not respond. Your estimate of this relative
risk is 0.923. Given these results, you can estimate that a newspaper subscriber is 1.673 times as
likely to respond to the mailing as a nonsubscriber, or 0.923 times as likely as a nonsubscriber
not to respond.

The odds ratio is a ratio of event odds. The odds of an event is the ratio of the probability that
the event occurs to the probability that the event does not occur. Thus, the estimate of the odds
that a newspaper subscriber responds to the mailing is 17.2%/82.8% = 0.208. Likewise, the
estimate of the odds that a nonsubscriber responds is 10.3%/89.7% = 0.115. The estimate of the
odds ratio is therefore 0.208/0.115 = 1.812 (note there is some rounding error in the intervening
steps). The odds ratio is also the ratio of the relative risk of responding to the relative risk of not
responding, or 1.673/0.923 = 1.812.

Odds Ratio versus Relative Risk

Since it is a ratio of ratios, the odds ratio is very difficult to interpret. The relative risk is easier
to interpret, so the odds ratio alone is not very helpful. However, there are certain commonly
occurring situations in which the estimate of the relative risk is not very good, and the odds ratio
can be used to approximate the relative risk of the event of interest. The odds ratio should be
used as an approximation of the relative risk of the event of interest when both of the following
conditions are met:

m  The probability of the event of interest is small (< 0.1). This condition guarantees that the
odds ratio will make a good approximation to the relative risk. In this example, the event of
interest is a response to the mailing.

B The design of the study is case control. This condition signals that the usual estimate of the
relative risk will likely not be good. A case-control study is retrospective, most often used
when the event of interest is unlikely or when the design of a prospective experiment is
impractical or unethical.

Neither condition is met in this example, since the overall proportion of respondents was 12.8%
and the design of the study was not case control, so it’s safer to report 1.673 as the relative risk,
rather than the value of the odds ratio.
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Risk Estimate by Subpopulation

Figure 17-6
Risk estimate for newspaper subscription by response, controlling for income category

Income category Estimate

Undetr F25 Meswespaper Oideds Ratio 272
subscription * Relative Far cohort Response = Yes 2241
Response Rizk

For cohort Response = Mo 396

23 - §49 Mewrspaper Crclcls Ratio 1.794
subscription * Redative For cohort Response = Yes 1645
Response Risk

For cohort Respaonse = Mo
97

F50 - 574 Mewwzpaper Oz Ratio 1165
subscription * Relative For cohort Response = Yes 1152
Response Risk

For cohort Response = Mo
886

75+ Mewvspaper Oz Ratio 1.242
subscription * Redative For cohort Response = Yes 1227
Responze Rizk

For cohort Respaonse = Mo
588

Statistics are computed only far 2-by-2 tables with all cells observed.

Relative risk estimates are computed separately for each income category. Note that the relative
risk of a positive response for newspaper subscribers appears to gradually decrease with increasing
income, which indicates that you may be able to further target the mailings.

Summary

Using Complex Samples Crosstabs risk estimates, you found that you can increase your response
rate to direct mailings by targeting newspaper subscribers. Further, you found some evidence that
the risk estimates may not be constant across Income category, so you may be able to increase
your response rate even more by targeting lower-income newspaper subscribers.

Related Procedures

The Complex Samples Crosstabs procedure is a useful tool for obtaining descriptive statistics
of the crosstabulation of categorical variables for observations obtained via a complex sampling
design.

B The Complex Samples Sampling Wizard is used to specify complex sampling design
specifications and obtain a sample. The sampling plan file created by the Sampling Wizard
contains a default analysis plan and can be specified in the Plan dialog box when you are
analyzing the sample obtained according to that plan.

m  The Complex Samples Analysis Preparation Wizard is used to set analysis specifications for
an existing complex sample. The analysis plan file created by the Sampling Wizard can be
specified in the Plan dialog box when you are analyzing the sample corresponding to that plan.

m  The Complex Samples Frequencies procedure provides univariate descriptive statistics of
categorical variables.
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The Complex Samples Ratios procedure displays univariate summary statistics for ratios of
variables. Optionally, you can request statistics by subgroups, defined by one or more categorical
variables.

Using Complex Samples Ratios to Aid Property Value Assessment

A state agency is charged with ensuring that property taxes are fairly assessed from county to
county. Taxes are based on the appraised value of the property, so the agency wants to track
property values across counties to be sure that each county’s records are equally up-to-date.
Since resources for obtaining current appraisals are limited, the agency chose to employ complex
sampling methodology to select properties.

The sample of properties selected and their current appraisal information is collected in
property_assess_cs_sample.sav. For more information, see the topic Sample Files in Appendix A
in IBM SPSS Complex Samples 19. Use Complex Samples Ratios to assess the change in property
values across the five counties since the last appraisal.

Running the Analysis

» To run a Complex Samples Ratios analysis, from the menus choose:
Analyze > Complex Samples > Ratios...

© Copyright SPSS Inc. 1989, 2010 171
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Figure 18-1
Complex Samples Plan dialog box

H Complex Samples Plan for Ratios Analysis m

rPlan

File: |proper‘ty_assess csplan | W

If ywou do not have a plan file for your complex sample,
you can use the Analysis Preparation Wizard to create
one. Choose Prepare for Analysis from the Complex
Samples menu to access the wizard,

rdairt Probabilitie

Joint probakilties are required if the plan requests
unegual probabilty WIOR estimation. Ctherwise, they are
igrored.
® Use default fie  (C:\Program Files'SPSSIn.. demo.sav)
@ an open dataset

property_assess_cs_sample sav [DataSet3]

© Custom file

File: Brormese...

(contowe) (_canee ) [_rew ]

» Browse to and select property_assess.csplan. For more information, see the topic Sample Files in
Appendix A in IBM SPSS Complex Samples 19.

» Click Continue.
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Figure 18-2
Ratios dialog box
= Complex Samples Ratios
&) Property 1D [propid] Mumerstors: =
&3 Meighborhiood [nbrhood] f Current walue [curryal]

& Township ftowr

f Years zince last appra..
&) Inciusion (Selection) Pr...
&) Cumulstive Sampling W,
&b Cumulstive Sampling W | |

Denominstor:
| f “alue st last sppraisal [1... |

Subpopulations:

|£) Courty [county] |

Each combination of categories
defines a subpopulstion.

[ Ok ” Paszte ” Reset ”Cancel” Helg ]

Select Current value as a numerator variable.
Select Value at last appraisal as the denominator variable.
Select County as a subpopulation variable.

Click Statistics.

Figure 18-3
Ratios Statistics dialog box
H Complex Samples Ratios: Statistics
Statistics
[ sStandard error [ Urreveighted court
E Confidence irterval E Population size

Level(%): [7] Design eftect

[T] coetficiert of variation [ Sguare root of design effect

E ttest Test value:

[Continue” Cancel ” Helfa ]

Select Confidence interval, Unweighted count, and Population size in the Statistics group.
Select t-test and enter 1.3 as the test value.
Click Continue.

Click OK in the Complex Samples Ratios dialog box.
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Ratios
Figure 18-4
Ratios table
95% Confidence
Ratio Standard Interal
County Mumeratar Denominator Esztimate Error Lowwer Upper Te
Eastern Current value | Value st last appraisal 1381 &5 1.236 18223
Central Current walue | Value st last appraisal 1.364 054 1.227 1.502
Western Current value | Value st last appraisal 1524 ns3 1.410 1638
Morthern Current walue | Value st last appraisal 1277 niz 1.208 1.346
Southern | Current value | Yalue at last appraizal 1195 nza 1.134 1.256

The default display of the table is very wide, so you will need to pivot it for a better view.

Pivoting the Ratios Table
» Double-click the table to activate it.
» From the Viewer menus choose:
Pivot > Pivoting Trays
Drag Numerator and then Denominator from the row to the layer.
Drag County from the row to the column.

Drag Statistics from the column to the row.

vV v v v

Close the pivoting trays window.

Pivoted Ratios Table
Figure 18-5
Pivoted ratios table

Mumeratar: Current value
Denominator; Yalue st last sppraisal

courty
Eastern Central ‘Western arthern Southern
Fatio Estimate 1.381 1.364 1524 1.277 1.1895
Standard Errar 65 064 na3 032 029
95% Confidence Lawver 1.236 1227 1410 1.208 1.134
Irteral Upper 1525 1.502 1635 1.346 1.256
Hypothesiz Test Test Walue 1.3 1.3 1.3 13 1.3
t 11591 887 4201 -0z -3.645
df 15 15 15 15 15
Sig. 282 334 0 4593 002
Untveightect Count 168 179 202 205 220

The ratios table is now pivoted so that statistics are easier to compare across counties.

®  The ratio estimates range from a low of 1.195 in the Southern county to a high of 1.524 in
the Western county.

m  There is also quite a bit of variability in the standard errors, which range from a low of 0.029
in the Southern county to 0.068 in the Eastern county.
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®  Some of the confidence intervals do not overlap; thus, you can conclude that the ratios for the
Western county are higher than the ratios for the Northern and Southern counties.

®  Finally, as a more objective measure, note that the significance values of the 7 tests for the
Western and Southern counties are less than 0.05. Thus, you can conclude that the ratio for
the Western county is greater than 1.3 and the ratio for the Southern county is less than 1.3.

Summary

Using the Complex Samples Ratios procedure, you have obtained various statistics for the ratios
of Current value to Value at last appraisal. The results suggest that there may be certain inequities
in the assessment of property taxes from county to county, namely:

m  The ratios for the Western county are high, indicating that their records are not as up-to-date

as other counties with respect to the appreciation of property values. Property taxes are
probably too low in this county.

m  The ratios for the Southern county are low, indicating that their records are more up-to-date

than the other counties with respect to the appreciation of property values. Property taxes are
probably too high in this county.

®  The ratios for the Southern county are lower than those of the Western county but are still
within the objective goal of 1.3.

Resources used to track property values in the Southern county will be reassigned to the Western
county to bring these counties’ ratios in line with the others and with the goal of 1.3.

Related Procedures

The Complex Samples Ratios procedure is a useful tool for obtaining univariate descriptive
statistics of the ratio of scale measures for observations obtained via a complex sampling design.

m  The Complex Samples Sampling Wizard is used to specify complex sampling design
specifications and obtain a sample. The sampling plan file created by the Sampling Wizard
contains a default analysis plan and can be specified in the Plan dialog box when you are
analyzing the sample obtained according to that plan.

m  The Complex Samples Analysis Preparation Wizard is used to set analysis specifications for
an existing complex sample. The analysis plan file created by the Sampling Wizard can be
specified in the Plan dialog box when you are analyzing the sample corresponding to that plan.

m  The Complex Samples Descriptives procedure provides descriptive statistics for scale
variables.
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Complex Samples General Linear
Model

The Complex Samples General Linear Model (CSGLM) procedure performs linear regression
analysis, as well as analysis of variance and covariance, for samples drawn by complex sampling
methods. Optionally, you can request analyses for a subpopulation.

Using Complex Samples General Linear Model to Fit a Two-Factor
ANOVA

A grocery store chain surveyed a set of customers concerning their purchasing habits, according to
a complex design. Given the survey results and how much each customer spent in the previous
month, the store wants to see if the frequency with which customers shop is related to the amount
they spend in a month, controlling for the gender of the customer and incorporating the sampling
design.

This information is collected in grocery Imonth_sample.sav. For more information, see the
topic Sample Files in Appendix A in /BM SPSS Complex Samples 19. Use the Complex Samples
General Linear Model procedure to perform a two-factor (or two-way) ANOVA on the amounts
spent.

Running the Analysis

» To run a Complex Samples General Linear Model analysis, from the menus choose:
Analyze > Complex Samples > General Linear Model...

© Copyright SPSS Inc. 1989, 2010 176
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Figure 19-1
Complex Samples Plan dialog box

H Complex Samples Plan for General Linear Model

rPlan

If yiou do nat have a plan file for your complex sathple, you can
use the &nalysis Preparation Wizard to creste one. Choose

the wizard.

File: |grocer'f csplan | W

Prepare for Analysis from the Complex Samples menu to access

it Prokakilitie:

Joint probakilties are reguired if the plan requests unequal
probability VWWOR estimation. Ctherwize, they are ignored.

@ Use default file  rhased on name of plan file)
© an open dataset

grocery_1month_sample sav [DataSetd]

© Custom file

File: Erowwse...

(comene) _cance ) (_ep J

Complex Samples General Linear Model

» Browse to and select grocery.csplan. For more information, see the topic Sample Files in

>

Appendix A in IBM SPSS Complex Samples 19.

Click Continue.
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Figure 19-2
General Linear Model dialog box

E Complex Samples General Linear Model

& Store ID [storeid]
& Hesith food store [kithi ..

a) Store organization [org]

& Customer ID [custid]

&) W egetatian [veg] Covaristes:
a) Shopping style [style] B
& Incluzion (Selection) Pr...
y Cumulative Sampling W, L2
& Cumulative Sampling W

Subpopulation

Yariahle:
|

Categary:

(Lot ) (esse ) (pesat ] (cancel ) (Loew )

Wariables: Dependent Variable: m
) st ] | sdtes.. |
Factors:
d Size of store [size] N W
&) ‘Wwho shopping for [sho...
L&) Uze coupons [usecoug] | W
& Mumber of customers [

» Select Amount spent as the dependent variable.
» Select Who shopping for and Use coupons as factors.

» Click Model.



179

Complex Samples General Linear Model

Figure 19-3
Model dialog box

E Complex Samples General Linear Model: Model E-

—Specity Model Effect:

© Main effects @® Custam
Factors & Covaristes: hadel:
M shopfor shopfor Q
M usecoup LISECOUR
Ishopfor*usecoup | +*

Build Termi=)

Type:

2

Mested Term

Term: |

Irteraction Mesting Al ta bode! Clear

rIrtercept

E Inglude in model
[+ Display statistics

(contnue) _cancet J[_riep )

Choose to build a Custom model.

Select Main effects as the type of term to build and select shopfor and usecoup as model terms.

Select Interaction as the type of term to build and add the shopfor*usecoup interaction as a model
term.

Click Continue.

Click Statistics in the General Linear Model dialog box.
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Figure 194
General Linear Model Statistics dialog box

H Complex Samples General Linear Model: Statistics

tdadel Parameter

m Estimate |:| Covariances of parameter estimates
IE Standard errar |:| Correlations of parameter estimates
[ confidence interval [ Design etfect

|:| ttest |:| Sguare root of design effect

[+ Moced Fit
E Population means of dependent variable and covaristes

m Sample design information

[Cormnue” Cancel ” Helg ]

» Select Estimate, Standard error, Confidence interval, and Design effect in the Model Parameters
group.

» Click Continue.

» Click Estimated Means in the General Linear Model dialog box.

Figure 19-5
General Linear Model Estimated Means dialog box

H Complex Samples General Linear Model: Estimated Means
Factors and Interactions: Display Means Fat:
shopfor Term |Cnntrast Reference Category |
USECoup shopfor Simple 3
shopfor*usecaup Lsecoup Simple =
shopfortusecoup Mone 1 Mo

2 From nevvspaper
3 From mailings
4 From both

|:| Cizplay mean for overall populstion

[Continue” Cancel ” Help ]

» Choose to display means for shopfor, usecoup, and the shopfor*usecoup interaction.
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Select a Simple contrast and 3 Self and family as the reference category for shopfor. Note that, once
selected, the category appears as “3” in the dialog box.

Select a Simple contrast and 1 No as the reference category for usecoup.
Click Continue.

Click OK in the General Linear Model dialog box.

Model Summary

Figure 19-6
R-square statistic

|RSquare | B01 |

a. Model Amourt spert = (Intercept) +
shopfor + usecoup + shopfor * uzecoup

R-square, the coefficient of determination, is a measure of the strength of the model fit. It shows
that about 60% of the variation in Amount spent is explained by the model, which gives you
good explanatory ability. You may still want to add other predictors to the model to further
improve the fit.

Tests of Model Effects

Figure 19-7

Tests of between-subjects effects
Source df1 of2 Wald F Sig.
(Corrected Model) 11.000 3.000 127 23 o
(Intercept) 1.000 13.000 E321.597 oo
shopfor 2.000 12.000 643593 oo
usecoup 3.000 14.000 87453 oo
zhopfor * usecoup £.000 5.000 10635 0oz

a. hodel Amount spernt = (Intercept) + shopfar + usecaup + shopfar *
USECOLP

Each term in the model, plus the model as a whole, is tested for whether the value of its effect
equals 0. Terms with significance values of less than 0.05 have some discernible effect. Thus, all
model terms contribute to the model.
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Parameter Estimates
Figure 19-8
Parameter estimates
95% Confidence
Stel. Initeryal Design

Parameter Estimate Error Lot Upper Effect
[Irtercept) 218248 | 1173 (492805 | 543092 1.387
[shopfar=1] 174757 | 10762 1950 | -151.51 850
[shopfar=2] 129443 | 11455 -1542 | 10470 925
[zhopfor=3] oood . . . .
[uzecoup=1] -140835 | 10180 1628 | 115855 B4
[uzecoup=2] -G3026 | 13193 | -91.53 | -34.520 340
[uzecoup=3] -31 375 Q726 | -52.387 | 10365 564
[uzecoup=4] non2 . . . .
[shopfor=1] * [usecoup=1] 41885 | 11470 17 562 65524 BOE
[shopfor=1] * [usecoup=2] 44505 | 18.068 547 83539 1.413
[zhopfor=1] * [usecoup=3] 9204 | 11.057 | -14.654 J3.092 294
[zhopfor=1] * [usecoup=4] non2 . . . .
[zhopfor=2] * [usecoup=1] 9.211 10967 62215 | 112903 533
[shopfor=2] * [usecoup=2] 54267 | 14848 2872 86 562 836
[shopfor=2] * [usecoup=3] 178584 | 13753 | -11.828 47 595 797
[shopfor=2] * [usecoup=4] oooa

[zhopfor=3] * [usecoup=1] ooo@

[zhopfor=3] * [usecoup=2] 0oo3

[shopfar=3] * [usecoup=3] oao@

[zhopfor=3] * [usecoup=4] 0oo3

a. Set to zero because this parameter is redundant.

b. Model, Amount spent = (Intercept) + shopfor + usecoup + shopfor * uzecoup

The parameter estimates show the effect of each predictor on Amount spent. The value of 518.249
for the intercept term indicates that the grocery chain can expect a shopper with a family who uses
coupons from the newspaper and targeted mailings to spend $518.25, on average. You can tell
that the intercept is associated with these factor levels because those are the factor levels whose
parameters are redundant.

B The shopfor coefficients suggest that among customers who use both mailed coupons and
newspaper coupons, those without family tend to spend less than those with spouses, who in
turn spend less than those with dependents at home. Since the tests of model effects showed
that this term contributes to the model, these differences are not due to chance.

B The usecoup coefficients suggest that spending among customers with dependents at home
decreases with decreased coupon usage. There is a moderate amount of uncertainty in the
estimates, but the confidence intervals do not include 0.

m  The interaction coefficients suggest that customers who do not use coupons or only clip from
the newspaper and do not have dependents tend to spend more than you would otherwise
expect. If any portion of an interaction parameter is redundant, the interaction parameter is
redundant.

m  The deviation in the values of the design effects from 1 indicate that some of the standard
errors computed for these parameter estimates are larger than those you would obtain if you
assumed that these observations came from a simple random sample, while others are smaller.
It is vitally important to incorporate the sampling design information in your analysis because
you might otherwise infer, for example, that the usecoup=3 coefficient is not different from 0!
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The parameter estimates are useful for quantifying the effect of each model term, but the estimated
marginal means tables can make it easier to interpret the model results.

Estimated Marginal Means

Figure 19-9
Estimated marginal means by levels of Who shopping for

95% Conficence Interval
Whio shopping for Mean Std. Error Loswer Upper
Self 3085326 394236 3000145 3170506
Self and spouse 370.3361 487903 359.7955 3808767
Self and family 4594392 719769 443 8595 474 9355

This table displays the model-estimated marginal means and standard errors of Amount spent at
the factor levels of Who shopping for. This table is useful for exploring the differences between
the levels of this factor. In this example, a customer who shops for him- or herself is expected
to spend about $308.53, while a customer with a spouse is expected to spend $370.34, and a
customer with dependents will spend $459.44. To see whether this represents a real difference or
is due to chance variation, look at the test results.

Figure 19-10
Individual test results for estimated marginal means of gender
Difference
Who shopping for Contrast Hypothesized [Estimate - Std.
Simple Cartrast” Estimate “alue Hypothesized) Error o1 df2 ‘Wiald F Sig.

Level Self vs. Level
Self and family
Level Self and

spouse vs. Level -89.103 000 -39103 | 5903 | 1000 | 1300 | 22754 i}
Self and family

-150.807 i} -150.907 4803 | 1000 | 1300 | 9474 000

a. Reference Category = Self and family

The individual tests table displays two simple contrasts in spending.
B The contrast estimate is the difference in spending for the listed levels of Who shopping for.
m  The hypothesized value of 0.00 represents the belief that there is no difference in spending.

m  The Wald F statistic, with the displayed degrees of freedom, is used to test whether the
difference between a contrast estimate and hypothesized value is due to chance variation.

m  Since the significance values are less than 0.05, you can conclude that there are differences in
spending.

The values of the contrast estimates are different from the parameter estimates. This is because
there is an interaction term containing the Who shopping for effect. As a result, the parameter
estimate for shopfor=1 is a simple contrast between the levels Self and Self and Family at the
level From both of the variable Use coupons. The contrast estimate in this table is averaged over
the levels of Use coupons.
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Figure 19-1
Overall test results for estimated marginal means of gender
df1 dfz ald F =ig.
2.000 12.000 E43.593 oo

The overall test table reports the results of a test of all of the contrasts in the individual test table.
Its significance value of less than 0.05 confirms that there is a difference in spending among the
levels of Who shopping for.

Figure 19-12
Estimated marginal means by levels of shopping style

95% Confidence Interval
Uze coupons Mean Sted. Errar Lawer Upper
Mo 319.6455 £.51429 3055722 3337188
From nevwspaper 386.7469 432295 3T AO0TT 396.0361
From mailings 3945025 554218 3525297 405.4760
From bath 416.5486 §.51260 402.7790 43081582

This table displays the model-estimated marginal means and standard errors of Amount spent at
the factor levels of Use coupons. This table is useful for exploring the differences between the
levels of this factor. In this example, a customer who does not use coupons is expected to spend
about $319.65, and those who do use coupons are expected to spend considerably more.

Figure 19-13
Individual test results for estimated marginal means of shopping style
Difference
Use coupons Contrast Hypothesized [Estimate - Sid.
Simple Cortrast” Estimate Walue Hypothesized) Error i1 df2 Wl F =ig.
Lewel Fram
NEWSPRREr VS, E7.A01 Luuin} E701 5537 1.000 |13.000 | 10535 ulula]
Lewvel Mo
Lewel From
mailings ws. Level 74857 Jalula] 74857 | 5875 | 1.000 13000 | 16233 oo
Mo
Lewvel From hath
vs Level Mo 97 203 oo 97 203 5603 1.000 |13.000 | 30092 ulula]

a. Reference Category = Mo

The individual tests table displays three simple contrasts, comparing the spending of customers
who do not use coupons to those who do.

Since the significance values of the tests are less than 0.05, you can conclude that customers
who use coupons tend to spend more than those who don’t.

Figure 19-14
Overall test results for estimated marginal means of shopping style
df1 di2 Wil F Sig.
3000 11.000 7 453 0o

The overall test table reports the results of a test of all the contrasts in the individual test table. Its
significance value of less than 0.05 confirms that there is a difference in spending among the levels
of Use coupons. Note that the overall tests for Use coupons and Who shopping for are equivalent

to the tests of model effects because the hypothesized contrast values are equal to 0.
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Figure 19-15
Estimated marginal means by levels of gender by shopping style

95% Confidence Interval
Who shopping for  Use coupons Mean St Errar Lawer Upper
Self Rlo 244 3471 £.00949 231 3644 257.3298
From nevespaper 3249708 594134 321353 3378063
From mailings 321 3207 411028 324410 3302005
Fram both 3434916 657843 3292797 Fa7.7034
Self and spouse [{a] 337A7E3 7A213 321.7925 352.5640
Fram nevvspaper 380.0468 791038 362.9574 3971361
Fram mailings IS4 £.22468 361 8665 3807617
Fram both 3556054 7A210 3734214 4041594
Self and family [§a] 3TN 1158215 392.53594 4024328
From newvspaper 4552232 £.14420 441 9494 4634969
Fram mailings 4865736 10.76529 463 B16E 5101306
Fram both 518.2488 11.73120 4929050 543.5925

This table displays the model-estimated marginal means, standard errors, and confidence intervals
of Amount spent at the factor combinations of Who shopping for and Use coupons. This table

is useful for exploring the interaction effect between these two factors that was found in the

tests of model effects.

Summary

In this example, the estimated marginal means revealed differences in spending between customers
at varying levels of Who shopping for and Use coupons. The tests of model effects confirmed this,
as well as the fact that there appears to be a Who shopping for*Use coupons interaction effect.
The model summary table revealed that the present model explains somewhat more than half of
the variation in the data and could likely be improved by adding more predictors.

Related Procedures

The Complex Samples General Linear Model procedure is a useful tool for modeling a scale
variable when the cases have been drawn according to a complex sampling scheme.

B  The Complex Samples Sampling Wizard is used to specify complex sampling design
specifications and obtain a sample. The sampling plan file created by the Sampling Wizard
contains a default analysis plan and can be specified in the Plan dialog box when you are
analyzing the sample obtained according to that plan.

m  The Complex Samples Analysis Preparation Wizard is used to specify analysis specifications
for an existing complex sample. The analysis plan file created by the Sampling Wizard can be
specified in the Plan dialog box when you are analyzing the sample corresponding to that plan.

m  The Complex Samples Logistic Regression procedure allows you to model a categorical
response.

m  The Complex Samples Ordinal Regression procedure allows you to model an ordinal response.



Chapter

Complex Samples Logistic Regression

The Complex Samples Logistic Regression procedure performs logistic regression analysis on
a binary or multinomial dependent variable for samples drawn by complex sampling methods.
Optionally, you can request analyses for a subpopulation.

Using Complex Samples Logistic Regression to Assess Credit Risk

If you are a loan officer at a bank, you want to be able to identify characteristics that are indicative
of people who are likely to default on loans and then use those characteristics to identify good
and bad credit risks.

Suppose that a loan officer has collected past records of customers given loans at
several different branches, according to a complex design. This information is contained in
bankloan_cs.sav. For more information, see the topic Sample Files in Appendix A in /BM SPSS
Complex Samples 19. The officer wants to see if the probability with which a customer defaults is
related to age, employment history, and amount of credit debt, incorporating the sampling design.

Running the Analysis

» To create the logistic regression model, from the menus choose:
Analyze > Complex Samples > Logistic Regression...

© Copyright SPSS Inc. 1989, 2010 186



187

Complex Samples Logistic Regression

Figure 20-1
Complex Samples Plan dialog box

H Complex Samples Plan for Logistic Regression m

rPlan

File: |bankloan.csaplan | W

If you do nat have a plan file for your complex sample, you
can uze the Analysis Preparation YWizard to create one.
Choose Prepare for Analysis from the Complex Samples
menu to access the wizard.

rdiirt Probskilitie:

Joint probakilties are reguired if the plan requests unegual
probability WOR estimation. Ctherwize, they are ignored.

® Use default file  hankloan sav)
O an open dataset
bankloan_cs sav [DataSets)]

© Custom file

File: Erowse...

(comrve) (cance J_ew )

» Browse to and select bankloan.csaplan. For more information, see the topic Sample Files in
Appendix A in IBM SPSS Complex Samples 19.

» Click Continue.
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Figure 20-2
Logistic Regression dialog box

E Complex Samples Logistic Regression W

Wariables: Cependent Yaristle: m
« |_£ Previously defautted [d... |

&) Eranch [branch]
f Mumber of customers [

& Custoner D custone] (peteroms atspre)  (pppanesi o)
{I Level of educstion [ed] E

Covaristes:

& Age in years [age]
f “ears with current ...
f Years at current ad...

& Househaold income ... [&
~

Subpopulation

Yariahle:
|

Category:

i) (ot et (o) i)

Select Previously defaulted as the dependent variable.

»

» Select Level of education as a factor.

» Select Age in years through Other debt in thousands as covariates.
>

Select Previously defaulted and click Reference Category.
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>

>

» Click Statistics in the Logistic Regression dialog box.

Figure 20-3

Logistic Regression Reference Category dialog box

H Complex Samples Logistic Regression: Reference Category

rReference Categary
Highest value
@ Lowest value
Custom

[Cormnue” Cancel ” Help ]

Select Lowest value as the reference category.

Complex Samples Logistic Regression

This sets the “did not default” category as the reference category; thus, the odds ratios reported in
the output will have the property that increasing odds ratios correspond to increasing probability

of default.

Click Continue.

Figure 20-4
Logistic Regression Statistics dialog box

H Complex Samples Logistic Regression: Statistics

rhlociel Fit

[ Pseudo R-square
[&! Classitication table

rParameter:

m Expanertisted estimate |:| Carrelations of paratneter estimates
E Standard error E Cesign effect
[ confidence interval ] Square roct of design effect

[ t-test

E Estimate |:| Covariances of parameter estimates

m Suminary statistics for model variables

m Sample design infarmation

|§Corﬂinue§” Ccancel ” Hzlp ]

Select Classification table in the Model Fit group

Click Continue.

Click Odds Ratios in the Logistic Regression dialog box.

Select Estimate, Exponentiated estimate, Standard error, Confidence interval, and Design effect in
the Parameters group.
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Figure 20-5
Logistic Regression Odds Ratios dialog box
H Complex Samples Logistic Regression: Odds Ratios
Factars: Oddz Retios for Comparing Factor Levels:
d:' Level of education [ed] Factor |Reference Cateq... |
Lewvel of education [... (Highest value)

Covariates: Oddz Retios for Change in Covariate Values:

g& Household income ... %

& Debt to income ratio...
R b

Covariate |units of Change |
YWears with curren... 1 |§|

Dbt to incothe rati... 1

One set of odds ratios is produced for each variable in the Odds Ratios grids. For
each set, all other factors in the model are evaluated at their highest levels; all other
covariates are evaluated at their means.

[ Cancel ][ Help ]

» Choose to create odds ratios for the factor ed and the covariates employ and debtinc.
» Click Continue.

» Click OK in the Logistic Regression dialog box.

Pseudo R-Squares

Figure 20-6

Pseudo R-square statistics
Cox and Snell 330
Magelkerke 451
McFadden S04

Dependent Yariahle: Previously defaulted (reference category = Mo)
Model: (Irtercept), ed, age, employ, address | incame, dektine,
creddebt, othcebt

In the linear regression model, the coefficient of determination, R2, summarizes the proportion of
variance in the dependent variable associated with the predictor (independent) variables, with
larger R? values indicating that more of the variation is explained by the model, to a maximum
of 1. For regression models with a categorical dependent variable, it is not possible to compute

a single R? statistic that has all of the characteristics of R2 in the linear regression model, so
these approximations are computed instead. The following methods are used to estimate the
coefficient of determination.

m  Cox and Snell’s R2 (Cox and Snell, 1989) is based on the log likelihood for the model
compared to the log likelihood for a baseline model. However, with categorical outcomes, it
has a theoretical maximum value of less than 1, even for a “perfect” model.

m  Nagelkerke’s R2 (Nagelkerke, 1991) is an adjusted version of the Cox & Snell R-square that
adjusts the scale of the statistic to cover the full range from 0 to 1.

®m  McFadden’s R?2 (McFadden, 1974) is another version, based on the log-likelihood kernels for
the intercept-only model and the full estimated model.
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What constitutes a “good” R? value varies between different areas of application. While these
statistics can be suggestive on their own, they are most useful when comparing competing models
for the same data. The model with the largest R? statistic is “best” according to this measure.

Classification
Figure 20-7
Classification table
Predicted

Ohserved Mo es Percent Correct
[Wla] 185289 BEY 31ET1.267 §5.5%
Yes 45970 600 TIETS135 E0.9%
Crverall Percert B8 .5% 31.5% TE.5%

Dependent Yariahle: Previously defaulted (reference category = MNa)
Model: (Intercept), ed, age, employ, address, income, debtine,
creddebt, athdekt

The classification table shows the practical results of using the logistic regression model. For each
case, the predicted response is Yes if that case’s model-predicted logit is greater than 0. Cases are
weighted by finalweight, so that the classification table reports the expected model performance in
the population.

m  Cells on the diagonal are correct predictions.

m  Cells off the diagonal are incorrect predictions.

Based upon the cases used to create the model, you can expect to correctly classify 85.5% of the
nondefaulters in the population using this model. Likewise, you can expect to correctly classify
60.9% of the defaulters. Overall, you can expect to classify 76.5% of the cases correctly; however,
because this table was constructed with the cases used to create the model, these estimates are
likely to be overly optimistic.

Tests of Model Effects

Figure 20-8

Tests of between-subjects effects
Source o1 di2 Wiald F Sig.
(Corrected Madel) 11,000 4000 14 GEA mo
(Irtercept) 1000 14.000 5777 03
ed 4000 11.000 1 E83 224
age 1.000 14.000 5352 036
employ 1.000 14.000 55.244 oo
address 1000 14.000 1123 307
income 1,000 14.000 o7 932
dekbtinc 1.000 14.000 2T B32 oo
creddebt 1.000 14.000 33.402 oo
atholekt 1,000 14,000 709 A4

Dependent Yariahle: Previously defaulted (reference category = Mo
Maodel: (Irtercept), ed, age, employ, address | income, debtine, creddebt,
athclebt
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Each term in the model, plus the model as a whole, is tested for whether its effect equals 0. Terms
with significance values less than 0.05 have some discernible effect. Thus, age, employ, debtinc,

and creddebt contribute to the model, while the other main effects do not. In a further analysis of
the data, you would probably remove ed, address, income, and othdebt from model consideration.

Parameter Estimates

Figure 20-9
Parameter estimates

95% Confidence
95% Confidence Interwval for

PrevioLsly Stal. Irer sl Design Exp(E)
defaulted Parameter B Error Lowver Upper Eifect Exp(B) | Lower Upper
Yes (Intercept) -1.140 399 | 1895 -.284 EES 320 A36 753
[ed=1] 720 340 =010 1.4439 ae2 2054 850 4.258
[d=2] =2 371 =112 1431 1.247 1.983 ==L 4397
[Ec=3] A18 307 =140 11477 /3 1679 8649 3.244
[ed=4] 789 302 142 1437 E=ik 2202 1152 4.208
[ed=5] oo . . . . 1.000 . .
age =023 oo -043 -0z MG 878 458 893
employ =225 024 =277 =174 1.200 798 .7a8 G40
address -025 nze - 055 nza L= a7z 818 1.029
income ulun} o3 -.ooy no& 1410 1.000 883 1.006
debtine nas o 06 A34 1222 1.100 1.058 1.143
creddebt 493 085 30 ETE 1373 1637 1.363 1.966
othdebt 26 03 -0 94 1219 1.027 860 1.098

Dependent Yariahle: Previously defaulted (reference category = Mo
Model: (Intercept], ed, age, employ, address, income, debting, creddebt, othdett

a. Zet to zero because thiz parameter is redundant.

The parameter estimates table summarizes the effect of each predictor. Note that parameter values
affect the likelihood of the “did default” category relative to the “did not default” category. Thus,
parameters with positive coefficients increase the likelihood of default, while parameters with
negative coefficients decrease the likelihood of default.

The meaning of a logistic regression coefficient is not as straightforward as that of a linear
regression coefficient. While B is convenient for testing the model effects, Exp(B) is easier to
interpret. Exp(B) represents the ratio change in the odds of the event of interest attributable to a
one-unit increase in the predictor for predictors that are not part of interaction terms. For example,
Exp(B) for employ is equal to 0.798, which means that the odds of default for people who have
been with their current employer for two years are 0.798 times the odds of default for those who
have been with their current employer for one year, all other things being equal.

The design effects indicate that some of the standard errors computed for these parameter
estimates are larger than those you would obtain if you assumed that these observations came
from a simple random sample, while others are smaller. It is vitally important to incorporate the
sampling design information in your analysis because you might otherwise infer, for example,
that the age coefficient is no different from 0!
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Odds Ratios

Figure 20-10
Odds ratios for level of education

95% Confidence
PresiaLisly Irteryal
defautted Oddds Ratio Liowyer Upper
Lewvel of Didl nat complete high Yes
Felvestan ﬁggojln\;se.rgraduate 2054 430 4259
degres
High school degree ws. Wes 1.883 894 4,397
Some college ws. Yes 1679 JBE9 2244
College degree vs. Yes 2.202 1.152 4205

Dependent “Yariable: Previously defaulted (reference category = Mol
Model: (Intercept), ed, age, employ, address | income, debtine, creddebt, athodett

&. Factors and covaristes used in the computstion are fixed at the following values:
Level of educstion=Post-undergraduate degree; Age in years=34.19; Years with
current employer=6.99; Years at current address=6.32, Houzehold income in
thousands=60.1551; Deht to incame ratio (x100)=9.9341; Credit card debt in
thousands=1.9764; Cther dekt in thousands=3 9164

This table displays the odds ratios of Previously defaulted at the factor levels of Level of
education. The reported values are the ratios of the odds of default for Did not complete high
school through College degree, compared to the odds of default for Post-undergraduate degree.
Thus, the odds ratio of 2.054 in the first row of the table means that the odds of default for a
person who did not complete high school are 2.054 times the odds of default for a person who has
a post-undergraduate degree.

Figure 20-11
Odds ratios for years with current employer
95% Confidence
Irterval
Previously
Units of Change defaulted Odds Ratio | Lower Upper
Years with current employer 1.000 | Yes a8 Ja8 G40

Dependent Yariahle: Previously defautted (reference category = Mo)
Model: (Intercept), ed, age, employ, address, income, debtine, creddebt, othdekt
a. Factors and covaristes used in the computstion are fixed at the following values:
Level of education=Post-undergraduate degrees; Age in years=3419; Years with
current employer=6.99 Years at current address=6.32, Houzehold income in
thousands=60.1551; Deht to incame ratio (x100)=9.9341; Credit card debt in
thousands=1.9764; Cther debt in thousands=3 9164

This table displays the odds ratio of Previously defaulted for a unit change in the covariate Years
with current employer. The reported value is the ratio of the odds of default for a person with 7.99
years at their current job compared to the odds of default for a person with 6.99 years (the mean).

Figure 20-12
Odds ratios for debt to income ratio
3% Confidence
Previously Irtessal
Units of Changs defautted Odlds Ratio Lot Upper
Dbt to income ratio (1000 1.000 | Yes 1100 1.058 1.143

Dependent Yariahle: Previously defaulted (reference category = Ma)
Model: (Irtercept), ed, age, employ, address, income, debting, creddebt, athdebt

8. Factors and covaristes used in the computation are fixed at the following values:
Lewvel of education=Post-undergraduate degree; Age in years=354.19; Years with
current employer=6.993; Years at current address=6.32; Househald income in
thousands=60.1581; Debt to income ratio (1001=2.9341; Credit card debt in
thousands=1 9764 Cther debkt in thousands=5.9164
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This table displays the odds ratio of Previously defaulted for a unit change in the covariate Debt to
income ratio. The reported value is the ratio of the odds of default for a person with a debt/income
ratio of 10.9341 compared to the odds of default for a person with 9.9341 (the mean).

Note that because none of these predictors are part of interaction terms, the values of the odds
ratios reported in these tables are equal to the values of the exponentiated parameter estimates.
When a predictor is part of an interaction term, its odds ratio as reported in these tables will also
depend on the values of the other predictors that make up the interaction.

Summary

Using the Complex Samples Logistic Regression Procedure, you have constructed a model for
predicting the probability that a given customer will default on a loan.

A critical issue for loan officers is the cost of Type I and Type II errors. That is, what is
the cost of classifying a defaulter as a nondefaulter (Type I)? What is the cost of classifying a
nondefaulter as a defaulter (Type II)? If bad debt is the primary concern, then you want to lower
your Type I error and maximize your sensitivity. If growing your customer base is the priority,
then you want to lower your Type II error and maximize your specificity. Usually, both are
major concerns, so you have to choose a decision rule for classifying customers that gives the
best mix of sensitivity and specificity.

Related Procedures

The Complex Samples Logistic Regression procedure is a useful tool for modeling a categorical

variable when the cases have been drawn according to a complex sampling scheme.

m  The Complex Samples Sampling Wizard is used to specify complex sampling design
specifications and obtain a sample. The sampling plan file created by the Sampling Wizard
contains a default analysis plan and can be specified in the Plan dialog box when you are
analyzing the sample obtained according to that plan.

m  The Complex Samples Analysis Preparation Wizard is used to specify analysis specifications
for an existing complex sample. The analysis plan file created by the Sampling Wizard can be
specified in the Plan dialog box when you are analyzing the sample corresponding to that plan.

m  The Complex Samples General Linear Model procedure allows you to model a scale response.

®  The Complex Samples Ordinal Regression procedure allows you to model an ordinal response.
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The Complex Samples Ordinal Regression procedure creates a predictive model for an ordinal
dependent variable for samples drawn by complex sampling methods. Optionally, you can request
analyses for a subpopulation.

Using Complex Samples Ordinal Regression to Analyze Survey Results

Representatives considering a bill before the legislature are interested in whether there is public
support for the bill and how support for the bill is related to voter demographics. Pollsters design
and conduct interviews according to a complex sampling design.

The survey results are collected in poll_cs_sample.sav. The sampling plan used by the pollsters
is contained in poll.csplan; because it makes use of a probability-proportional-to-size (PPS)
method, there is also a file containing the joint selection probabilities (poll_jointprob.sav). For
more information, see the topic Sample Files in Appendix A in /BM SPSS Complex Samples 19.
Use Complex Samples Ordinal Regression to fit a model for the level of support for the bill based
upon voter demographics.

Running the Analysis

» To run a Complex Samples Ordinal Regression analysis, from the menus choose:
Analyze > Complex Samples > Ordinal Regression...

© Copyright SPSS Inc. 1989, 2010 195
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Figure 21-1
Complex Samples Plan dialog box

H Complex Samples Plan for Ordinal Regression m

rPlan

File: |po||.csplan | Browse

If wiou do not have & plan file far your complex sample, you
can use the Analysis Preparation Wizard to create one.
Choose Prepare for &Analysis from the Complex Samples menu
to access the wizard.

rdaint Probakbilties

Joint probabilities are required if the plan requests unegual
probability WOR estimation. Ctherwise, they are ignored.

@ Use defautt fle  (C\Program Files\SPSSNcPAS.. ool sav)
@ an open datazet

poll_cs_sample.sav [DataSet?]

@ Custom file

File: |poIIJointprob sav | M
(contrue | carcat |||

» Browse to and select poll.csplan as the plan file. For more information, see the topic Sample Files
in Appendix A in /IBM SPSS Complex Samples 19.

» Select poll _jointprob.sav as the joint probabilities file.

» Click Continue.
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Figure 21-2
Ordinal Regression dialog box

E Complex Samples Ordinal Regression ﬂ

Wariables: i Cependent Yaristle: m

&b Voter ID [voteid] [ The legistature should e...
& Meighborhood [nbrhood]
&) Toswniship [town]

&) County [county] Factors: m
& Incluzion (Selection) Pr... il Age category [auecst]

& cumulstive Sampling W & Gender [wender] E
& Cumulstive Sampling ... i & woted in last election [v... @

il Drriving freguency [driv...

Covaristes:

Link Function:
Lowyit YJ

Subpopulation

Watiahle:
|

Categary:

» Select The legislature should enact a gas tax as the dependent variable.
» Select Age category through Driving frequency as factors.

» Click Statistics.
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Figure 21-3
Ordinal Regression Statistics dialog box

H Complex Samples Ordinal Regression: Statistics

rhocel Fit

m Pzeuda R-square
[ Classification table

rParatmeters
[ Estimate [7] covatiances of parameter estimates
m Exponentisted ectimate |:| Cotrelations of parameter estimstes
[ Standard error [« Design effect
m Confidence interval |:| Square root of design effect
[T t-test

rParallel Lines

E Wald test of equal slopes

E Parameter estimates for generalized (unequal slopes) model

|:| Covariances of parameter estimates for generalized (unequal slopes) model

IE Summary statistics for model variables
i Sample design infarmation

|§Continue§” Cancel ” Help ]

» Select Classification table in the Model Fit group.

» Seclect Estimate, Exponentiated estimate, Standard error, Confidence interval, and Design effect in
the Parameters group.

» Select Wald test of equal slopes and Parameter estimates for generalized (unequal slopes) model.
» Click Continue.

» Click Hypothesis Tests in the Complex Samples Ordinal Regression dialog box.
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Figure 21-4
Hypothesis Tests dialog box

H Complex Samples Ordinal Regression: Hypothesis Tests

Test Statistic ———— Sampling Degrees of Freedom
FE @ Eased an sample design
® Adjusted F Fixed

Chi-zquare
Adjusted Chi-sguare

& diustment for Multiple Comparisons
Least significant difference

@) sequertial Sidak

Seguential Bonferroni

Sidak

Eonferroni

|C i e” Cancel ” Help ]

Even for a moderate number of predictors and response categories, the Wald F test statistic can
be inestimable for the test of parallel lines.

Select Adjusted F in the Test Statistic group.
Select Sequential Sidak as the adjustment method for multiple comparisons.
Click Continue.

Click Odds Ratios in the Complex Samples Ordinal Regression dialog box.

Figure 21-5
Ordinal Regression Odds Ratios dialog box

3] Complex Samples Ordinal Regression: Odds Ratios

Factars: Cumulative Qdds Ratios for Comparing Factor Lewvels:

@0 'S0 [GenieT | = Factor |Reference Category |
& Voted in last electio... Age category [agecat]  (Highest value)
- b

d:l Driving frequency [... Driving frequency [drive... 10-14 939 mileshear

Covariates: Cumulative Odds Ratios for Change in Covariste Walues:
Covariate |units of Change [
+

one zet of cumulative odds ratios iz produced for each variable inthe Odds Ratios grids. For
each =et, all ather factors in the model are evalusted at their highest levels; all other covariates
are evaluated st their means.

|Cont|nue” Cancel ” Help ]

Choose to produce cumulative odds ratios for Age category and Driving frequency.

Select 10-14,999 miles/year, a more “typical” yearly mileage than the maximum, as the reference
category for Driving frequency.

Click Continue.
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» Click OK in the Complex Samples Ordinal Regression dialog box.

Pseudo R-Squares

Figure 21-6
Pseudo R-Squares

Cox and Snell Ava
Magelkerke Rk
hicFadden Lyl

Dependent Yariakle: The legislature should enact a gas tax (Ascending)
Model: (Threshold), agecat, gender, votelast, drivefreq
Link function: Logit

In the linear regression model, the coefficient of determination, R2, summarizes the proportion of
variance in the dependent variable associated with the predictor (independent) variables, with
larger R2 values indicating that more of the variation is explained by the model, to a maximum
of 1. For regression models with a categorical dependent variable, it is not possible to compute

a single R? statistic that has all of the characteristics of R2 in the linear regression model, so
these approximations are computed instead. The following methods are used to estimate the
coefficient of determination.

m  Cox and Snell’s R2? (Cox and Snell, 1989) is based on the log likelihood for the model

compared to the log likelihood for a baseline model. However, with categorical outcomes, it
has a theoretical maximum value of less than 1, even for a “perfect” model.

m  Nagelkerke’s R2 (Nagelkerke, 1991) is an adjusted version of the Cox & Snell R-square that
adjusts the scale of the statistic to cover the full range from 0 to 1.

®m  McFadden’s R2 (McFadden, 1974) is another version, based on the log-likelihood kernels for
the intercept-only model and the full estimated model.

What constitutes a “good” R? value varies between different areas of application. While these
statistics can be suggestive on their own, they are most useful when comparing competing models
for the same data. The model with the largest R? statistic is “best” according to this measure.

Tests of Model Effects
Figure 21-7
Tests of model effects
Adjusted Seguential

Source df1 df2 Wzl F Sig. Sicak Sig.
agecat 2283 | 31966 B.215 04 003
gendsr 1000 | 14000 045 &34 834
watelast 1000 | 14000 076 a7 J87
drivefreq | 3785 | S2887 228015 00 oo

Dependent Yariable: The legiskature should enact a gas tax (Ascending)
Model: (Threshold), agecat, gender, votelast, drivefrey
Link function: Logit
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Each term in the model is tested for whether its effect equals 0. Terms with significance values
less than 0.05 have some discernable effect. Thus, agecat and drivefreq contribute to the model,
while the other main effects do not. In a further analysis of the data, you would consider removing
gender and votelast from the model.

Parameter Estimates

The parameter estimates table summarizes the effect of each predictor. While interpretation
of the coefficients in this model is difficult due to the nature of the link function, the signs of
the coefficients for covariates and relative values of the coefficients for factor levels can give
important insights into the effects of the predictors in the model.

m  For covariates, positive (negative) coefficients indicate positive (inverse) relationships
between predictors and outcome. An increasing value of a covariate with a positive coefficient
corresponds to an increasing probability of being in one of the “higher” cumulative outcome
categories.

m  For factors, a factor level with a greater coefficient indicates a greater probability of being in
one of the “higher” cumulative outcome categories. The sign of a coefficient for a factor level
is dependent upon that factor level’s effect relative to the reference category.

Figure 21-8
Parameter estimates

95% Confidence
93% Confidence Interwval faor
St Irterval Design Exp(E)
Parameter B Error Lot Upper Effect Exp(B) | Lower Upper
Threshold [opinion_gastax=1] -3.343 A04 | 3866 | -3420 1132 035 nzs 044
[opinion_gastax=2] -1.910 oge | -2420 | -1.700 1.058 148 A20 A8z
[opinion_gastax=3] -E74 .0s0 -.866 -482 815 A10 421 E18
Regrezsion  [agecat=1] -324 QiR -.494 -1594 1.793 J23 E10 858
[agecat=2] -135 054 -.285 -022 1158 &7 F75 878
[agecat=3] - 095 076 =257 &5 2206 Aa09 A3 1.070
[agecat=4] 000 . . . . 1.000 . .
[encer=0] - 005 035 -.054 &5 849 a9z 820 1.071
[gender=1] ooo@ . . . . 1.000 . .
[vatelast=0] =011 039 -.093 073 1103 259 09 1.076
[votelast=1] o3 . . . . 1.000 . .
[drivetfreng=1] -3.751 A53 -4.078 -3.423 1117 nz3 017 033
[drivefreg=2] -3.003 ME | -3.251 -2.758 1.226 =) nic:=] 064
[drivefreq=3] -2.295 114 -2.540 -2050 1.585 Aam .07e 128
[drivetfreng=4] -1.:570 082 -1.768 -1.372 1.073 208 AT 254
[drivefreg=5] -8z 089 | -1.003 -EM A4 Ad4 3ET £37
[drivefreg=a] non@ . . 1.000

Dependent Yariable: The legiskature should enact a gas tax (Ascending)
Model: (Threshold), agecat, gender, votelast, drivefreg
Link function: Logit

a. Zet to zero because this parameter is redundant.

You can make the following interpretations based on the parameter estimates:

m  Those in lower age categories show greater support for the bill than those in the highest age
category.
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B Those who drive less frequently show greater support for the bill than those who drive more
frequently.
m  The coefficients for the variables gender and votelast, in addition to not being statistically
significant, appear to be small compared to other coefficients.
The design effects indicate that some of the standard errors computed for these parameter
estimates are larger than those you would obtain if you used a simple random sample, while
others are smaller. It is vitally important to incorporate the sampling design information in your
analysis because you might otherwise infer, for example, that the coefficient for the third level
of Age category, [agecat=3], is significantly different from 0!
Classification
Figure 21-9
Categorical variable information
Weighted
Wizighted Court Percent
The legislature Strongly agree 25132955 2.3%
shouldenact s agree 32261 425 27 3%
gas ax Disagres 28477 47 24.9%
Strongly dizagres 3314203 26.5%
Age categary 158-30 20509 504 17.4%
31.45 35380.506 20.9%
45-60 34865792 29.5%
=50 27430.198 23.2%
Gencder Iale E1424 547 52.0%
Female SETE1 453 45.0%
“oted in last Mo TOBO7T 216 59.7%
election Yes 4757E T4 40.3%
Dorivvirg Do not owen car 43T A3Y 2.89%
frasuency =10,000 milesfyear 10516.349 9.2%
10-14,999 milestyear 32539.364 27 5%
15-19,399 milestyear 39179.814 33.2%
20-29,999 milesiear 25617 804 7%
==30,000 milesiyear Bo5E5 532 2.6%
Population Size 118186.000 100.0%

a. Dependent variable values are sorted in ascending order.

Given the observed data, the “null” model (that is, one without predictors) would classify all
customers into the modal group, Agree. Thus, the null model would be correct 27.3% of the time.
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Figure 21-10
Classification table
Predicted
Strangly Strangly Percert

Ohzerved agres Agree Dizagres dizsagres Correct
Strongly aoree TOEY 567 12130514 3575825 2055.750 28.1%
Aaree 4271.234 14464 236 7320767 6205137 44 5%
Dizagree 2024 516 11703.368 7105.457 8640.746 24.1%
Strongly dizagres 489.569 8169109 945,522 15305.703 45.9%
Crverall Percert 121% 39.3% 21 4% 27.3% IT2%

Dependent Yariable: The legisksture should enact 3 gas tax (Ascending)
Model: (Threshold), agecat, gender, votelast, drivefreg
Link function; Logit

The classification table shows the practical results of using the model. For each case, the predicted
response is the response category with the highest model-predicted probability. Cases are
weighted by Final Sampling Weight, so that the classification table reports the expected model
performance in the population.

m  Cells on the diagonal are correct predictions.

m  Cells off the diagonal are incorrect predictions.

The model correctly classifies 9.9% more, or 37.2% of the cases. In particular, the model does
considerably better at classifying those who Agree or Strongly disagree, and slightly worse with
those who Disagree.

Odds Ratios

Cumulative odds are defined as the ratio of the probability that the dependent variable takes
a value less than or equal to a given response category to the probability that it takes a value
greater than that response category. The cumulative odds ratio is the ratio of cumulative odds
for different predictor values and is closely related to the exponentiated parameter estimates.
Interestingly, the cumulative odds ratio itself does not depend upon the response category.

Figure 21-1
Cumulative odds ratios for Age category

95% Confidence
Cumulative Initeral Ciesign Sruare Roat
Ciclols Ratio Lowwer Upper Effect Design Effect
Age 158-30 ws. =60 1.383 1166 1.639 1.793 1.339
categary 31-45 ws. =60 1.148 1022 1.290 1155 1.076
46-60 ws. =G0 1.100 835 1.294 2206 1.485

Dependernt “arisble: The legislature should enact a gas tax (Azcending)
Model: (Threshold), agecat, gender, votelast, drivefreq
Link function; Logit

a. Factors and covaristes used in the computation are fixed at the following values: Age
category==60; Gender=Female; “oted in last election=Yes; Driving
frequency===30,000 miesvear

This table displays cumulative odds ratios for the factor levels of Age category. The reported
values are the ratios of the cumulative odds for /8—30 through 46—60, compared to the cumulative
odds for >60. Thus, the odds ratio of 1.383 in the first row of the table means that the cumulative
odds for a person aged 18-30 are 1.383 times the cumulative odds for a person older than 60.
Note that because Age category is not involved in any interaction terms, the odds ratios are
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merely the ratios of the exponentiated parameter estimates. For example, the cumulative odds
ratio for /8—30 vs. >60 is 1.00/0.723 = 1.383.

Figure 21-12
Odds ratios for driving frequency
95% Confidence
Cumulative Irterval Design Srjuare Root
Odds Ratio Lovwer Upper Effect Design Effect
Driving Doonot owen car ws,
frequency  10-14.999 missiyear 4285 2878 £.330 2345 1.531
=10,000 milesfvear vs.
10-14 393 milesfyear 2.030 1.656 24585 1.838 1.356
15-19,299 miles/vear ws.
10-14 999 milesfyesr A4 430 E46 1.450 1.204
20-29,999 milesfvear vs,
10-14,993 milesfyear 24T 183 267 2085 1.445
==30 000 mileshear vs.
10-14 393 milestyear Ao .arma 129 1.585 1.259

Dependent Yariable: The legislature should enact & gas tax (Azcending)
Maodel (Threshold), agecat, gender, votelast, drivefreq
Link function; Logit

&. Factors and covariates used in the computation are fixed at the following values: Age
category==60; Gender=Female; “oted in last election=""es; Driving frequency===30000 miesiear

This table displays the cumulative odds ratios for the factor levels of Driving frequency, using
10—-14,999 miles/year as the reference category. Since Driving frequency is not involved in any
interaction terms, the odds ratios are merely the ratios of the exponentiated parameter estimates.
For example, the cumulative odds ratio for 20—29,999 miles/year vs. 10—14,999 miles/year is
0.101/0.444 = 0.227.

Generalized Cumulative Model

Figure 21-13
Test of parallel lines

Adiusted Seguentizl
df1 df2 Wiald F Sig. Sidak Sig.
8789 122,767 1.894 11 392

Dependernt “Yariahle: The legislature should enact & gas tax (Ascending)
Madel: (Threshald), agecat, gender, wotelast, drivefreny
Link function; Logit

The test of parallel lines can help you assess whether the assumption that the parameters are the
same for all response categories is reasonable. This test compares the estimated model with one
set of coefficients for all categories to a generalized model with a separate set of coefficients for
each category.

The Wald F test is an omnibus test of the contrast matrix for the parallel lines assumption that
provides asymptotically correct p values; for small to mid-sized samples, the adjusted Wald ¥
statistic performs well. The significance value is near 0.05, suggesting that the generalized model
may give an improvement in the model fit; however, the Sequential Sidak adjusted test reports a
significance value high enough (0.392) that, overall, there is no clear evidence for rejecting the
parallel lines assumption. The Sequential Sidak test starts with individual contrast Wald tests to
provide an overall p value, and these results should be comparable to the omnibus Wald test result.
The fact that they are so different in this example is somewhat surprising but could be due to the
existence of many contrasts in the test and a relatively small design degrees of freedom.
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Parameter estimates for generalized cumulative model (shown in part)

93% Confidence

The legislature should Std. Interval
enact a gas tax Parameter B Errar Lowwer Upper
Strongly agree [ Threshold) -3 61 22 -4.155 -3.207
[agecat="1] -.320 096 -.a23 =113
[agecat=2] -075 a7 =227 77
[agecat=3] - 022 073 -180 135
[agecat=4] 0o0oE .
[gender=0] -na2 054 -1a7 033
[gender=1] non2 .
[wotelast=0] nos 052 =104 Az0
[votelast=1] non@ .
[drivefrag=1] -4 096 267 -4 GBI -3.523
[drivefreng=2] -3.367 237 -3.876 -2857
[drivefreq=3] -2675 224 -3.158 -2198
[drivefreng=4] -1.928 213 -2.354 -1.471
[drivefrag=5] -1.015 252 -1.555 -476
[drivefreg=6] oon2 .
Agres [ Thresholdd) -1963 153 =227 -1 B35
[agecat="1] -.385 093 -.a87 =182
[agecat=2] -130 0E9 -279 ma
[agecat=3] -139 Ao -.356 orr
[agecat=4] oo .
[gender=0] - 004 040 -0a0 0s2
[gender=1] ooo@ .
[votelast=0] ] 059 -7 135
[votelast=1] non@ .
[drivefrag=1] -3.867 38 -4.549 -3.185
[drivefreg=2] -3.005 A7s | -3.380 -2630
[drivefreq=3] -2.290 AE7 -2.69 -1.885
[drivefreng=4] -1633 AEE -1.985 -1.278
[drivefrag=5] -.809 A37 -1.204 -513
[drivefreg=F] ooo@

Moreover, the estimated values of the generalized model coefficients don’t appear to differ much
from the estimates under the parallel lines assumption.

Dropping Non-Significant Predictors

The tests of model effects showed that the model coefficients for Gender and Voted in last election

are not statistically significantly different from 0.

» To produce a reduced model, recall the Complex Samples Ordinal Regression dialog box.
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» Click Continue in the Plan dialog box.

Figure 21-15
Ordinal Regression dialog box

E Complex Samples Ordinal Regression

Wariahles:

&5 Voter ID [voteid]

& Meighborhood [nbrhood]
33 Toswniship [town]

&) County [county]

&) Gender [gender]

& Voted in last election [...
f Incluzion (=election) Pr...
f Cumulative Sampling W
f Cumulative Sampling W

Cependent Yaristle: m
i | d‘l The legislsture should e |

Covaristes:

Link Function:
Lowyit YJ

Subpopulation

Watiahle:
|

Categary:

» Deselect Gender and Voted in last election as factors.

» Click Options.

il Age category [agecat]
{I Driving frequency [driv... E
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Figure 21-16
Ordinal Regression Options dialog box
H Complex Samples Ordinal Regression: Options
E=timation bethoc Estimation Criteriza

® Mewton-Raphsaon Maximum tterations:

© Fizher zcoring

© Fisher scoring then Mewton-Raphson Maimum Step-Halving:

Mazimum Mumber of teration

Before Switching Q‘. Limit terations bazed on change in parameter estimates

Minimum Change: | pooogq Type:

|| Limit iterations based on change in log-likelihood
Uzer-Miszing Values
@ Treat as invalic

© Treat as vald [ Check for complete separation of data points

Thiz setting applies to categorical design and Starti P
arting fter ation:
model variables. fing

Q‘. Cizplay teration history

Increment: I:I

Confidence Interwval(%):

|§C0rdinue§|[ Cancel ][ Helg ]

» Select Display iteration history.

The iteration history is useful for diagnosing problems encountered by the estimation algorithm.
» Click Continue.

» Click OK in the Complex Samples Ordinal Regression dialog box.

Warnings

Figure 21-17
Warnings for reduced model

The log-likelihood value cannat be increased after the maximum number of
steps inthe step-halving method.

The CSORDIMNAL procedure continues despite the above warning(s).
Subzequent results shown are based on the last iteration. Yalidity of the model
fit i= uncertain.

The followving message applies to the generalized cumulstive model.

The log-likelhood value cannot be increased after the maximum number of
steps inthe step-halving method.

The warnings note that estimation of the reduced model ended before the parameter estimates
reached convergence because the log-likelihood could not be increased with any change, or “step,”
in the current values of the parameter estimates.
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Figure 21-18
Warnings for reduced model
Threshold Regression
] Pseudo -2 | [opinion | [opinion [opinion [drive | [drive | [drive [drive [ddrivee:

teration | Step-h Log _gastax | _gastax | _gastax [agec | [agec [agec freg= freg= freo= freg= freg=
Iumber alving Likelihood =1] =2] =3] at=1] at=2] at=3] 1] 2] 3] 4] 3]
a 0 J26640.3 -1.309 -.03g 1.020 .ooo .ooo .noo .noo oo .ooo o0 oo
1 0 303567 .5 -3.242 -1.881 -.704 =323 | -437 -0394 |-3541 |-2870 | -2245 |-13863 - 835
2 0 303336.3 -3.327 -1.897 - BE4 =325 | -139 -095 |-3740 |-2993 |-2291 |-1568 -811
3 0 3033339 -3.333 -1.900 - B4 -.326 | -139 -096 [-3.750 | -3003 | -2293 |-1.570 -2
4 i} 3033338 -3.333 -1.800 - G4 -.326 | -138 -095 (-3.750 |-3003 | -2.293 |-1.370 -1z
53 3 3033359 -3.333 -1.900 - BE4 -.326 | -138 -096 |-3750 |-3003 |-2295 |-1570 -812

Redundant parameters are not displayed. Their values are alvways zero in all terstions.
Dependent Variable: The legislature should enact a gas tax (Ascending)

Model: (Threshold), sgecat, drivefreg

Link function: Logit

A. The log-likelihood value cannot be increased after the maximum number of steps inthe step-halving method.

b Meston-Raphson method was used to estimste the parameters.

Looking at the iteration history, the changes in the parameter estimates over the last few iterations
are slight enough that you’re not terribly concerned about the warning message.

Comparing Models
Figure 21-19
Pseudo R-Squares for reduced model
Cox and Snel A7a
Magelkerke A
fcFadden iyl

Dependent Yariahle: The legisiature should enact & gas tax (Ascending)
Model: (Threshold), agecat, gender, votelast, drivefreg
Link function; Logit

The R? values for the reduced model are identical to those for the original model. This is evidence
in favor of the reduced model.

Figure 21-20
Classification table for reduced model
Predicted
Strongly Strangly Percent

Ohzerved agres Agres Disagres disagres Correct
Strongly agree TOEY 567 12823255 3183.380 2055.750 28.1%
Agree 4271.234 | 15684090 E100.963 E205.137 42 6%
Digagrees 2024816 | 13157809 SES4.047 8640746 19.2%
Strongly dizagree §59.869 Q226575 S859.053 15308703 45 .9%
Creerall Percent 124% 431% 17 6% 27 3% 37 0%

Dependent “Yariable: The legislsture should enact & gas tax (Ascending)
Model: (Threshald), agecat, drivefreg
Link function; Logit

The classification table somewhat complicates matters. The overall classification rate of 37.0%
for the reduced model is comparable to the original model, which is evidence in favor of the
reduced model. However, the reduced model shifts the predicted response of 3.8% of the voters



209

Complex Samples Ordinal Regression

from Disagree to Agree, more than half of whom were observed to respond Disagree or Strongly

disagree. This is a very important distinction that deserves careful consideration before choosing
the reduced model.

Summary

Using the Complex Samples Ordinal Regression Procedure, you have constructed competing
models for the level of support for the proposed bill based on voter demographics. The test of
parallel lines shows that a generalized cumulative model is not necessary. The tests of model
effects suggest that Gender and Voted in last election could be dropped from the model, and the
reduced model performs well in terms of pseudo-R? and overall classification rate compared to the
original model. However, the reduced model misclassifies more voters across the Agree/Disagree
split, so the legislators prefer to keep the original model for now.

Related Procedures

The Complex Samples Ordinal Regression procedure is a useful tool for modeling an ordinal
variable when the cases have been drawn according to a complex sampling scheme.

m  The Complex Samples Sampling Wizard is used to specify complex sampling design
specifications and obtain a sample. The sampling plan file created by the Sampling Wizard
contains a default analysis plan and can be specified in the Plan dialog box when you are
analyzing the sample obtained according to that plan.

m  The Complex Samples Analysis Preparation Wizard is used to specify analysis specifications
for an existing complex sample. The analysis plan file created by the Sampling Wizard can be
specified in the Plan dialog box when you are analyzing the sample corresponding to that plan.

®  The Complex Samples General Linear Model procedure allows you to model a scale response.

m  The Complex Samples Logistic Regression procedure allows you to model a categorical
response.
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The Complex Samples Cox Regression procedure performs survival analysis for samples drawn
by complex sampling methods.

Using a Time-Dependent Predictor in Complex Samples Cox Regression

A government law enforcement agency is concerned about recidivism rates in their area of
jurisdiction. One of the measures of recidivism is the time until second arrest for offenders. The
agency would like to model time to rearrest using Cox Regression on a sample drawn by complex
sampling methods, but they are worried the proportional hazards assumption is invalid across
age categories.

Persons released from their first arrest during the month of June 2003 were selected from
sampled departments, and their case history inspected through the end of June 2006. The
sample is collected in recidivism_cs_sample.sav. The sampling plan used is contained in
recidivism_cs.csplan; because it makes use of a probability-proportional-to-size (PPS) method,
there is also a file containing the joint selection probabilities (recidivism_cs_jointprob.sav). For
more information, see the topic Sample Files in Appendix A in IBM SPSS Complex Samples
19. Use Complex Samples Cox Regression to assess the validity of the proportional hazards
assumption and fit a model with time-dependent predictors, if appropriate.

Preparing the Data

The dataset contains the dates of release from first arrest and second arrest; since Cox regression
analyzes survival times, you need to compute the amount of time between these dates.

However, Date of second arrest [date2] contains cases with the value 10/03/1582, a missing
value for date variables. These are people who have not had a second offense, and we definitely
want to include them as right-censored cases in the model. The end of the follow-up period was
June 30, 2006, so we are going to recode 10/03/1582 to 06/30/2006.

» To recode these values, from the menus choose:
Transform > Compute Variable...

© Copyright SPSS Inc. 1989, 2010 210
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Figure 22-1

Compute Variable dialog box

H Compute Variable
Target Wariable: Mumeric Expression:
|d8182 | = DATE. DMy (30,6 2006)

(1ype 8 Labe. |

&5 Region [regian] - Y

&) Province [province] —
unction group:
& District [district] — ni ef -
— e Arithmetic
@b City [city) _
&b Arrest D [arrest] Date Creation
& . Date Extraction
Age in years [age] | -
{I Age category [agec.. ni\;i;snf;neous

&) Marital status [marital]
ol social status [sacisl]
{I Level of education ...

Mizsing “alues

4]

Functions and Special Yariahles:

&) Employed [employ] Diate Dy
&) Gender [gender] Date My
H:I Severity of first cri... DATE DY [ day month yeat). Mumeric. Returns a “ Diate Moyr
% Viclert first crime [v... date value corresponding to the indicated day, Date Gy
B month, and year. The arguments must resolve to

4z Date of releass fro... integers, with day between 1 and 31, month Date Wyt
& Pasted bail (il hetween 1 and 13, and year & four-digt inteoes Date M roay
&) Feceived rehabilitati... grester than 1552, To dizplay the result as a date,

A Sarnnd arvest Tarea 0| [ BEsion s date format to the result variable. =

E(Dmional casze selection condition)

Lok J (paste ] (geset J(concel) _tew )

» Type date2 as the target variable.
» Type DATE.DMY(30,6,2006) as the expression.

» Click If.
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Figure 22-2
Compute Variable If Cases dialog box

E Compute Variable: If Cases

&5 Region [region] - @ Include &l cases

&) Province [province] @ Include if case satisties condition:

& District [dlistrict] MISSNGrdae2)

& City [city] +

% Arrest D [arrest]

f Age in years [age] Function groug:

,{I Age category [agec... Date Cresation B
&) Marital status [marital] Date Extraction

,{I Social status [zocial] Inverse DF

il Level of education [... Mizcellaneous

&) Employed [employ] Miz=sing Yalues

&) Gender [gendet] PDF & Moncertral PDF -

il Severity of first ori...

|2

&5 Vinlent first crime [v...
afé Date of releasze fro...

- Functions and Special Yariahl
H FSyamiz

. . Mizsing
& Posted bail [bai] MISSINGvariable). Logical. Returns 1 o true if variabls Mriss
@b Received rehabiltati... hias & system- or user-mizsing value. The aroument Nvalid
&) Second arrest [arre... should be & variable name in the active dataset.
. Sysmis
{I Severity of second ...
Walug

% Winlert secaond crim. .
&) Zecond conviction [...
,:,;, Date of second atr...

@? Inclusion [ Selection...

B T

Neowie) (conea) (e

Select Include if case satisfies condition.
Type MISSING(date2) as the expression.
Click Continue.

Click OK in the Compute Variable dialog box.

Next, to compute the time between first and second arrest, from the menus choose:

Transform > Date and Time Wizard...




213

Complex Samples Cox Regression

Figure 22-3
Date and Time Wizard, Welcome step

E Date and Time Wizard

Welcome to the date and time wizard

What weould you like to da?

@ Learn how dates and times are represented in PASW Statistics
@) Creste a datetime variakle from a string containing a date or time

@ Creste a datefime variable from variables holding parts of dates or times
@ calculate with dates and times

@ Extract a part of a date ar time variable

()] A=sign periodicity to & dataset (for time series data). This ends the wizard and opens the
Define Dates dialog box

» Select Calculate with dates and times.

» Click Next.
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Figure 22-4
Date and Time Wizard, Do Calculations on Dates step

E Date and Time Wizard - Step 1 of 3

Do Calculstions on Dates:

Choose one of the following tasks and press MNext

()] Acd or subtract a duration from & date (e.g., add a month to an age or add 5 time variable
to & datetime variable)

@ Calculste the number of time unitz between tvwo dates (e.g., calculste an sge in vears from
a birthdate and anather date)

@ Subtract two durations (e.g., time warked - time commuting)

» Select Calculate the number of time units between two dates.

» Click Next.
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Figure 22-5
Date and Time Wizard, Calculate the number of time units between two dates step

fH Date and Time Wizard - Step 2 of 3

Calculste the number of time units between twio date or datetime variables.

The result will be an integer variable. Any fractional part of a unit will be discarded. The result will be a duration wariable. Only duration
variables are shown in the varishles list below.

Yariahles: Datet:
Current dete and time ... hd

Date of zecond arrest [date2] |

minuz Date:
Date of release fram first arrest [dated] |

Unit:
|Da\,fs b ol |

Result Treatment

® Truncate to integer
Round to integer
Retain fractional part

For month and year units, the result is based on
average unit length unless truncation is used.

FTIME i the current date and time.

Select Date of second arrest [date2] as the first date.
Select Date of release from first arrest [datel] as the date to subtract from the first date.
Select Days as the unit.

Click Next.
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Figure 22-6
Date and Time Wizard, Calculation step
HH Date and Time Wizard - Step 3of 3
Calculation: date? - datel
Result Yariahle: Units:
|time_to_event Days

Yariahle Label:
|Time to second arrest

Execition
’7@3 Creste the variahle now @ Pazte the syntac into the syntax window

» Type time_to_event as the name of the variable representing the time between the two dates.
» Type Time to second arrest as the variable label.

» Click Finish.

Running the Analysis

» To run a Complex Samples Cox Regression analysis, from the menus choose:
Analyze > Complex Samples > Cox Regression...
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Figure 22-7
Complex Samples Plan for Cox Regression dialog box

H Complex Samples Plan for Cox Regression

rPlan

File: |recidivism_cs caplan | [ Browese... ]

If ywou do not have a plan file for your complex sample,
you can use the Analysis Preparation Wizard to create
one. Choose Prepare for Analysis from the Complex
Samples menu to access the wizard,

rdairt Probabilitie

Joint probakilties are required if the plan requests
unegual probabilty WIOR estimation. Ctherwise, they are
igrored.

Use default file  (recidivism_c= sav)
An open detaset

@ Custom file

File: |recidivism_csjointprob Eav | [Browse... ]

[CDntinue” Cancel ” Helg ]

Complex Samples Cox Regression

» Browse to the sample files directory and select recidivism_cs.csplan as the plan file.

» Select Custom file in the Joint Probabilities group, browse to the sample files directory, and select

>

recidivism_cs_jointprob.sav.

Click Continue.
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Figure 22-8

Cox Regression dialog box, Time and Event tab

E Complex Samples Cox Regression

X]

Wariahles:

&) Region [region] s
&) Province [province]

& District [oistrict]

& City [city]

a) Arrest D [arrest]

f Loein years [ag2]

{I Age categary [agecat]

&) Marital status [marital]

{I Social status [socisl]

il Level of education [ed)

&) Employed [employ]

a) Gender [gender]

il Severity of first crime [crimet]

a) Yiolert first crime [violent1]

Date of release from first arrest [date]
& Posted bail [bail]

a) Received rehahbiltation [rehab]

d Severity of second crime [crime2]

a) Yiolent second crime [violert2]

&) Second conviction [convict2)

Date of second arrest [date?]

& Incliuzion (Selection) Probakilty for St
‘f Cumulstive Sampling Weight for Stag...
f Cumulstive Sampling Weight for Stag... |=

ik

e s Evert predictors  Subaroups | Model | Siliscs | Pl HypothesisTests | Save Export  Ontons|

rSurvival Time
—=tart of Interval (Onset of Risk)
@ Time 0
© varies by subject
Start Yatiakle:
2 |
rEnd of Intetwal
End Variable:
g |_&) Second arrest [arrest?)] |

rEvent

Status Variable:
| & Time to second arrest [time_to_evert]

£

Yalues indicating that evert
haz occurred:

[mone]

Subject [dertifier:

-

Choose a subject identifier variahle if there are multiple cazes per
subject.

() (o) ()

» Select Time to second arrest [time_to_event] as the variable defining the end of the interval.
» Select Second arrest [arrest?] as the variable defining whether the event has occurred.

» Click Define Event.
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Figure 22-9
Define Event dialog box

E Define Event H

—alues Indicating that Evert Has Ocourred
@ Individual values(s)  Specify One OF Mare Values:
- rs
O Ma
1es
s
b
i
- |-
© Range of values i -
haxitnim: -

(conrne) [ conce oo )

» Select 1 Yes as the value indicating the event of interest (rearrest) has occurred.
» Click Continue.

» Click the Predictors tab.
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Figure 22-10
Cox Regression dialog box, Predictors tab

E I!omp'gx gamp'és Cox H:gressmn E

Time ond Evert | Frodetore  Subgroups | Model | Silsics | Pl Hypothesis Tests | Save Export Ontons|

Wariables: M Factors:
& Region [region]
‘) Province [province]
& District [district]
&5 City [city]
‘3 Arrest ID [arrest]
il Age category [agecst]
‘3 Marital status [marital]
il Social status [zocisl]
{I Level of education [ed]
‘3 Etnployed [employ]
‘) Gender [gender]
{I Severity of first crite [crimet]
& “iolent first crime [violent1]
Date of release from first arrest [date] |‘f A in yesrs [age]
&b Posted bail [bai]
‘) Received rehabiltstion [rehak]
{I Severity of second crime [crime?] -

Time-Dependent Predictors: Q

i Covaristes:

(Lot ) (eacte ) (geset ) (conca) oo )

» Select Age in years [age] as a covariate.

» Click the Statistics tab.
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Figure 22-11
Cox Regression dialog box, Statistics tab

Complex Samples Cox Regression

= Complex Samples Cox Regression

m Sample design information
E Event and censaring suthmary
|:| Rizk zet at event times

Time and Event | Predictors | Subgroups | Maodel - Hypothesis Tests Export | Options

rParameter:
[7] Estimate [7] covatiances of parameter estimates
|:| Exponertisted estimate |:| Cotrelations of parameter estimates
[7] standard error [7] Design eftect

|:| Confidence interwval |:| Sojuare roat of design effect

[ t-test

—hodel Assumption:

[&] Test of proportional hazards
Time Function: Laog w2

[+ Parameter estimates for aternative mocel

|:| Covariance matrix for atternative madel

|:| Bazeline survival and cumulative hazard functions

[ K ” Paste ”Reset ”Cancel” Help ]

» Select Test of proportional hazards and then select Log as the time function in the Model

Assumptions group.
» Select Parameter estimates for alternative model.

» Click OK.

Sample Design Information

Figure 22-12
Sample design information

il

Ureighted Counts | Walid Suhjects 8687
Cases G687

Irealid Cases ]

Total Cazes SREET

Population Subject Size A07R83.608
Stage 1 Strata 4
Units 20

Sampling Design Degrees of Freedom 16
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This table contains information on the sample design pertinent to the estimation of the model.
m  There is one case per subject, and all 5,687 cases are used in the analysis.
m  The sample represents less than 2% of the entire estimated population.

m  The design requested 4 strata and 5 units per strata for a total of 20 units in the first stage of
the design. The sampling design degrees of freedom are estimated by 20—4=16.

Tests of Model Effects
Figure 22-13
Tests of model effects
Source it df2 Wald F S,
age 1.000 16 504.767 1.580E-13

Survival Time Variable: Time to second arrest
Event Status variahle: Secand arrest=1.0
mModel: age

In the proportional hazards model, the significance value for the predictor age is less than 0.05
and, therefore, appears to contribute to the model.

Test of Proportional Hazards

Figure 22-14
Overall test of proportional hazards
rl dfz Wiald F Sig.
1.000 16.000 20.924 5.136E-5

Survival Time Variable: Time to second arrest
Ewent Status Yariable: Second arrest=1.0
Model: age, age*_TF

Figure 22-15
Parameter estimates for alternative model

0% Confidence
Interval
Parameter B Std. Errar Lower Upper
age -.0o2 014 -024 0.0z
age* TF? -012 0oz -016 -.0oy

Survival Time Variahle: Time 10 secand arrest
Event Status Wariahle: Second arrest=1.0
model: age, age*_TF

a. Time function: Log

The significance value for the overall test of proportional hazards is less than 0.05, indicating that
the proportional hazards assumption is violated. The log time function is used for the alternative
model, so it will be easy to replicate this time-dependent predictor.

Adding a Time-Dependent Predictor

» Recall the Complex Samples Cox Regression dialog box and click the Predictors tab.
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» Click New.

Figure 22-16

Cox Regression Define Time-Dependent Predictor dialog box

Complex Samples Cox Regression

E Complex Samples Cox Regression: Define Time-Dependent Predictor

@ hame:

|t_age

Wariahles:

&5 Time 7]
a) Arrest D [arrest]
f Age in years [age]
Age category [agec...
&) Marital status [matital]
d Social status [social]
{I Level of education ...
&) Etvployved [employ]
a) Gender [gender]
il Severity of first cri..
&b Violent first crime [v...
,ﬁ Date of release fro...
& Posted bail [bail]
&b Received rehahiltati_.
a) Second arrest [arre. .
{I Severity of second ...
a) Winlert second crim...
a) Second conviction [...
,f,;f, Date of second arr...
f Inclusion [ Selection...
f Cumulstive Samplin...
f Inclhuzion (Selection...

f Cumulative Samplin...

Tumer

ic Expression;

IN(T_Page

roperators and Mumber:

e
CEOEE
EEEEE]

EE&
EEE
CEE8E

it

~Functions and Special Yariakble:

Function:

Cescription:

Arsl

Abs

Artan

i
a
4 =D

in

Display: |Arithmetic

'J Inzert

» Type t_age as the name of the time-dependent predictor you want to define.

» Type In(T_)*age as the numeric expression.

>

Click Continue.
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Figure 22-17
Cox Regression dialog box, Predictors tab

E I!omp'gx gamp'és Cox H:gressmn E

Time ond Evert | Prodetore  Subgroups | Model | Silsics | Pl Hypolhesis Tests | Save Export Ontons|

Wariables: M Factors:
& Region [region]
‘) Province [province]
& District [district]
@5 City [city]
‘3 Arrest ID [arrest]
il Age category [agecst]
‘3 Marital status [marital]
il Social status [zocisl]
{I Level of education [ed]

‘3 Etnployed [employ]

‘) Gender [gender]

{I Severity of first crite [crimet] .

& winlent first crime [widlert1] L covaristes:

Date of release from first arrest [date] f A0 N yesrs [age]
& Posted bail [bail] (D42

‘) Received rehabiltstion [rehak]

{I Severity of second crime [crime?] -

Time-Dependent Predictors: Q

» Select ¢ age as a covariate.

» Click the Statistics tab.
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Figure 22-18
Cox Regression dialog box, Predictors tab

H Complex Samples Cox Regression

m Sample design information

E Event and censaring suthmary

|:| Rizk zet at event times

rParameter:
[ Estimate [7] covatiances of parameter estimates
|:| Exponertisted estimate |:| Cotrelations of parameter estimates
[ standard error [+ Design effect
E Confidence interwval |:| Sojuare roat of design effect
[ t-test

—hodel Assumption:

[ Test of proportional hazards

4

[

|:| Bazeline survival and cumulative hazard functions

(S

[ Paste ”Reset ”Cancel” Help ]

» Select Estimate, Standard error, Confidence interval, and Design effect in the Parameters group.

» Deselect Test of proportional hazards and Parameter estimates for alternative model in the Model
Assumptions group.

» Click OK.
Tests of Model Effects
Figure 22-19
Tests of model effects
Source oft df2 Wil F Sid.
ane 1.000 16.000 015 0.91
t_age 1.000 16.000 29.824 5.136E-5

Survival Time Variable: Time to second arrest
Event Status Wariable: Second arrest=1
Model: age, _age

With the addition of the time-dependent predictor, the significance value for age is 0.91, indicating
that its contribution to the model is superseded by that of ¢ _age.
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Parameter Estimates

Figure 22-20
Parameter estimates

95% Confidence

Interval
Pararneter B Std. Error Lot pper Design Effect
age -.002 0.01 -.030 037 it
t age -2 0oz -7 -.0og GEE

Survival Time Yariable: Time to second arrest
Ewent Status YWariable: Second arrest=1
mModel: age, t_age

Looking at the parameter estimates and standard errors, you can see that you have replicated the
alternative model from the test of proportional hazards. By explicitly specifying the model, you
can request additional parameter statistics and plots. Here we have requested the design effect; the
value for ¢_age of less than 1 indicates that the standard error for ¢ _age is smaller than what you
would obtain if you assumed that the dataset was a simple random sample. In this case, the effect
of t_age would still be statistically significant, but the confidence intervals would be wider.

Multiple Cases per Subject in Complex Samples Cox Regression

Researchers investigating survival times for patients exiting a rehabilitation program post-ischemic
stroke face a number of challenges.

Multiple cases per subject. Variables representing patient medical history should be useful as
predictors. Over time, patients may experience major medical events that alter their medical
history. In this dataset, the occurrence of myocardial infarction, ischemic stroke, or hemorrhagic
stroke is noted and the time of the event recorded. You could create computable time-dependent
covariates within the procedure to include this information in the model, but it should be more
convenient to use multiple cases per subject. Note that the variables were originally coded so that
the patient history is recorded across variables, so you will need to restructure the dataset.

Left-truncation. The onset of risk starts at the time of the ischemic stroke. However, the

sample only includes patients who have survived the rehabilitation program, thus the sample

is left-truncated in the sense that the observed survival times are “inflated” by the length of
rehabilitation. You can account for this by specifying the time at which they exited rehabilitation
as the time of entry into the study.

No sampling plan. The dataset was not collected via a complex sampling plan and is considered to
be a simple random sample. You will need to create an analysis plan to use Complex Samples
Cox Regression.

The dataset is collected in stroke survival.sav. For more information, see the topic Sample
Files in Appendix A in /BM SPSS Complex Samples 19. Use the Restructure Data Wizard to
prepare the data for analysis, then the Analysis Preparation Wizard to create a simple random
sampling plan, and finally Complex Samples Cox Regression to build a model for survival times.
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Preparing the Data for Analysis

Before restructuring the data, you will need to create two ancillary variables to help with the

restructuring.

» To compute a new variable, from the menus choose:
Transform > Compute Variable...

Complex Samples Cox Regression

Figure 22-21

Compute Variable dialog box

H Compute Variable
Target Variable: Mumeric Expression:
Istart_time2 | = [timet

(v 8 atet.|

@a Hospital D fhospid] | <] 4o

{I Hospital size [hosp...
@ Patient ID [patic]

?a Attending physician...
Age inyears [age]
il Age category [agec...

&) Gender [gender]

&) Physically active [&...
&) Ohestty [ohesity]

&b History of disbstes ... E Q
&) Elood pressure [be]

&) Atrial fibrillation [af]

Function grougp:

All

Arithmetic

COF & honcentral COF
Conversion

Current DatesTime
Date Arithmetic

i

-

Functions and Special YWatiatles:

&) Smoker [smoker]

&) Cholesteral [choles]
&) Histary of angina [a...
{I History of myocardi...

{I Hiztary of izchemic ..
il Histrwss it hemorrhs

-

@ [optional case selection condition)

Lok J (paste | (geset J concel) _tew )

» Type start_time2 as the target variable.
» Type timel as the numeric expression.

» Click OK.
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Recall the Compute Variable dialog box.

Figure 22-22
Compute Variable dialog box

E Compute Variable ﬁ-

Target “ariable: Mumeric Expression:

[start_time3 | = |time2

(1ype s Labe. |

& Hospital 1D [hospic] | +
il Hospital =ize [hosp...
4 Patient ID [patic]

Function group:

.

g | (@@ @@E | F
. Arithmetic E
‘gﬁ Age in years [age]
@ e WEE

{I Age category [agec... )
& oo e e WEE et e
&5 Physically active [a... Current-Dates'.ﬁme
y Yniens OO0 @G| e =
a) History of disbetes .. E Q @ - Functions and Special Yariahles:
&) Elood pressure [by]

a) Atrial fibrillation [af]
&) Smioker [smoker]

a) Cholesterol [choles]
a) History of angina [a...
il History of myocardi...
il History of izchemic ...

Hiztorw nf hemorrha

-

E {optional case selection condition)

i) (et (et (o) ()

Type start_time3 as the target variable.
Type time?2 as the numeric expression.
Click OK.

To restructure the data from variables to cases, from the menus choose:
Data > Restructure...
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Figure 22-23
Restructure Data Wizard, Welcome step

ﬁ Restructure Data Wizard

Welcome to the Restructure Data Wizard!

Thiz wizard helps you to restructure your data from multiple variables (columns) in & single case to groups of
related cases (rows) oF vice versa, of you can choose to transpose your data.

’i‘ The wizard replaces the current data set with the restructured data, MNote that deta restructuring
L cannat be undone.

What do you weant to do?
f\* MR ED (B Restructure selected variables into cases:
[ [ema e [ [== ]y R : :
o Jeta] v [ | ane || 1o |t | cote Uze thiz when each caze in your current data has some
:: :: m variables that you would like to rearrange into groups of
related cases inthe new data set.
T [ewa] e D Restructure selected cazes into variables
] =y -
EEEED [ Tenlee Tore Teve |y Lz thiz vwhen you have groups of related cases that you
DI R |
e [t | o] weant to resrrange so that data from each group are
Il e el represented az a single case in the new data set.
(@) Tranzpoze all data
00 | 2 I All cases will become variables and selected variables will
1 jema) e .= = become cases in the new data set. (Choosing this option
M | st | e |t . - : f
-_mﬂ%l.‘——/ wiill end the wizard, and the Transpose dislog will appear.)
1 ek |

» Make sure Restructure selected variables into cases is selected.

» Click Next.
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Figure 22-24
Restructure Data Wizard, Variables to Cases Number of Variable Groups step

ﬁ Restructure Data Wizard - Step 2 of 7

Variables to Cases: Number of VVariable Groups

You have chozen to restructure selected variables into groups of related cases in the new file.
A group of related variables, called a varishle group, represents measurements on one variable.
Faor example, the variable may be width. If it is recorded inthree separate measurements, each one
, representing a different paint in time--w1, w2, and w3, then the data are arranged in & group of
variables.

If there iz more than one variakble in the file often it is also recorded in & variable group, for example
height, recorded in b1, h2, and b3,

-

Hove many wariable groups do you want to restructure?

One (for example, wi, w2, and w3)

® More than one (for example, w1, w2, w3 and h1, h2, h3, etc.)

Huow Whaney? EI

» Select More than one variable group to restructure.
» Type 6 as the number of groups.

» Click Next.
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Figure 22-25
Restructure Data Wizard, Variables to Cases Select Variables step

ﬁ Restructure Data Wizard - Step 3 of 7

Variables to Cases: Select Variables

For each variahle group you have in the current data the restructured file will have one target variable.

In thiz step, choose howy to identify case groups in the restructured data, and choose which varisbles belong with
each target variable.

Optionally, you can also choose variables to copy to the new file as Fixed Yariahles,

“ariahles inthe Current File:

&b Post-evert preventstive sur.. E Case Group |dertification

&) Post-event rehakbiltstion [re... |Llse selected variakle - |
& Length of stay for rehabilitat...

& Total treatment and rehabilt... W Warishle: |j.’=¢ Patient ID [paticl] |

&) First event post-asttack [eve...
f Time to first event post-stta...
d:l History of myocardial infarct...
;[I History of ischemic stroke [i... Target Variable: |everrt =
;[I History of hemorrhagic stro...
&) Second event post-sttack (2.
f Time to second evert post-...
;[I History of myocardial infarct...
d:l History of izchemic stroke [i..
;[I History of hemorrhagic stro...
&) Third event post-attack [eve... Fixed Wariable():
f Time to third event post-atta. ..
& start_time2 -
& start_time3 -

wariables to be Transposed

&) First event post-sttack [event1]
&) Second evert post-sttack [event2]
&5 Third event post-attack [eventa]

= Back Cancel Help

In the Case Group Identification group, select Use selected variable and select Patient ID [patid] as
the subject identifier.

Type event as the first target variable.

Select First event post-attack [eventl], Second event post-attack [event2], and Third event
post-attack [event3] as variables to be transposed.

Select trans2 from the target variable list.
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Figure 22-26
Restructure Data Wizard, Variables to Cases Select Variables step

ﬁ Restructure Data Wizard - Step 3 of 7

Variables to Cases: Select Variables

For each variahle group you have in the current data the restructured file will have one target variable.

In thiz step, choose howy to identify case groups in the restructured data, and choose which varisbles belong with
each target variable.

Optionally, you can also choose variables to copy to the new file as Fixed Yariahles,

“ariahles inthe Current File:

Caze Group ldentification

]

&) Post-event preventative sur...

&) Post-event rehahiltation [re... |Llse zelected variable b |
& Length of stay for rehabilitat...
& Tatal trestmert and rehabilt... W Varisble: |_§?a Patient D [patic] |

&) First event post-asttack [eve...
f Time to first event post-stta...
d:l History of myocardial infarct...
;[I History of ischemic stroke [i... Target Variable: |start_time ke d
;[I History of hemorrhagic stro...
&) Second event post-sttack (2.
f Time to second evert post-...
;[I History of myocardial infarct...
d:l History of izchemic stroke [i..
;[I History of hemorrhagic stro...
&) Third event post-attack [eve... Fixed Wariable():
f Time to third event post-atta. ..
& start_time2 -
& start_time3 -

wariables to be Transposed

+ ¥ ﬁ Length of stay for rehahiltation [los_rehak)
& start_timez
& start_times

= Back Cancel Help

Type start_time as the target variable.

Select Length of stay for rehabilitation [los_rehab], start_time2, and start time3 as variables to be
transposed. Time to first event post-attack [timel] and Time to second event post-attack [time2]
will be used to create the end times, and each variable can only appear in one list of variables to be
transposed, thus start_time2 and start time3 were necessary.

Select trans3 from the target variable list.
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Figure 22-27
Restructure Data Wizard, Variables to Cases Select Variables step

ﬁ Restructure Data Wizard - Step 3 of 7

Variables to Cases: Select Variables

For each variahle group you have in the current data the restructured file will have one target variable.

In thiz step, choose howy to identify case groups in the restructured data, and choose which varisbles belong with
each target variable.

Optionally, you can also choose variables to copy to the new file as Fixed Yariahles,

“ariahles inthe Current File:

&b Post-evert preventstive sur . E Case Group |dertification

&) Post-event rehakbiltstion [re... |Llse selected variakle - |
& Length of stay for rehabilitat...

& Total treatment and rehabilt... W Warishle: |_% Patient ID [paticl] |

&) First event post-asttack [eve...
f Time to first event post-stta...
d:l History of myocardial infarct...
;[I History of ischemic stroke [i... Target Variable: |time_to_event = |
;[I History of hemorrhagic stro...

&) Second event post-sttack (2.
f Time to second evert post-...

;[I History of myocardial infarct...
d:l History of izchemic stroke [i..
;[I History of hemorrhagic stro...

&) Third event post-attack [eve... Fixed Wariable():
f Time to third event post-atta. ..
& start_time2 -
& start_time3 -

wariables to be Transposed

+ ¥ f Time to first event post-attack [time]
f Time to second event post-sttack [timez]
‘g& Time to third event post-sttack [time3]

= Back Cancel Help

Type time_to_event as the target variable.

Select Time to first event post-attack [timel], Time to second event post-attack [time2], and Time
to third event post-attack [time3] as variables to be transposed.

Select trans4 from the target variable list.
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Figure 22-28
Restructure Data Wizard, Variables to Cases Select Variables step

E Restructure Data Wizard - Step 3 of 7

Variables to Cases: Select Variables

For each variahle group you have in the current data the restructured file will have one target variable.

In thiz step, choose howy to identify case groups in the restructured data, and choose which varisbles belong with
each target variable.

Optionally, you can also choose variables to copy to the new file as Fixed Yariahles,

“ariahles inthe Current File:

@b Chalesteral [choles] ] rCase Group dentification

&b Histary of angina [angina] |Llse selected variable - |
d:l Histary of myocardial infarct...

ol Histary of ischemic strake [is] W Warishle: |_Rﬁ Patient ID [paticl] |

;[I History of hemorrhagic stro...
&) Prescribed nitroglycerin [nitra]
&) Taking anti-clotting drugs [a...
&) History of transient izchemi... Targst Variable: |mi - |
& Time to hospital [time]

;[I Initizl Rankin score [rankind]
&) CAT zcan result [catzcan]
&) Clot-dissolving drugs [clotso...
;[I Trestment result [resut]

&) Post-evernt prevertstive sur. ..
&) Post-evert rehahilitation [re... Fixed Wariable():
&7 Length of stay for rehabilitat...
& Total treatment and rehabilt... -
&) First event post-attack [eve... | =

wariables to be Transposed

+ ¥ ;[I Histary of myocardial infarction [mi]
;[I Histary of myocardial infarction [mi1]
EEI History of myocardial infarction [mi2]

= Back Cancel Help

Type mi as the target variable.

Select History of myocardial infarction [mi], History of myocardial infarction [mil], and History
of myocardial infarction [mi2] as variables to be transposed.

Select trans5 from the target variable list.
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Figure 22-29

Restructure Data Wizard, Variables to Cases Select Variables step

Complex Samples Cox Regression

ﬁ Restructure Data Wizard - Step 3 of 7

each target variable.

“ariahles inthe Current File:

@0 A1 S0 TESUIL [CAsCE]

a) Clot-dizzolving drugs [clotso...

;[I Trestment result [resut]

&) Post-event preventative sur...
&) Post-event rehakbiltstion [re...
&7 Length of stay for rehabilitat..
& Total treatment and rehabilt...
&) First event post-asttack [eve...
f Time to first event post-stta...
d:l History of myocardial infarct...
;[I History of ischemic stroke [i..
;[I History of hemorrhagic stro...
&) Second event post-sttack (2.
f Time to second evert post-...
;[I History of myocardial infarct...
d:l History of izchemic stroke [i..
;[I History of hemorrhagic stro...
&) Third event post-attack [eve...

W T R AU T

3]

Variables to Cases: Select Variables

Optionally, you can also choose variables to copy to the new file as Fixed Yariahles,

For each variahle group you have in the current data the restructured file will have one target variable.

Caze Group ldentification

|Llse selected vatiahle 2 |
W Varisble | gk Patient ID [patid] |
wariables to be Transposed
Target Variable: |i3 -

+ ¥ ;[I Histary of ischemic stroke [is]
;[I Histary of izchemic stroke [is1]
EEI History of ischemic stroke [is2]

= Back m

Fixed Wariable():

Cancel Help

In thiz step, choose howy to identify case groups in the restructured data, and choose which varisbles belong with

Type is as the target variable.

Select History of ischemic stroke [is], History of ischemic stroke [isl], and History of ischemic
stroke [is2] as variables to be transposed.

Select trans6 from the target variable list.
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Figure 22-30
Restructure Data Wizard, Variables to Cases Select Variables step

ﬁ Restructure Data Wizard - Step 3 of 7

Variables to Cases: Select Variables

For each variahle group you have in the current data the restructured file will have one target variable.

In thiz step, choose howy to identify case groups in the restructured data, and choose which varisbles belong with
each target variable.

Optionally, you can also choose variables to copy to the new file as Fixed Yariahles,

“ariahles inthe Current File:

@0 CAT scanresult [catscan] [ Case Group ldertification
&) Clot-dissolving drugs [clotso... ]
;[I Trestment result [resut]

a) Post-event preventative sur.. - Wariahle: |_£)ﬂ Patiert ID [paticl] |
&) Post-event rehahilitation [re. ..

& Length of stay for rehabilitat...
& Total treatment and rehabilt...

|Llse selected vatiahle 2 |

wariables to be Transposed

@b First event post-sttack [eve... Taroet Variable: |hs | - |
f Time to first event post-atta...

,[l Hiztory of myocardial infarct.. + | ¥ ;El History of hemorrhagic stroke [he]

d:l Hiztary of izchemic straoke [i.. :[I Histary of hemarrhadic stroke [he1]

ol Histary of hemorrhagic stra... :[I History of hemarrhagic stroke [hs2]
&) Second event post-sttack (2.
f Time to second evert post-...
;[I History of myocardial infarct...
d:l History of izchemic stroke [i...
d:l History of hemorrhagic stro...

&) Third event post-attack [eve..
il

Fixed Wariable():

= Back Cancel Help

» Type hs as the target variable.

» Select History of hemorrhagic stroke [hs], History of hemorrhagic stroke [hsl], and History of
hemorrhagic stroke [hs2] as variables to be transposed.

» Click Next, then click Next in the Create Index Variables step.
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Figure 22-31
Restructure Data Wizard, Variables to Cases Create One Index Variable step

ﬁ Restructure Data Wizard - Step S of 7

Variables to Cases: Create One Index Variable

“ou have chosen to create one index variable. The variahle's values can be seguential numbers or the names
of wariables in a group.
In the table you can specify the name and label for the index variable.

Wyhat kind of index valugs?

@ Sequential numbers
Inclex “alues: 1,23

@ “ariable names

Indes Yalues: evert!, evert2, event3

Edit the Index “ariable Name and Label:

| Mame Lahel | Levels | Index Values

everrt_index Ewent Index 13 [, 2.3

» Type event_index as the name of the index variable and type Event index as the variable label.

» Click Next.
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Figure 22-32
Restructure Data Wizard, Variables to Cases Create One Index Variable step

ﬁ Restructure Data Wizard - Step 6 of 7 m

Variables to Cases: Options

I thiz step you can set options that will be applied ta the restructured data file.

rHandling of Yariahles not Selected

(@] Drop variable(z) fram the new data file
@ Heep and treat as fixed variable(s)

System Missing or Blank Yalues in all Transposed Yariahles

@ Create & caze in the nesy file

© Discard the data

riCase Court Yariakble
= Count the number of new cazes created by the case in the current data
Mame:

Label:

» Make sure Keep and treat as fixed variable(s) is selected.

» Click Finish.
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Figure 22-33
Restructured data
event_index event start_time tlme_r:to_e\re mi is hs

1 ] 3 1500 0 1 ]
2 -4 1500 -4 -4 -4 -4
3 -4 . -4 -4 -4 -4
1 1 33 1311 0 1 0
2 4 1311 1325 1 1 0
3 -3 1325 -3 -3 -3 -3
1 4 12 1098 1 1 0
2 -3 1095 -3 -3 -3 -3
3 -3 -3 -3 -3 -3
1 4 4 1356 0 1 0
2 -3 1356 -3 -3 -3 -3
3 -3 -3 -3 -3 -3

The restructured data contains three cases for every patient; however, many patients experienced
fewer than three events, so there are many cases with negative (missing) values for event. You can
simply filter these from the dataset.

» To filter these cases, from the menus choose:
Data > Select Cases...
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Figure 22-34
Select Cases dialog box

E Select Cases

&) Chalesterol [chales]

(@0 STOREr [SMoRer] |

&) History of angina [a...
&) Prescribed nitroglyc..
&b Taking anti-clatting .
&) History of transient ..
& Time to hospital [time]
{I Initial Rankin score [...
&) CAT scan result [ca...
&) Clot-clizsalving drug...
{I Trestment result [re. .
&) Post-event prevert...
&) Post-event rehahilt ..
‘f Total treatment and ..
&) Event Index [event_...
&) Firat event post-att...
‘f Length of stay for ...
f Time to first event p...
{I History of myocardi...
{I Histary of ischemic ...
{I History of hemorrha...

=

rzelect

© All cazes
@ It condition is satisfied

)
@] Random sample of cazes
Sample...
© Bazed on time or case rancge
Range. .
@ Use fiter variable:

2 |

oLt
C] Fiter out unzelected cazes
© cCopy selected cases to & new dataset

Dataset name:

© Delete unzelected cazes

Current Status: Do not fitter cases

oeste [ Beset ) (cancel]Lten |

» Select If condition is satisfied.

>

Click If.




Figure 22-35
Select Cases If dialog box

Complex Samples Cox Regression

E Select Cases: If

&4 Hospital ID [hospid]
Hospital size [hosp...

&4 Patient 1D [patia]

& Attending physician...

& Age in years [age]

{I Ade category [agec...

& Gender [gender]

33 Pheysically active [a...

& Ohesity [ohesity]

& History of diabetes ...

33 Elood pressure [bi]

& Atrial fibrillation [af]

& Smoker [smoker]

event == 0

BE®
FE®
DEBE

1

21333
CE0EE
B8

Function grougp:
Al
Arithirnetic

CDF & honcentral COF
Current DatesTime
Date Arithmetic

-

Functions and Special Yatiakles:

& Cholesterol [chales]

& Histary of angina [a...
& Prescribed nitroglyc...
&b Taking anti-clatting .
% History of transient ...
& Time to hospital [time]
{I Initial Rankin score ...
% CAT gcan result [ca... [5

o) (canea) (i)

» Type event >= 0 as the conditional expression.

>

Click Continue.
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Figure 22-36
Select Cases dialog box
E Select Cases
rzelect
@ SMOKE |SMOKEr| e &" cases

&) Chaolesteral [choles]
& Histary of angin [a... @ It condition is satisfied

&) Prescribed nitraglyc .. event ==

&b Taking arti-clotting .. Fandom sample of cases
&3 History of transient ...
& Time to hospital [time]
{I Initial Rankin score [...
&3 CAT scan result [ca...

@ Clot-dlissalving drug... Use filter variable:
{I Trestment result [re. .

Bazed on time or case rancge

&) Post-event prevert... hd |

&b Post-event rehahilt ..

f Total treatment and .. ~OutpLt

&) Event Index [event_...

& First event post-att... Fitter out unzelected cases

f Length of stay for ...
‘gﬁ Time to first event p...
{I History of myocardi...
{I Histary of ischemic ...
I{I History of hemorrha,.. | =

Copy selected cases to a new dataset

@ Delete unzelected cazes

Current Status: Do not fitter cases

[ QK [ Pazte ” Reset ”Cancel” Help ]

» Select Delete unselected cases.

» Click OK.

Creating a Simple Random Sampling Analysis Plan

Now you are ready to create the simple random sampling analysis plan.

» First, you need to create a sampling weight variable. From the menus choose:
Transform > Compute Variable...



243

v

v

v

v

Figure 22-37

Cox Regression main dialog box

Complex Samples Cox Regression

E Compute Yariable

Target “ariable:

|samp|eweigl’rt

(1ype s Labe. |

& hozpid
d hozpeize
&4 patid
& physid
f age

{I anecat
&) gender
&) active
a) obesity
&b dishetes
&b bp

a) af

&) simaker
&) choles
a) angina
&) nitro
& anticiot

L tis

Mumeric Expression:

= 1

EEE
EEE
DEBE

E

al3aaa
LELEE
EEEEE

a
3

-

E {optional case selection condition)

Function group:

Al

Arithmetic

CDF & Moncertral COF
Conversion

Current DatedTime
Date Arithmetic x

0

Functions and Special Yariahles:

i) (et (et (o) ()

Type sampleweight as the target variable.

Type 1 as the numeric expression.

Click OK.

You are now ready to create the analysis plan.

Note: There is an existing plan file, srs.csaplan, in the sample files directory that you can use if
you want to skip the following instructions and proceed to analysis of the data.

To create the analysis plan, from the menus choose:

Analyze > Complex Samples > Prepare for Analysis...
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Figure 22-38
Analysis Preparation Wizard, Welcome step

H Analysis Preparation Wizard

Wielcome to the &nalysis Preparation Wizard

The Analysis Preparation Wizard helps you describe your complex sample and choose an estimation method. You will be asked to provide
sample weights and ather information needed for accurate estitmation of standard errors.

“Your selections will be saved to a plan file that you can use in any of the analysis procedures in the Complex Samples Option.

‘What weould you like to do?

@ create a plan file

Choose this option if you have sample File: | | [ ]
data but have not crested a plan file. S L

Ediit & plan file

Choose this aption if you want to add,
remove, or modify stages of an
existing plan.

|t wou already have a plan file you can =kip the Analysis Preparation \Wizard and go directly
A to any of the analysis procedures inthe Complex Samples Option to analyze your sathple.

» Select Create a plan file and type srs.csaplan as the name of the file. Alternatively, browse to the

location you want to save it.

» Click Next.
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Figure 22-39
Analysis Preparation Wizard, Design Variables

H Analysis Preparation Wizard

Stage 1: Design YVariables

In this panel you can select variables that define strata or clusters. & sample weight variable must be selected in the first stage.

You can alzo provide a label for the stage that will be used inthe output.

; Vislcome Wariablas: Strata:
B Stage e I e
i~ P Desion Variables & Taking anti-clatting drug... [~
Estimation Method % Histary of transient isch... up
Summery &P Time to hospital [time]
Completion il Initial Rankin score [ranki...

&) CAT zcan result [catzcan]
&) Clot-dissolving drugs [cl...
il Treatment result [resul]
&) Post-event preventative -
& Post-evert rehabilitstion .
ef Total treatment and reha...
&) Evert Index [event_inde:x]
& First event post-attack [ .. Sample Wisight:

ef Length of stay for rehat... . | & sampleweight
& Time to first event post- ...
il Histary of myocardial inf....
il History of ischemic strok...
il Hiztary of hemarthagic = |+ Stage Label: | |

Clusters:

[: Elack] H i [ Finizh ”Cancel ” Help ]

» Select sampleweight as the sample weight variable.

» Click Next.
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Figure 22-40
Analysis Preparation Wizard, Estimation Method

H Analysis Preparation Wizard

Stage 1: Estimation Method

Wielcome

Stage 1

Design Variables
P Estimation Method
Sumimary
Completion

Inthis panel you select & method for estimating standard errors.

The estimation method depends on assumptions about how the sample vwas draswn.

Which of the following sample designs should be assumed far estimation’?

@ W (zampling with replacement)

If you choose this option you will not be able to sdd additional stages. Any sample stages
after the current stage will be ignored when the data are analyzed.

[i Usze finte population correction (FPC) wwhen estimating variance under simple
random sampling sssumption

Exjual WOR (ecual probakility sampling without replacement)

The next panel will ask you to specify inclusion probabilities or populstion sizes.

[¢ Eack][ﬁext = [Cance|][ Hela ]

» Deselect Use finite population correction.

» Click Finish.

You are now ready to run the analysis.

Running the Analysis

» To run a Complex Samples Cox Regression analysis, from the menus choose:

Analyze > Complex Samples > Cox Regression...




247

Complex Samples Cox Regression

Figure 22-41
Plan for Cox Regression dialog box

H Complex Samples Plan for Cox Regression

rFlan

File: |3r3 czaplan | [ Browese... ]

If you do not have a plan file for your complex sample, you
can use the Analysis Preparation Wizard to creste one,
Choose Prepare for Analysis from the Cotmplex Samples
menu ta access the wizard.

rJaint Probahilities

Joint probabilties are required if the plan requests unegual
probability WWOR estimation. Otherwise, they are ignored.

@ Use default file  (srs sav)

An open dataset

Custom file

[Continue” Cancel ” Help ]

» Browse to where you saved the simple random sampling analysis plan, or to the sample files

directory, and select srs.csaplan.

» Click Continue.
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Figure 22-42

Cox Regression dialog box, Time and Event tab

H Complex Samples Cox Regression

Wariahles:

[E0 EaltiReli= R e e 1 71
& Gender [gender]

% Phyzically active [active]

&) Ohesity [obesity]

& History of diabetes [diabetes]

% Blood pressure [bp]

&) Atrial fibrillation [af]

& Smioker [smoker]

&) Cholesterol [choles]

&) History of angina [angina]

&) Prescribed nitraglycerin [nitra]

&) Taking anti-clotting drugs [anticlot]

&) History of transzient izchemic sttack [tia]
& Time to hospital [time]

il Initizl Rankin score [rankind]

&) CAT scan result [catzcan)

&) Clot-dis=olving drugs [clotsalv]

,{I Treatment result [result]

& Post-event preventative surgery [sur..
&) Post-event rehahilitation [rehab)

f Total trestment and rehabiltstion cost...
& Evert Index [event_inde:x]

il Hiztary of myocardial infarction [mi]
,{I History of izchemic stroke [is]

,{I History of hemarrhagic stroke [hs] -

r=urvival Time

Start of Interval (Onset of Risk)
© Time 0
@ varies by subject
Start Wariable:
had | f Length of stay for rehahbilitation [start_ti... |

rEnd of Interval

End Wariable:
had | f Time to first event post-attack [time_to_e.. |
rEvert
Status Variable:
L

| ﬁ) First event post-attack [event] |

Yalues indicating that event
has ocourred:

[mone]

E Slbject ldertifier:
| |

Choose a subject identifier variable if there are multiple cases per
subject.

M Paste Mww

Select Varies by subject and select Length of stay for rehabilitation [los_rehab] as the start variable.

Note that the restructured variable has taken the variable label from the first variable used to

construct it, though the label is not necessarily appropriate for the constructed variable.

Select Time to first event post-attack [time to_event] as the end variable.

Select First event post-attack [event] as the status variable.

Click Define Event.




249

Complex Samples Cox Regression

Figure 22-43
Define Event dialog box

E Define Event H

—alues Indicating that Evert Has Ocourred

@ Individual values(s)  Specify One OF Mare Values:

0 Mo evert ohsetved

1 Myocardial infarction
2 lzchemic stroke

3 Hemorrhagic stroke
4 Desth

© Range of values i

haxitnim: -

» Select 4 Death as the value indicating the terminal event has occurred.

» Click Continue.
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Figure 22-44
Cox Regression dialog box, Time and Event tab

E Complex Samples Cox Regression

X]

Wariahles:

&4 Hospital ID [hospid]
Hospital size [hospsize]
& Attending physician 1D [physicd]
f Agein years [ag2]
{I Age categary [agecat]
&) Gender [gender]
&) Physically active [active]
&) Obesity [obesity]
&) Hiztary of dishetes [disbetes]
&) Elood pressure [hyp]
&) Atrial fibrillation [af]
&) Smoker [zmoker]
&) Cholesterol [choles]
&) History of andging [angina]
&) Prescribed nitroglycerin [nitra]
&) Taking anti-clotting drugs [anticlot]
&) History of transient ischetnic sttack [tia]
& Time to hospital [time]
{I Initial Rankin score [rankind]
&) CAT zcan result [catzcan)
&) Clot-dizzolving drugs [clotsol]
{I Treatment result [result]
&) Post-event preventative surgery [sur..
&) Post-event rehabilitation [rehak]
i I

r=urvival Time

—start of Interval (Onset of Risk)
© Time 0
@ ‘aries by subject

Start Wariable:
L3

| f Length of stay for rehahbilitation [start_ti... |

rEnd of Interval

End Wariable:
had | f Time to first event post-attack [time_to_e.. |
rEvert
Status Variable:
L

| a) First event post-attack [event]

“Yalues indicating that event Death
has ocourred:

(oot v |

Slbject ldertifier:

had Ié Patient ID [joatic]

Choose a subject identifier variable if there are multiple cases per

subject.

(Lot ) (eacte ) (geset ) (conca) oo )

» Select Patient ID [patid] as the subject identifier.

» Click the Predictors tab.
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Figure 22-45
Cox Regression dialog box, Predictors tab
E Complex Samples Cox Regression ﬁ-
Wariables: M Factors:
@ MISTORY OT CIARETes |HaneTes] Y

d History of myocardial infarction [imi]

3) Blood pressure [ap] {l Histary of ischemic stroke [is]

&) Adrial fibrilation [af] {l Histary of hethorrhagic stroke [hs]
a) Smoker [smoker]

a) Chalesteral [chales]

&) History of angina [anging]

&) Prescribed nitroglycerin [nitra) Q

a) Taking anti-clotting drugs [anticlot]

&) History of transient izchemic sttack [tia]
& Time to hospital [time]

{I Initial Rankin score [rankind]

&) CAT zcan result [catzcan]

a) Clot-diz=solving drugs [clotsaly] Ii e
d Treatment resul [Fesut] =
&) Post-event preventstive surgery [surgery]
&) Post-event rehabilitation [rehak]

f Total treatment and rehahbiltation costs inth...
&) Evert Index [event_index] -

Time-Dependent Predictars: »

@ Edit... || Delete

» Select History of myocardial infarction [mi] through History of hemorrhagic stroke [hs] as factors.

» Click the Statistics tab.
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Figure 22-46
Cox Regression dialog box, Statistics tab

M
Time an Event | Prectors| Suboraups hodel| SIS | ik Hypethesis Tests | Save | Expart Optons

Sample design information

Event and censaring summary

Risk set ot evert times

rParameter:
Estimate Covariances of parameter estimates
Exponertisted estimate Carrelations of parameter estimates
Standard error Design effect
Confidence interval Sguare roat of design effect

test

rhodel Assumption

Test of propartional hazards

Time Function: kaplan-heier

. Parameter estimates for aternative mockel

. Coveariance matrix for aternative model

Bazeling survival and cumulative hazard functions

» Select Estimate, Exponentiated estimate, Standard error, and Confidence interval in the Parameters
group.

» Click the Plots tab.
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Figure 22-47
Cox Regression dialog box, Statistics tab
E Complex Samples Cox Regression ﬁ-
rPlat:
Ij Survival function E Log-minus-log of survival function
[ Hazard function E Cne minus survival function

D Dizplay confidence intervals in selected plots

Plot Factors at.

Factor |Le1rel Separate Lines
History of myocardial infarction (Highest level) E
History of ischemic stroke 10 |
History of hemorrhagic stroke |III.D D

Plat Covariates at:

Cowvariate Value

By default, covariates in the model are evaluated at their means, and factors in the model are evalusted st their highest levels.
You can change the value at which any model predictor iz evalusted and plat separste lines for each level of one factor variakle.

Select Log-minus-log of survival function.

Check Separate Lines for History of myocardial infarction.
Select 1.0 as the level for History of ischemic stroke.
Select 0.0 as the level for History of hemorrhagic stroke.

Click the Options tab.
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Figure 22-48
Cox Regression dialog box, Options tab

H Complex Samples Cox Regression

Time and Event | Predictors  Subgroups | Model | Statistics Hypathesis Tests Export | Options
L

~Estimation

£

rSuryival Function:

Maximum fersfions: Method for estimating baseline survival functions:
@ Efron method

faximum Step-Halving: Eleeln METEE

Provuct-limit method
[+ Limit terstions based on change in parameter estimates Confidence intervals of survival functions:

@ Compute based on transformed survival

inimum Change: |0.000001 Type: function, then back transform to original units

Transformation:  ||ag -
|:| Limit terations bazed on change in log-likelihood

Compute based on origingl units:
of survival function

[7] Displary teration history
zer-Mizsing Yalues

@ Trest as intealicl

Tie-breaking method for parameter estimation: Treat as valid

ey Thiz setting applies to all categorical model and
@ Breslow sample design variables.

Confidence interval(%):

[ K ” Pazte ”Reset ”Cancel” Help ]

» Select Breslow as the tie-breaking method in the Estimation group.

» Click OK.

Sample Design Information

Figure 22-49
Sample design information

I
valid gubjects 5;210
) ases
Urweeighted Counts Ivalid Cases 0
Total Cases 330
Population Subject Size 2421.000
Strata 1
Stage 1 Units 7421
Sampling Design Degrees of Freedam 2420

This table contains information on the sample design pertinent to the estimation of the model.
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®  There are multiple cases for some subjects, and all 3,310 cases are used in the analysis.

m  The design has a single stratum and 2,421 units (one for each subject). The sampling design

degrees of freedom are estimated by 2421-1=2420.

Tests of Model Effects
Figure 22-50
Tests of model effects
Source df1 df? Wald F Sig.
rhi 3000 | 2418000 | 452.873 oo
is 2.000 | 2419.000 | 1064.936 .0on
hs 2000 | 2419.000 | 7391487 aon

Survival Time Variable: Length of stay far rehahilitation, Time to first event post-

attack

Ewent Status Wariahle: First event postattack=4
Subject IDWariahle: Patient 1D
mModel: mi, is, hs

The significance value for each effect is near 0, suggesting that they all contribute to the model.

Parameter Estimates
Figure 22-51
Parameter estimates
95% Confidence 95% Confidence
Interval Interval for ExpiE)
Std.

Parameter B Errar Lower Upper ExpiB) Lower Upper
[tni=0] -6.381 283 -6.9345 -5.827 o2 001 003
[ni=1] -5.484 284 -6.147 -5.032 o4 ooz ooy
[mi=2] -2114 344 -2.794 -1.445 120 061 236
[mi=3] 0002 . 1.000
liz=1] -6.421 202 -6.817 -6.024 002 001 .00z
lis=2] -2.803 232 -3.2349 -2 366 061 038 094
[iz=3] .0ao2 . 1.000
[hs=0] -6.148 355 -6.844 -5.453 0 001 004
[hs=1] -2.232 373 -2 963 -1.402 07 052 223
hs=2] 000° 1.000

Survival Time Variakle: Lenath of stay far rehahilitation, Time to first event postattack

Ewent Status Variable: First event postattack =4
Subject ID Variable: Patient ID
model: mi, is, hs

a. Setto zero because this parameter is redundant,

h. Tie hreaking method: Breslow

The procedure uses the last category of each factor as the reference category; the effect of other
categories is relative to the reference category. Note that while the estimate is useful for statistical
testing, the exponentiated estimate, Exp(B), is more easily interpreted as the predicted change in

the hazard relative to the reference category.

®  The value of Exp(B) for /mi=0] means that the hazard of death for a patient with no prior
myocardial infarctions (mi) is 0.002 times that of a patient with three prior mi’s.
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m  The confidence intervals for /mi=0] and /mi=1] do not overlap with the interval for /mi=2],
and none of them include 0. Therefore, it appears that the hazard for patients with one or no
prior mi’s is distinguishable from the hazard for patients with two prior mi’s, which in turn is
distinguishable from the hazard for patients with three prior mi’s.

Similar relationships hold for the levels of is and As, where increasing the number of prior
incidents increases the hazard of death.

Pattern Values

Figure 22-52
Pattern values

Survival Tirne Interval
Histary of Histary of Histary of
ryacardial ischemic hermarrhagic
Start End infarction stroke stroke
Referance Pattern | 1 non | @ Threa Threa T
Pattern 1.1 1 ooo | @ MNaone Qne Mone
Pattern 1.2 1 oog | = One Qne Mone
Pattern 1.3 1 non | o= Tuwi Ore Hone
Pattern 1.4 1 non | @ Three One MHaone

Unspecified predictor is assigned the value ofthis predictor atthe reference pattern.
Each Survival Time Interval is defined as Start = Survival Time == End.
Maodel: mi, is, hs.

a. Unhounded

The pattern values table lists the values that define each predictor pattern. In addition to the
predictors in the model, the start and end times for the survival interval are displayed. For analyses
run from the dialogs, the start and end times will always be 0 and unbounded, respectively;
through syntax you can specify piecewise constant predictor paths.

m  The reference pattern is set at the reference category for each factor and the mean value of
each covariate (there are no covariates in this model). For this dataset, the combination of
factors shown for the reference model cannot occur, so we will ignore the log-minus-log plot
for the reference pattern.

m  Patterns 1.1 through 1.4 differ only on the value of History of myocardial infarction. A
separate pattern (and separate line in the requested plot) is created for each value of History of
myocardial infarction while the other variables are held constant.
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Log-Minus-Log Plot
Figure 22-53
Log-minus-log plot
Pattern 1
History of myocardial
infarction
5.0004 —Thane
10ne
Twio
— 1 Three

25004

000+ f -

-2.5004

Log Minus Log Survival Function

-5.0004

-7 500 f

T T T T T T T T
000 200.000 400.000 &00.000 S00.000 1000.0001200.0001400.000

Survival Time

This plot displays the log-minus-log of the survival function, In(—In(suvival)), versus the survival
time. This particular plot displays a separate curve for each category of History of myocardial
infarction, with History of ischemic stroke fixed at One and History of hemorrhagic stroke fixed at
None, and is a useful visualization of the effect of History of myocardial infarction on the survival
function. As seen in the parameter estimates table, it appears that the survival for patients with
one or no prior mi’s is distinguishable from the survival for patients with two prior mi’s, which in
turn is distinguishable from the survival for patients with three prior mi’s.

Summary

You have fit a Cox regression model for post-stroke survival that estimates the effects of the
changing post-stroke patient history. This is just a beginning, as researchers would undoubtedly
want to include other potential predictors in the model. Moreover, in further analysis of this
dataset you might consider more significant changes to the model structure. For example, the
current model assumes that the effect of a patient history-altering event can be quantified by a
multiplier to the baseline hazard. Instead, it may be reasonable to assume that the shape of the
baseline hazard is altered by the occurrence of a nondeath event. To accomplish this, you could
stratify the analysis based on Event index.
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Sample Files

The sample files installed with the product can be found in the Samples subdirectory of the
installation directory. There is a separate folder within the Samples subdirectory for each of
the following languages: English, French, German, Italian, Japanese, Korean, Polish, Russian,
Simplified Chinese, Spanish, and Traditional Chinese.

Not all sample files are available in all languages. If a sample file is not available in a language,
that language folder contains an English version of the sample file.

Descriptions

Following are brief descriptions of the sample files used in various examples throughout the
documentation.

accidents.sav. This is a hypothetical data file that concerns an insurance company that is
studying age and gender risk factors for automobile accidents in a given region. Each case
corresponds to a cross-classification of age category and gender.

adl.sav. This is a hypothetical data file that concerns efforts to determine the benefits of a
proposed type of therapy for stroke patients. Physicians randomly assigned female stroke
patients to one of two groups. The first received the standard physical therapy, and the second
received an additional emotional therapy. Three months following the treatments, each
patient’s abilities to perform common activities of daily life were scored as ordinal variables.

advert.sav. This is a hypothetical data file that concerns a retailer’s efforts to examine the
relationship between money spent on advertising and the resulting sales. To this end, they
have collected past sales figures and the associated advertising costs..

aflatoxin.sav. This is a hypothetical data file that concerns the testing of corn crops for
aflatoxin, a poison whose concentration varies widely between and within crop yields. A grain
processor has received 16 samples from each of 8 crop yields and measured the alfatoxin
levels in parts per billion (PPB).

anorectic.sav. While working toward a standardized symptomatology of anorectic/bulimic
behavior, researchers (Van der Ham, Meulman, Van Strien, and Van Engeland, 1997) made a
study of 55 adolescents with known eating disorders. Each patient was seen four times over
four years, for a total of 220 observations. At each observation, the patients were scored for
each of 16 symptoms. Symptom scores are missing for patient 71 at time 2, patient 76 at time
2, and patient 47 at time 3, leaving 217 valid observations.

bankloan.sav. This is a hypothetical data file that concerns a bank’s efforts to reduce the
rate of loan defaults. The file contains financial and demographic information on 850 past
and prospective customers. The first 700 cases are customers who were previously given
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loans. The last 150 cases are prospective customers that the bank needs to classify as good
or bad credit risks.

bankloan_binning.sav. This is a hypothetical data file containing financial and demographic
information on 5,000 past customers.

behavior.sav. In a classic example (Price and Bouffard, 1974), 52 students were asked to
rate the combinations of 15 situations and 15 behaviors on a 10-point scale ranging from
0="extremely appropriate” to 9="“extremely inappropriate.” Averaged over individuals, the
values are taken as dissimilarities.

behavior_ini.sav. This data file contains an initial configuration for a two-dimensional solution
for behavior.sav.

brakes.sav. This is a hypothetical data file that concerns quality control at a factory that
produces disc brakes for high-performance automobiles. The data file contains diameter
measurements of 16 discs from each of 8 production machines. The target diameter for the
brakes is 322 millimeters.

breakfast.sav. In a classic study (Green and Rao, 1972), 21 Wharton School MBA students
and their spouses were asked to rank 15 breakfast items in order of preference with 1="most
preferred” to 15="least preferred.” Their preferences were recorded under six different
scenarios, from “Overall preference” to “Snack, with beverage only.”

breakfast-overall.sav. This data file contains the breakfast item preferences for the first
scenario, “Overall preference,” only.

broadband_1.sav. This is a hypothetical data file containing the number of subscribers, by
region, to a national broadband service. The data file contains monthly subscriber numbers
for 85 regions over a four-year period.

broadband_2.sav. This data file is identical to broadband_1.sav but contains data for three
additional months.

car_insurance_claims.sav. A dataset presented and analyzed elsewhere (McCullagh and
Nelder, 1989) concerns damage claims for cars. The average claim amount can be modeled
as having a gamma distribution, using an inverse link function to relate the mean of the
dependent variable to a linear combination of the policyholder age, vehicle type, and vehicle
age. The number of claims filed can be used as a scaling weight.

car_sales.sav. This data file contains hypothetical sales estimates, list prices, and physical
specifications for various makes and models of vehicles. The list prices and physical
specifications were obtained alternately from edmunds.com and manufacturer sites.

car_sales_uprepared.sav. This is a modified version of car_sales.sav that does not include any
transformed versions of the fields.

carpet.sav. In a popular example (Green and Wind, 1973), a company interested in
marketing a new carpet cleaner wants to examine the influence of five factors on consumer
preference—package design, brand name, price, a Good Housekeeping seal, and a
money-back guarantee. There are three factor levels for package design, each one differing in
the location of the applicator brush; three brand names (K2R, Glory, and Bissell); three price
levels; and two levels (either no or yes) for each of the last two factors. Ten consumers rank
22 profiles defined by these factors. The variable Preference contains the rank of the average
rankings for each profile. Low rankings correspond to high preference. This variable reflects
an overall measure of preference for each profile.
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carpet_prefs.sav. This data file is based on the same example as described for carpet.sav, but it
contains the actual rankings collected from each of the 10 consumers. The consumers were
asked to rank the 22 product profiles from the most to the least preferred. The variables
PREFI through PREF22 contain the identifiers of the associated profiles, as defined in
carpet_plan.sav.

catalog.sav. This data file contains hypothetical monthly sales figures for three products sold
by a catalog company. Data for five possible predictor variables are also included.

catalog_seasfac.sav. This data file is the same as catalog.sav except for the addition of a set
of seasonal factors calculated from the Seasonal Decomposition procedure along with the
accompanying date variables.

cellularsav. This is a hypothetical data file that concerns a cellular phone company’s efforts
to reduce churn. Churn propensity scores are applied to accounts, ranging from 0 to 100.
Accounts scoring 50 or above may be looking to change providers.

ceramics.sav. This is a hypothetical data file that concerns a manufacturer’s efforts to
determine whether a new premium alloy has a greater heat resistance than a standard alloy.
Each case represents a separate test of one of the alloys; the heat at which the bearing failed is
recorded.

cereal.sav. This is a hypothetical data file that concerns a poll of 880 people about their
breakfast preferences, also noting their age, gender, marital status, and whether or not they
have an active lifestyle (based on whether they exercise at least twice a week). Each case
represents a separate respondent.

clothing_defects.sav. This is a hypothetical data file that concerns the quality control process
at a clothing factory. From each lot produced at the factory, the inspectors take a sample of
clothes and count the number of clothes that are unacceptable.

coffee.sav. This data file pertains to perceived images of six iced-coffee brands (Kennedy,
Riquier, and Sharp, 1996) . For each of 23 iced-coffee image attributes, people selected all
brands that were described by the attribute. The six brands are denoted AA, BB, CC, DD, EE,
and FF to preserve confidentiality.

contacts.sav. This is a hypothetical data file that concerns the contact lists for a group of
corporate computer sales representatives. Each contact is categorized by the department of
the company in which they work and their company ranks. Also recorded are the amount of
the last sale made, the time since the last sale, and the size of the contact’s company.

creditpromo.sav. This is a hypothetical data file that concerns a department store’s efforts to
evaluate the effectiveness of a recent credit card promotion. To this end, 500 cardholders were
randomly selected. Half received an ad promoting a reduced interest rate on purchases made
over the next three months. Half received a standard seasonal ad.

customer_dbase.sav. This is a hypothetical data file that concerns a company’s efforts to use
the information in its data warehouse to make special offers to customers who are most
likely to reply. A subset of the customer base was selected at random and given the special
offers, and their responses were recorded.

customer_information.sav. A hypothetical data file containing customer mailing information,
such as name and address.

customer_subset.sav. A subset of 80 cases from customer_dbase.sav.
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debate.sav. This is a hypothetical data file that concerns paired responses to a survey from
attendees of a political debate before and after the debate. Each case corresponds to a separate
respondent.

debate_aggregate.sav. This is a hypothetical data file that aggregates the responses in
debate.sav. Each case corresponds to a cross-classification of preference before and after
the debate.

demo.sav. This is a hypothetical data file that concerns a purchased customer database, for
the purpose of mailing monthly offers. Whether or not the customer responded to the offer
is recorded, along with various demographic information.

demo_cs_1.sav. This is a hypothetical data file that concerns the first step of a company’s
efforts to compile a database of survey information. Each case corresponds to a different city,
and the region, province, district, and city identification are recorded.

demo_cs_2.sav. This is a hypothetical data file that concerns the second step of a company’s
efforts to compile a database of survey information. Each case corresponds to a different
household unit from cities selected in the first step, and the region, province, district, city,
subdivision, and unit identification are recorded. The sampling information from the first
two stages of the design is also included.

demo_cs.sav. This is a hypothetical data file that contains survey information collected using a
complex sampling design. Each case corresponds to a different household unit, and various
demographic and sampling information is recorded.

dmdata.sav. This is a hypothetical data file that contains demographic and purchasing
information for a direct marketing company. dmdata2.sav contains information for a subset of
contacts that received a test mailing, and dmdata3.sav contains information on the remaining
contacts who did not receive the test mailing.

dietstudy.sav. This hypothetical data file contains the results of a study of the “Stillman diet”
(Rickman, Mitchell, Dingman, and Dalen, 1974). Each case corresponds to a separate
subject and records his or her pre- and post-diet weights in pounds and triglyceride levels
in mg/100 ml.

dvdplayer.sav. This is a hypothetical data file that concerns the development of a new DVD
player. Using a prototype, the marketing team has collected focus group data. Each case
corresponds to a separate surveyed user and records some demographic information about
them and their responses to questions about the prototype.

german_credit.sav. This data file is taken from the “German credit” dataset in the Repository of
Machine Learning Databases (Blake and Merz, 1998) at the University of California, Irvine.

grocery_Tmonth.sav. This hypothetical data file is the grocery coupons.sav data file with the
weekly purchases “rolled-up” so that each case corresponds to a separate customer. Some of
the variables that changed weekly disappear as a result, and the amount spent recorded is now
the sum of the amounts spent during the four weeks of the study.

grocery_coupons.sav. This is a hypothetical data file that contains survey data collected by
a grocery store chain interested in the purchasing habits of their customers. Each customer
is followed for four weeks, and each case corresponds to a separate customer-week and
records information about where and how the customer shops, including how much was
spent on groceries during that week.
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guttman.sav. Bell (Bell, 1961) presented a table to illustrate possible social groups. Guttman
(Guttman, 1968) used a portion of this table, in which five variables describing such things
as social interaction, feelings of belonging to a group, physical proximity of members, and
formality of the relationship were crossed with seven theoretical social groups, including
crowds (for example, people at a football game), audiences (for example, people at a theater
or classroom lecture), public (for example, newspaper or television audiences), mobs (like a
crowd but with much more intense interaction), primary groups (intimate), secondary groups
(voluntary), and the modern community (loose confederation resulting from close physical
proximity and a need for specialized services).

health_funding.sav. This is a hypothetical data file that contains data on health care funding
(amount per 100 population), disease rates (rate per 10,000 population), and visits to health
care providers (rate per 10,000 population). Each case represents a different city.

hivassay.sav. This is a hypothetical data file that concerns the efforts of a pharmaceutical
lab to develop a rapid assay for detecting HIV infection. The results of the assay are eight
deepening shades of red, with deeper shades indicating greater likelihood of infection. A
laboratory trial was conducted on 2,000 blood samples, half of which were infected with
HIV and half of which were clean.

hourlywagedata.sav. This is a hypothetical data file that concerns the hourly wages of nurses
from office and hospital positions and with varying levels of experience.

insurance_claims.sav. This is a hypothetical data file that concerns an insurance company that
wants to build a model for flagging suspicious, potentially fraudulent claims. Each case
represents a separate claim.

insure.sav. This is a hypothetical data file that concerns an insurance company that is studying
the risk factors that indicate whether a client will have to make a claim on a 10-year term
life insurance contract. Each case in the data file represents a pair of contracts, one of which
recorded a claim and the other didn’t, matched on age and gender.

judges.sav. This is a hypothetical data file that concerns the scores given by trained judges
(plus one enthusiast) to 300 gymnastics performances. Each row represents a separate
performance; the judges viewed the same performances.

kinship_dat.sav. Rosenberg and Kim (Rosenberg and Kim, 1975) set out to analyze 15 kinship
terms (aunt, brother, cousin, daughter, father, granddaughter, grandfather, grandmother,
grandson, mother, nephew, niece, sister, son, uncle). They asked four groups of college
students (two female, two male) to sort these terms on the basis of similarities. Two groups
(one female, one male) were asked to sort twice, with the second sorting based on a different
criterion from the first sort. Thus, a total of six “sources” were obtained. Each source
corresponds to a 15 x 15 proximity matrix, whose cells are equal to the number of people in a
source minus the number of times the objects were partitioned together in that source.

kinship_ini.sav. This data file contains an initial configuration for a three-dimensional solution
for kinship_dat.sav.

kinship_var.sav. This data file contains independent variables gender, gener(ation), and degree
(of separation) that can be used to interpret the dimensions of a solution for kinship_dat.sav.
Specifically, they can be used to restrict the space of the solution to a linear combination of
these variables.

marketvalues.sav. This data file concerns home sales in a new housing development in
Algonquin, Ill., during the years from 1999-2000. These sales are a matter of public record.
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nhis2000_subset.sav. The National Health Interview Survey (NHIS) is a large, population-based
survey of the U.S. civilian population. Interviews are carried out face-to-face in a nationally
representative sample of households. Demographic information and observations about
health behaviors and status are obtained for members of each household. This data

file contains a subset of information from the 2000 survey. National Center for Health
Statistics. National Health Interview Survey, 2000. Public-use data file and documentation.
ftp://fip.cdc.gov/pub/Health _Statistics/NCHS/Datasets/NHIS/2000/. Accessed 2003.

ozone.sav. The data include 330 observations on six meteorological variables for predicting
ozone concentration from the remaining variables. Previous researchers (Breiman and
Friedman, 1985), (Hastie and Tibshirani, 1990), among others found nonlinearities among
these variables, which hinder standard regression approaches.

pain_medication.sav. This hypothetical data file contains the results of a clinical trial for
anti-inflammatory medication for treating chronic arthritic pain. Of particular interest is the
time it takes for the drug to take effect and how it compares to an existing medication.

patient_los.sav. This hypothetical data file contains the treatment records of patients who were
admitted to the hospital for suspected myocardial infarction (MI, or “heart attack™). Each case
corresponds to a separate patient and records many variables related to their hospital stay.

patlos_sample.sav. This hypothetical data file contains the treatment records of a sample
of patients who received thrombolytics during treatment for myocardial infarction (MI, or
“heart attack™). Each case corresponds to a separate patient and records many variables
related to their hospital stay.

poll_cs.sav. This is a hypothetical data file that concerns pollsters’ efforts to determine the
level of public support for a bill before the legislature. The cases correspond to registered
voters. Each case records the county, township, and neighborhood in which the voter lives.

poll_cs_sample.sav. This hypothetical data file contains a sample of the voters listed in
poll_cs.sav. The sample was taken according to the design specified in the poll.csplan plan
file, and this data file records the inclusion probabilities and sample weights. Note, however,
that because the sampling plan makes use of a probability-proportional-to-size (PPS) method,
there is also a file containing the joint selection probabilities (poll_jointprob.sav). The
additional variables corresponding to voter demographics and their opinion on the proposed
bill were collected and added the data file after the sample as taken.

property_assess.sav. This is a hypothetical data file that concerns a county assessor’s efforts to
keep property value assessments up to date on limited resources. The cases correspond to
properties sold in the county in the past year. Each case in the data file records the township
in which the property lies, the assessor who last visited the property, the time since that
assessment, the valuation made at that time, and the sale value of the property.

property_assess_cs.sav. This is a hypothetical data file that concerns a state assessor’s efforts
to keep property value assessments up to date on limited resources. The cases correspond

to properties in the state. Each case in the data file records the county, township, and
neighborhood in which the property lies, the time since the last assessment, and the valuation
made at that time.

property_assess_cs_sample.sav. This hypothetical data file contains a sample of the properties
listed in property_assess_cs.sav. The sample was taken according to the design specified in
the property assess.csplan plan file, and this data file records the inclusion probabilities
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and sample weights. The additional variable Current value was collected and added to the
data file after the sample was taken.

recidivism.sav. This is a hypothetical data file that concerns a government law enforcement
agency’s efforts to understand recidivism rates in their area of jurisdiction. Each case
corresponds to a previous offender and records their demographic information, some details
of their first crime, and then the time until their second arrest, if it occurred within two years
of the first arrest.

recidivism_cs_sample.sav. This is a hypothetical data file that concerns a government law
enforcement agency’s efforts to understand recidivism rates in their area of jurisdiction. Each
case corresponds to a previous offender, released from their first arrest during the month of
June, 2003, and records their demographic information, some details of their first crime, and
the data of their second arrest, if it occurred by the end of June, 2006. Offenders were selected
from sampled departments according to the sampling plan specified in recidivism_cs.csplan;
because it makes use of a probability-proportional-to-size (PPS) method, there is also a file
containing the joint selection probabilities (recidivism_cs_jointprob.sav).

rfm_transactions.sav. A hypothetical data file containing purchase transaction data, including
date of purchase, item(s) purchased, and monetary amount of each transaction.

salesperformance.sav. This is a hypothetical data file that concerns the evaluation of two
new sales training courses. Sixty employees, divided into three groups, all receive standard
training. In addition, group 2 gets technical training; group 3, a hands-on tutorial. Each
employee was tested at the end of the training course and their score recorded. Each case in
the data file represents a separate trainee and records the group to which they were assigned
and the score they received on the exam.

satisf.sav. This is a hypothetical data file that concerns a satisfaction survey conducted by
a retail company at 4 store locations. 582 customers were surveyed in all, and each case
represents the responses from a single customer.

screws.sav. This data file contains information on the characteristics of screws, bolts, nuts,
and tacks (Hartigan, 1975).

shampoo_ph.sav. This is a hypothetical data file that concerns the quality control at a factory
for hair products. At regular time intervals, six separate output batches are measured and their
pH recorded. The target range is 4.5-5.5.

ships.sav. A dataset presented and analyzed elsewhere (McCullagh et al., 1989) that concerns
damage to cargo ships caused by waves. The incident counts can be modeled as occurring at
a Poisson rate given the ship type, construction period, and service period. The aggregate
months of service for each cell of the table formed by the cross-classification of factors
provides values for the exposure to risk.

site.sav. This is a hypothetical data file that concerns a company’s efforts to choose new
sites for their expanding business. They have hired two consultants to separately evaluate
the sites, who, in addition to an extended report, summarized each site as a “good,” “fair,”
or “poor” prospect.

smokers.sav. This data file is abstracted from the 1998 National Household

Survey of Drug Abuse and is a probability sample of American households.
(http://dx.doi.org/10.3886/ICPSR02934) Thus, the first step in an analysis of this data file
should be to weight the data to reflect population trends.
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stroke_clean.sav. This hypothetical data file contains the state of a medical database after it
has been cleaned using procedures in the Data Preparation option.

stroke_invalid.sav. This hypothetical data file contains the initial state of a medical database
and contains several data entry errors.

stroke_survival. This hypothetical data file concerns survival times for patients exiting a
rehabilitation program post-ischemic stroke face a number of challenges. Post-stroke, the
occurrence of myocardial infarction, ischemic stroke, or hemorrhagic stroke is noted and the
time of the event recorded. The sample is left-truncated because it only includes patients who
survived through the end of the rehabilitation program administered post-stroke.

stroke_valid.sav. This hypothetical data file contains the state of a medical database after the
values have been checked using the Validate Data procedure. It still contains potentially
anomalous cases.

survey_sample.sav. This data file contains survey data, including demographic data and
various attitude measures. It is based on a subset of variables from the 1998 NORC General
Social Survey, although some data values have been modified and additional fictitious
variables have been added for demonstration purposes.

telco.sav. This is a hypothetical data file that concerns a telecommunications company’s
efforts to reduce churn in their customer base. Each case corresponds to a separate customer
and records various demographic and service usage information.

telco_extra.sav. This data file is similar to the felco.sav data file, but the “tenure” and
log-transformed customer spending variables have been removed and replaced by
standardized log-transformed customer spending variables.

telco_missing.sav. This data file is a subset of the felco.sav data file, but some of the
demographic data values have been replaced with missing values.

testmarket.sav. This hypothetical data file concerns a fast food chain’s plans to add a new item
to its menu. There are three possible campaigns for promoting the new product, so the new
item is introduced at locations in several randomly selected markets. A different promotion
is used at each location, and the weekly sales of the new item are recorded for the first four
weeks. Each case corresponds to a separate location-week.

testmarket_1month.sav. This hypothetical data file is the testmarket.sav data file with the
weekly sales “rolled-up” so that each case corresponds to a separate location. Some of the
variables that changed weekly disappear as a result, and the sales recorded is now the sum of
the sales during the four weeks of the study.

tree_car.sav. This is a hypothetical data file containing demographic and vehicle purchase
price data.

tree_credit.sav. This is a hypothetical data file containing demographic and bank loan history
data.

tree_missing_data.sav This is a hypothetical data file containing demographic and bank loan
history data with a large number of missing values.

tree_score_car.sav. This is a hypothetical data file containing demographic and vehicle
purchase price data.

tree_textdata.sav. A simple data file with only two variables intended primarily to show the
default state of variables prior to assignment of measurement level and value labels.
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tv-survey.sav. This is a hypothetical data file that concerns a survey conducted by a TV studio
that is considering whether to extend the run of a successful program. 906 respondents were
asked whether they would watch the program under various conditions. Each row represents a
separate respondent; each column is a separate condition.

ulcer_recurrence.sav. This file contains partial information from a study designed to compare
the efficacy of two therapies for preventing the recurrence of ulcers. It provides a good
example of interval-censored data and has been presented and analyzed elsewhere (Collett,
2003).

ulcer_recurrence_recoded.sav. This file reorganizes the information in ulcer recurrence.sav to
allow you model the event probability for each interval of the study rather than simply the
end-of-study event probability. It has been presented and analyzed elsewhere (Collett et

al., 2003).

verd1985.sav. This data file concerns a survey (Verdegaal, 1985). The responses of 15 subjects
to 8 variables were recorded. The variables of interest are divided into three sets. Set 1
includes age and marital, set 2 includes pet and news, and set 3 includes music and live.

Pet is scaled as multiple nominal and age is scaled as ordinal; all of the other variables are
scaled as single nominal.

virus.sav. This is a hypothetical data file that concerns the efforts of an Internet service
provider (ISP) to determine the effects of a virus on its networks. They have tracked the
(approximate) percentage of infected e-mail traffic on its networks over time, from the
moment of discovery until the threat was contained.

wheeze_steubenville.sav. This is a subset from a longitudinal study of the health effects of
air pollution on children (Ware, Dockery, Spiro 111, Speizer, and Ferris Jr., 1984). The data
contain repeated binary measures of the wheezing status for children from Steubenville, Ohio,
at ages 7, 8, 9 and 10 years, along with a fixed recording of whether or not the mother was

a smoker during the first year of the study.

workprog.sav. This is a hypothetical data file that concerns a government works program
that tries to place disadvantaged people into better jobs. A sample of potential program
participants were followed, some of whom were randomly selected for enrollment in the
program, while others were not. Each case represents a separate program participant.
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using, marketing or distributing application programs conforming to the application programming
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